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Section 1. Installation

The components of the Clearing Member module are installed as part of the Calypso Installer when you select the
“Clearing Member” solution:

Setup - Calypso 15.1.0.11-5NAPSHC

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to install. Click

— ik Base Installation (software required for all installations, indudes Navigator)
EI 7] -] Solutions (pre-packaged options for installing standard configurations)
- [ & Back Office (Additional interfaces and optional modules)
- [ f& Cash FX Trading
- [¥] f& Clearing Member
-~ [¥] f& Collateral Management
L Enterprise Risk
& Enterprize Limit Compliance
- [ #& Front Office (Additional interfaces and optional modules)
-~ [ f& Security Finance

e Enterprise Risk

e Enterprise Limit Compliance (optional) - Limits are checked once the trades are in Calypso.
e Collateral Management (optional) - Allocation of margin calls (initial margins and variation margins).

e Exchange Feed - Direct connection with the CCP through IBM MQ Series to transmit / receive trades and
messages.

e Data Uploader - Upload of trades and messages received by the Exchange Feed into Calypso.

e CMF OTC Clearing - Back office processing — Once the trades are validated/rejected in Calypso, a
consent/reject message is sent to the CCP so that the trades can be cleared - Import of initial margins,
variation margins, market data, fees, etc. — Generation of client statements.

e Margin Engine (optional) - Computation of initial margins and variation margins.

Margin Calculators
(If using Margin Engine only)

In the "Common Third Party Libraries & Extension" window, add the Margin Calculator JARs. There is a JAR for each
type of report: TYPED, TYPEE, TYPEH, TYPEJ:

e calypso-margin-calculation-typed-service-x.x.x.Jjar — CME Swap (HistSim and OTCMargin
reports)

® calypso-margin-calculation-typee-service-x.x.x.jar - COMDER
® calypso-margin-calculation-typeh-service-x.x.x.jar - LCH
® calypso-margin-calculation-typej-service-x.x.x.jar — EUREX IM

Please contact Calypso Product Support for obtaining these JARS.

Please refer to the Calypso Installation Guide for details on the Calypso Installer.

© 2018 | Calypso Confidential - Copyright © Calypso Technology, Inc. All Rights Reserved
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If you are installing a CUP (Calypso Upgrade Package) instead, the instructions are also in the Calypso Installation
Guide.

Database Upgrade
When you run Execute SQL as part of your installation, the data files will be already loaded.

Please refer to Calypso Collateral Management release notes for upgrade information, if any.

OTC Clearing and ETD clearing
You can use the system for OTC Clearing only, ETD Clearing only, or both.

If the system is used for OTC Clearing, you need to set the following domain value in domain “ProcessingConfig”:
Value = OTCClearing.IsActive, Comment = true

This allows setting the CCPOriginCode in the Account attributes.

For information on installing and setting up ETD Clearing, please refer to Calypso ETD Clearing documentation.
If the system is used for ETD clearing, you need to set the following domain value in domain “ProcessingConfig”:
Value = ETDClearing.IsActive, Comment = true

This activates additional fields in the Fee Definition and Account Definition.
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Section 2. Overview

Calypso’s OTC derivatives clearing member solution combines Calypso’s Back Office, Connectivity, Collateral and
ERS Limits functionality to offer a complete solution for entities offering OTC clearing services to their internal
trading desks as well as to external clients. The primary activities that the clearing member will be relying on
Calypso for are:

e The use of connectivity and STP workflow to automatically accept or reject trades submitted for clearing
by their customers,

e Management of cash and collateral related to the clearing activities, and
e  Generating client statements for their customers to summarize the day's activity.

In order to support these activities, Calypso provides interfaces to Central Counterparties (CCPs) to allow the
creation of trades to start them on their process to becoming a cleared trade in the client’s account. These trades
will flow into the system in real-time throughout the day. At the end of the day the CCPs will summarize all of the
information about the trades, risk and positions related to each account managed by that clearing member, and
Calypso provides the facility to run schedule tasks which import and process that information. The processing
results in the generation of Calypso trade objects which will facilitate the settlement of cashflows and the
management of Initial Margin Requirements.

The Collateral Management module will then take over to manage any Margin Calls resulting from the day’s activity
for each account. This includes not only cashflows related to the cleared trades, but payments made to or from
each clearing account as part of routine business.

The end of day (EOD) processing will also save pricing marks for each trade based on the CCP’s valuation, and will
generate market data, such as curves and quotes, which can be used to value the positions using Calypso’s native
pricers. Again, all of this information is sourced from the EOD reports provided to the clearing member by the CCP.

As a last step, Calypso will aggregate all of the information stored in the system from the activity of each account,
and generate a client statement which will be sent to the account holders as a record of their activity.

2.1 CCP and Service Coverage

Calypso’s OTC derivatives clearing member solution includes “out-of-the-box” support for connectivity and
integration with the following central counterparties:
e | CH SwapClear and SwapClear US integration:
- Trade connectivity via SwapClear interface
- Creation of mirrored trades enriched with keywords and fees
- Import of EOD Reports for Market Data and Processing
- Initial Margin calculation
e CME Clearing House and CME Clearing Europe integration:
- Trade connectivity via MQ
- Creation of mirrored trades enriched with keywords and fees
- Import of EOD Reports for Market Data and Processing
- Initial Margin calculation
e  Processing of EOD Report in CDML format (Clearing Data Markup Language) for any CCP.
[NOTE: Calypso does not provide exchange translators to the CDML format out-of-the-box]

The concept provides a specification for the content and format of two file types, Trade Valuation and
Initial Margin, into which the EOD Reports published by each CCP can be converted based on the business
logic of their reports. This translation can be executed by a customer built translator, or any alternate
method that our users want to employ.

Calypso’s coverage for the services offered by the CCPs above is:

e LCH SwapClear and SwapClear US:
All eligible products.

© 2018 | Calypso Confidential - Copyright © Calypso Technology, Inc. All Rights Reserved
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- Interest Rate Swaps: Vanilla, Basis, OIS, Zero Coupon, Variable Notional
- FRAs

e CME Clearing House:
All eligible IRS products.
- Interest Rate Swaps: Vanilla, OIS, Zero Coupon, Single currency basis swaps
- FRAs
FX NDFs

e CME Clearing Europe:
All eligible IRS products.
- Interest Rate Swaps: Vanilla
- FRAs

Similar levels of support for other CCPs and services will be added as they become operational.

2.2 Intraday Processing

The trades are imported in real-time from the CCP. For each trade captured on the affirmation platform, two
mirrored trades are created in Calypso:

e  One to reflect the clearing member position at the CCP
e  One to reflect the client / house position at the clearing member

The trades navigate the Calypso workflow based on their clearing status (cleared, rejected, request), using
straight-through processing and exceptions monitoring. Once the trades are cleared, they update the accounts
positions. Intraday commissions and periodic fees are computed on the trades.

The system allows generating intraday margin call trades as margin calls are made by LCH.

The system also supports CCP limit checks for pre-clearing.

2.3 EOD Processing

The key aspects of the EOD processing are as follows:

e  Monitoring of house and client accounts

e Import and processing of CCP EOD files

e Management of settlement activity flowing from this processing
e  Generation of Market Data based on EOD files

e  Storage of trade level valuations based on Marks in EOD files

e  Collateral Management process

e  Regulatory reporting: Client Statements, CFTC Minimum Net Capital Requirement report, Sequestration
Fund Requirement report, Collateral Value report (LSOC regulation)

At EOD, a number of files are imported from the CCP to update the client / house positions with the cashflows that
are to be passed from the CCP to the clearing member, and ultimately to the Client or House entity. These
cashflows include the PAI, Coupons, Fees, and Variation Margin.

Initial margin (IM) requirements are imported from EOD files into the system and stored as pricer measures on
Collateral Exposure trades, based on Margin Call Contracts configurations. There is one Collateral Exposure trade
per Margin Call Contract and currency. Through the Collateral Management process, Calypso generates Margin Call
trades to transfer cash or collateral securities into and out of the client’s accounts in order to maintain sufficient
collateralization of their cleared positions. They are reported on the client statement, and based on the client’s
request, the margin calls can then be settled, paid in a different currency, or substituted to collateral securities.

Variation margins (VM) are represented by the cash positions of the cash client / house accounts. Margin calls to
the variation margin requirements are computed through the Collateral Management process in cash, and occur
when there is a negative balance in the client’s cash account.
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Clearing Member Positions at the CCP

For house activity, there is one Margin Call Contract per CCP and product type that handles IM between the
clearing member and the CCP.

For client activity, there is one Margin Call Contract per CCP and product type that handles IM between the clearing
member and the CCP.

The initial margins can be stored in the base currency of the Margin Call Contract, or in the native currency. Margin
calls are computed in the corresponding currency, and can be substituted to collateral securities.

There is no variation margin requirement between the clearing member and the CCP.

Client Positions at the Clearing Member
Initial Margin
There is one IM Margin Call Contract per Client, CCP and product type.

The initial margins can be stored in the base currency of the Margin Call Contract, or in the native currency. Margin
calls are computed in the corresponding currency, and can be substituted to collateral securities.

Variation Margin

The system supports storing variation margins in multiple currencies, or in a single currency, based on the client’s
choice.

e  Multi-currency scenario — There is one VM Margin Call Contract per Client and per currency (regardless of
CCP and product type).

In this case, there is one variation margin per currency, and the margin calls are computed per currency.

e  Single-currency scenario - There is one VM Margin Call Contract per Client.

In this case, all variation margins are converted to the base currency of the Margin Call Contract. There is
one variation margin in base currency, and the margin calls are computed in base currency.

The various scenarios, and their impact of the Collateral Management process and the client statement, are
described in the Calypso Clearing Member User Guide.

2.4  Account Definition

The clearing member module supports the following types of accounts:
e House accounts for clearing member house activity
e Individual segregated client accounts (ISA) for individual client activity

e Omnibus segregated client accounts (OSA) for clients that provide clearing activity for their own individual
clients

House Accounts

House accounts are created to monitor the clearing member’s trading activity, and differ from client accounts
primarily in the way that they are treated by the CCP and Regulators.

© 2018 | Calypso Confidential - Copyright © Calypso Technology, Inc. All Rights Reserved
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Clearing House (CCP)

!

Clearing Member

A/\A

House Activity

Internal Internal
Counterpartv #1 Counterparty #2
House Account #1 House Account #2
Calvnso Leaal Entitv Calvn<n Arcoiint

Each house account is represented by an internal counterparty, which is a legal entity of the trading group within
the same corporate structure, and a set of Calypso accounts.

Trades are entered at the Internal Counterparty level, in the House book.

VM, PAI, Coupons, Upfront Payments, etc. are calculated by the CCP at trade level - They are reported and
accounted in Calypso at the House Account level.

IM is calculated at the Internal Counterparty level.

e IMis settled between the CCP and the Clearing Member at the Clearing Member level across all house
accounts

e IMis settled between the Clearing Member and the Internal Counterparty at the Internal Counterparty
level

Individual Client Accounts

Clearing House (CCP)

!

Clearing Member

.

Individual Client Activity

Client #1 Client #2 Client #3
Client Account #1 Client Account #2 Client Account #31 Client Account #32
Calvnso | paal Fntity Caluncn Account

Each client account is represented by an external counterparty, and a set of Calypso accounts. An individual client
may have multiple unique accounts. Each account is managed independently at the CCP.

Trades are entered at the Client level, in the Client book.

VM, PAI, Coupons, Upfront Payments, etc. are calculated by the CCP at trade level - They are reported and
accounted in Calypso at the Client Account level.

IM is calculated at the Client level.
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e IMis settled between the CCP and the Clearing Member at the Clearing Member level across all client
accounts

e IMis settled between the Clearing Member and the Client at the Client level

Omnibus Client Accounts

Clearing House (CCP)

|

Clearing Member

/\A

Omnibus Client Activity

Omnibus Client #4 Omnibus Client #5
Client #41 Client #42 Client #51 Client #52
Client Account Client Account Client Account Client Account #52
#41 #42 #51
Calypso Legal Entity Calypso Account

The omnibus client provides clearing activity for its own individual clients.

Each omnibus client is represented by an external counterparty. Each individual client is represented by an external
counterparty, which parent is the omnibus client, and a set of Calypso accounts.

Trades are entered at the Client level, in the Client book.

VM, PAI, Coupons, Upfront Payments, etc. are calculated by the CCP at trade level - They are reported and
accounted in Calypso at the Client Account level.

IM is calculated at the Omnibus Client level.

e IMis settled between the CCP and the Clearing Member at the Clearing Member level

e IMis settled between the Clearing Member and the Omnibus Client at the Omnibus Client level
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Multi Branch Account Structure

Generally, Fund manager opens multi branch account wherein trades are cleared in individual position account and
VM and cash flows are calculated and reported at individual position account level and IM is calculated across all
portfolio (position accounts) i.e. performance bond account level. So in clearing system user will need to define
clearing account for both position and performance bond account level. Individual Funds (Legal Entity) will have
parent entity as fund manager. As per example given above 5 Client statement will be generated i.e. fund manager
(for IM) and individual funds level (for VM), also AMC will be calculated at parent entity level by considering total
equity of all underlying clients.

Clearing House (CCP)

|

Clearing Member

|

Multi Branch Client Activity

Performance Bond

Fund Manager —> Account
Fund 1 Fund 2 Fund 3 Fund 4
Position Account Position Account Position Account Position Account
Calypso Legal Entity Calypso Clearing Account

Custodial Segregation Account Structure

Custodial Segregation is an extension to Individual Segregation Account. LCH.Clearnet has developed the Custodial
Segregation (CustodialSeg) account (CSA) model in combination with end users of OTC derivatives (collectively,
the ‘Buy-side’), Clearing Members, Custodians and Central Securities Depositories to provide additional protection
for the Buy-side beyond the requirements of EMIR 39.3 (Individual Segregated Account).

The CustodialSeg account segregates the Buy-side client’s positions from those of all other clients, as well
segregating the assets allocated for collateral, which remain under the beneficial ownership of the client. The
account can be operated by the client’s nominated custodian and minimizes transit risk associated with moving
securities to and from SwapClear via the clearing member. In a clearing broker default, LCH.Clearnet cannot draw
on the client’s allocated assets to meet losses of any other clients and both positions and collateral can port to
another clearing broker of the client’s choice.

In order to maintain Clearing Member controls as may be considered towards a security financial collateral
arrangement LCH.Clearnet has devised the model involving both pre-defined controls (e.g. affirmation type and
eligibility sets) and event specific controls (e.g. manual affirmation of transaction amount and booking of
transaction amount to the Clearing Member books).

LCH.Clearnet has enhanced the existing SWIFT MX Message Service for the purpose of Clearing Members who are
seeking to automate event specific controls. As such LCH.Clearnet offers, with the SWIFT MX Message service, the
ability for Members receive automated notification or client instructions directly into their own systems from CMS
and the ability to Affirm or Reject these instructions without the need to sight verify and authorize the instruction
manually in the CMS GUI. An accepted instruction from this service will continue its lifecycle in CMS as normal,
starting from an initial status of ‘Instructed’.

The service will permit a Member to receive and affirm or reject the following Collateral Proposals from the client in
a single message: Triparty Collateral (Lodge, Amend and Close).

This entails:

e  Support SIFWT MX colr.007 inbound to LCH, colr.008 and colr.006 LCH outbound messages in Back Office
Module

e We need to generate Margin Call Trades facing to client and CCP for client of type CSA in clearing module
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The scope of this feature is limited to NON-CASH COLLATERAL for LCH-IRD

ey e >
Mrg Call hrg Call
WX Coir 003 X Colr.003
—
Propose
M Colr.007
——
Respond
M Colr.005
Request
i Goir. 007
Third Party
Messagin - Affirm i
Sewlgce ¢ Clearing Member 1 Gon 00 LCH.Clearnet Ltd Client
Asset Manager
Cancallation Collateral Manager
WX Colr.007
e
Tpty Status Message
T 558
All Account
Tpty Stmnt Types
T 560
Custodial
stmnt Hid stmnt Hid Seg Oy
k T 535 T 635
Cash Stmnt Cash Stmnt
/ MT 950 T 950

Settlement
Activity

o

FCM receives MT558 once they respond to original request sent by LCH on receipts of collateral allocation request
from client through Custodian. MT 558 is sent for different status such as matched and settled collateral allocation

by LCH.

FCM receives MT569 statement approximately 13 times a day only for CSA accounts with non-cash collateral
nominal holding, market price.

According to LCH they do not send MT558 for substitution hence we cannot use this message for generation of
Margin Call Trade.

The use of the MT535 messages provides Statement of Holding reports, sent daily for end of the prior day, allowing
members to reconcile positions and valuations utilized for cover by the Clearing House. This information remains
available within the CMS GUI.

Additionally, Members may request that LCH.Clearnet send the Statement of Holdings (MT535) messages for
specific Individually Segregated Accounts (ISAs) directly to a third party such as the underlying Client, Asset
Manager or Custodian acting on behalf of the Client

For Clearing Members who offer Custodial Seg accounts the MT569 Triparty Collateral and Exposure Statement,
sent either intraday or end of day for the current business day, allows members to reconcile positions and
valuations utilized for cover by the Clearing House in respect to securities pledged directly by clients. Clearing
Member may also wish to receive status updates in respect to Custodial Seg triparty transaction activity intraday
through the utilization of the MT558 Triparty Collateral Status and Processing Advice. Both sets of information
remain available within the CMS GUI.
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MTS35
Statement of Holdings
:"ITEES mtdma
ii INg3 i
Clearing Member CAE Statement 2 Third Party
MT358
TParty C Status & P
1 ~ 1
! ™. Status Updates , © '
i ~ - [
Settlement | S -7 I Settlement
Instructions : : Instructions
[ [
[ [
_____ .‘ .‘. ———
* For specific Subaccounts
1. Custodial Seg is only supported for clients who choose ISA or Multi Branch ISA account structure
2. Import MT569 which will be sent by LCH periodically, store it as BO message object
3. Import Collateral Position from Block Cla lesser of :19A::COVA and :19A::TRAA which is reported Post
Haircut
4. Retrieve currency from tag :19A which is of 3 characters size after two front slash for e.g.
:19A::COVA//GBP533000000,51 and :19A::TEXA//GBP533000000,
5. Cla block can be repetitive in case client gets transferred from one clearing broker to another clearing
broker
6. Few FCM would be creating dummy BPD by currency which we need to retrieve based on matching bond
denomination currency reported under tag 19A (transaction currency), and security code
CLEARING_DUMMY_CUST_SEG=True. Client can on board themselves in either of USD, GBP or EUR
currency
7. Few FCM would end up creating Margin Call trade in actual BPD by looking at Clal block (in next phase),

ZPm-duct Code Window =10] x|
Name [CLEARING DUMMY_CUS... =] .. | Type [bookean |

Product IEund vor |

so we will manage this through ST attribute to signify whether to look for actual bond based on ISIN
based on tag 35R or dummy bond based on transaction currency mentioned in 19A of Cla block

™ Unigue ¥ Searchable [ Mandatory

CLEARING_DUMMY_CUST_SEG |boolean |false  frue  |false Bond

Mame Type | Unique | Searchable | Mandatory Prov
FREV_RED_IMDEX string  |false false false CDSIndex ;I
MEXT_RED_IMDEX string  |false false false CDSIndex
RED_FAIR string  |false false falze Bond
IsPreferred boolean |false false false Bond

Load | Mew | Delete | Save | Close |

10.

Import Position Account ID from 95R::PTYB/LCHL/ which will give us IM Margin Call Contract ID, however
it is MUST for SCM to make this specific request to LCH to populate Account ID in 95R while on boarding
client.

Import Party mnemonic from 97B::SAFE which will be FirmID defined at PO LE attribute

Block C is further bifurcated into C1, Cla, Clal
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11. C1 provides information of non-cash collateral post haircut in EUR currency, Cla provides information of
non-cash collateral post haircut in transaction currency which client can choose while on-boarding. LCH
support EUR, GBP and USD as Transaction currencies, so client need to select one of the currency as
transaction currency. Clal provides information ISIN level in non cash collateral denomination currency
and also in transaction currency with FX rate for conversion.

Name ~ || Type / Code - |Calypso Mapping
23G Function of the Message 4lc[idic]
98a Date/Time [0..1]
22a Indicator [1..%]
Collateral Parties (A1) COLLPRTY

16R. Start of Block COLLPRTY
95a Party [1..1]
Party A [PTYA] [1..1]
Party A's client [CLPA] [1..1]
Triparty Agent [TRAG] [1..1]
97a Account [0..1]
Safekeeping Account [SAFE] [0..1]
97A Aleli35%
Qualifier Alef
Account Mumber 135
978 Alc/[Gc)dlc/35x
Qualifier Alef
Data Source Scheme [Bc] First 3 character for CCP short name
Account Type Code 4lc/ PO attribute - search in LCHFirmld, CMEFirmld and EurexFirmld
Account Number 35x
165 End of Block COLLPRTY
Linkages (A2) LINK
16R Start of Block LIMK
13a Number Identification [0..1]
Linked Message [LINK] [0..1]
20C Reference [1..1]
Related Message Reference [RELA] Alci16x
Previous Message Reference [PREV] Alci16x
165 End of Block LINK
165 End of Block GENL
Owverall Summary (B) SUMM
Summary by Exposure Type (C) SUME
16R Start of Block SUME
22a Indicator [1..%]
194 Amount [1..7]
92A Rate Alcl{[N]15d
25D Status Alc/[8c]dlc
Summary by Counterparty (C1) sumc
16R. Start of Block SUmc
138 MNumber [0..%]
95a Party [1..%]
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Party B [PTYB]

(1.1

95P “Alciidla2la?lc[3lc]
9500 Alcii4*35x%
95R Alc/Bef34x Margin Call Contract
PO: Based on Account Type Code Mapping to LE
Margin Type: IM
Qualifier Alef
Data Source Scheme 8cf
Proprietary Code 34x
Triparty Agent [TRAG] [0..1]
19A Amount [1.7]
92A Rate Alc//[N]15d
25D Status Alc/[5c]/dle
Transaction Details (C1a) TRANSDET
16R. Start of Block TRANSDET
20C Reference [1..5]
98a Date/Time [1..7]
Closing Date/Time [TERM)] [1..1]
984 Ale/YYYYMMDD
Qualifier Alef
Date MYYYMMDD Margin Call Trade and Value Date
988 -Alc/[8c]/lc
Qualifier Alef
Data Source Scheme [&c]
Date Code 4l
Open Ended OPEN
98C Ale/YYYYMMDDHHMMSS
Qualifier Alef
Date MYYYMMDD
Time HHMMSS
Execution Requested Date/Time [EXRQ] [1..1]
98A Ale/YYYYMMDD
Qualifier Alef
Date MYYYMMDD
98B Alc/[c]idlc
Qualifier Alef
Data Source Scheme [Bc]
Date Code Al
Open Ended OPEN
98¢ Ale/YYYYMMDDHHMMSS
Qualifier Alef
Date MYYYMMDD
Time HHMMSS
19A Amount [1..7]

Value of Collateral Held [COWA]

Alch[N]3la15d

Margin Call Amount = Min{COVA TRAA)

Following are details on MT569 message blocks:

A - General Block

B - Overall Summary

C - Summary of Exposure Type
D - Network Validation Rule

Custodial Segregation Setup Requirements:

1. Set environment property CLEARING_TRIPARTY_ALLOCATION=true.

2. Create PO attribute ClearingDummyCustSegBond=True/False, default value is “True”,

True = create margin call in dummy bond

False = create margin call in underlying ISIN, this option out of scope for this phase

3. Create new workflow called *INCOMINGCUSTSEG” to transition MT569 message object
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MOME
M

PEMDIMG
PROCESS
UFPDATE
| REJECT | CANCEL
REJECTED |= RECEIVED | -  CANCELED |
TRAMELATE
REFROCESS
¥ ¥
TRAMNSLATED |
Orig Status Action Result Status STP WF Rule
NONE NEW PENDING
PENDING PROCESS RECEIVED Yes
RECEIVED TRANSLATE | TRANSLATED Yes TranslateSwiftToMarginCall
TRANSLATED | REPROCESS | TRANSLATED TranslateSwiftToMarginCall
RECEIVED CANCEL CANCELED
RECEIVED REJECT REJECTED
4., Import MT569 using Import engine

18

Translate following fields from message to retrieve existing actual security position (if any) and to
create Margin Call for the differences facing to LCH and Client. This processing should be done in

TranslateSwiftToMarginCall WF rule on Message transition (Work Flow) so that if the need be user
can reprocess stored MT569 message:

Block | Tag Sample Type/Code Location Description/Mapping Acronym
Al 97B | {1:FO1 [8c] Biccode Retrieve CCP (LE short name) CCPsare
LCHLGB2LXXX info using LE Contact (Contact
Type="SWIFT"”) wh SWIFT
0000000000} ype ) where

code (initial 8 characters)
matched with sender
information. We need CCP for
IM MCC Mapping through
mccAdditionalField.CCP
additional info.
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Block | Tag | Sample Type/Code Location Description/Mapping Acronym
Al 97B | 97B::SAFE/LCHL | /4!c/ LCH 3 character Mnemonic info for PO mapping FIRMIDwmnem
/MNEM/AAA value after through PO LE Attribute
MNEM first front LCHFirmId
slash /"
Al 98E :98E::PREP//201 | :41c//YYYYMMD | first 8 characters | Retrieve date for transaction DATEvaLn
50625172856/+ | DHHMMSS[,3n] | which are in and value date of non-cash
0100 [/INJHH[MM]] YYYYMMDD collateral
format post two
front slash
C1 95R | :95R::PTYB/LCH :41¢c/8c/34x Characters from ClientAccountld (matching to CCPREFpry8
L/GIG128 LCHL/ i.e. 86¢) /position account id (short
second front name) for mappin it with IM
slash /" MCC through CCP_REFERENCE
additional info
Cla 20C :20C::CLTR//CSI | :41c//16x Characters from Retrieve CLTR i.e. unique EXTREF
000003 two front slash collateral transaction reference
to store on MC trade keyword
Cla 19A | :19A::COVA//EU | 3la 3 character from | Retrieve currency for booking TXNCCY
R776903618,59 second front non-cash collateral
slash /"
Cla 19A | :19A::COVA//EU | :4ic//[N]3!al5d | MIN(COVA,TRAA | Retrieve amount for booking COLcova
R776903618,59 ) Value post 3 non-cash collateral, this is post
character from haircut number
second front
slash /"
Cla 19A :19A::TRAA//EU 3la 3 character from | Retrieve currency for booking TXNCCY
R776903618,59 second front non-cash collateral
slash /"
Cla 19A | :19A::TRAA//EU :4!c//[N]3'al5d | MIN(COVA,TRAA | Retrieve amount for booking COLrran
R776903618,59 ) Value post 3 non-cash collateral, this is post
character from haircut number
second front
slash /"
5. To create margin call trade system retrieves following information:
Mapping Source Filters Validation Acronym
Information
Non Cash Bond Product 1. Bond Product Currency = Currency | If we retrieve two Bondrxncey
Collateral Definition from 19A tag bonds for above

2

98E tag

PIIRODUCT_CODE.CLEARING_DUMMY
_CUST_SEG = True

3. Bond Maturity Date >= Date from

combination then
system should
generate exception
in task station saying
“Multiple dummy
bonds cannot persist
for transaction
currency of block
Cla Tag 19A”




Clearing Member Setup Guide

Client Facing IM
MCC

Margin Call
Contract

1. Processing Org : PO LE based on
LCHFirmID

2. CCP_REFERENCE :
ClientAccountId from 95R

3. MARGIN_TYPE : “IM”

If we could not
retrieve IM MCC for
above combination
then system should
generate exception
in task station saying
“No IM MCC available
for <Client for 95R>
filter information
Processing
Org=<value>,
CCP_REFERENCE=<vVv
alue> and
MARGIN_TYPE=<val
ue>"

MCCecuient

20

CCP Facing IM
MCC

Margin Call
Contract

1. Processing Org: PO LE based on
LCHFirmID

2. CCP_REFERENCE: Value form
*CCPSegregationAccount (additional
info from retrieved client facing IM
MCC) post hyphen “-" value

3. MARGIN_TYPE: “IM”
4. LE: Value from 97B

If we could not
retrieve IM MCC for
above combination
then system should
generate exception
in task station saying
“No IM MCC available
facing to <CCP from
97B> for filter
information
Processing
Org=<value>,
CCP_REFERENCE=<vVv
alue>,
MARGIN_TYPE=<val
ue> and LE =
<value>"

MCCeccp

CCPSegregationAccount: IM MCC additional info attribute is recently introduced as part of SOD requirement.

The purpose of adding CCPSegregationAccount additional info MCC attribute is to retrieve CCP facing contract and
do 1 to many link based on type of account structures i.e. omnibus or individual segregated.

For information see below 86c:

MCC IM -> Client facing would have CCP_REFERENCE=HSWGIGANOSA1
MCC IM -> LCH facing would have CCP_REFERENCE=ADOPT1NOSA

Rep19 will show following information:
MCC IM -> Client facing would have ACCOUNT=0083/SWP-ADOPT1NOSA
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A B c | D E F G
Cobdate ¥ | Scmmn * | Scmnarn ~ | Account -T| Curreni ~ | Cashcovbalamt | * | Cashcovbaltot | =
7/31/2015 0:00 HSW HSBEC BAN O083/SWP-ADOPTINOSA GEP 20157904857 20157904857
7/31/2015 0:00 HSW HSBEC BAN O083/SWP-ADOPTINOSA GEP 20157904857 20157904857
7/31/2015 0:00 HSW HSBC BAN O083/SWP-ADOPTINOSA GBP 50157904857 50157904857
7/31/2015 0:00 HSW HSBC BAN O083/SWP-ADOPTINOSA GBP 50157904857 50157904857
7/31/2015 0:00 HSW HSBC BAN 5081/5WP-ADOPTILDISA GBP 50162188212 50162188212
7/31/2015 0:00 HSW HSBC BAN 5081/5WP-ADOPTIDISA GBP 50162188212 50162188212

LCH.Clearnet Limited
Overnight Cover Distribution

Doc No - REP00019 Report Last Refreshed:

Date 3072015

Member HSW HSBC BANK PLC

Account O0835SWP-ADOPTINOSA

Cumency GBP

Cash Cover Balance : CREDIT 50,157 904 857.08 50,157,904,857.08

Comm Group: LIABILITY: -7,244 260 29
SWP GBP US T Bonds (UsD) 7,244 26029
Liability Shortage GBP 0.00
0.00
Total Met Shortage of GBP 0.00
Owverall Unutilised Amount Total
Bonds (USD) 48,211,803, 1132.77 28,420,636, 904.33

Other Cash (GBP)

50,157,904,857 08

Use following filters to calculate Margin Call Non-Cash Positions for IM:

50,157,904 857 .08

Filter Criteria Source Default Value
Position Type ACTUAL
Underlying Type “Security”
ProcessingOrg PO based on 97B MNEM N/A
Valuation Date Date based on 98A VALN N/A
Collateral Context PO Attribute EODCollateralContext N/A
Additional Info CCP CCP based on 97B SAFE N/A
Additional Info MARGIN_TYPE M
PRODUCT_CODE.CLEARING_DUMMY_CUST_SEG True

Filter Client Facing IM MCC: Calculate Sum(Value) by Currency and CCP_REFERENCE henceforth referred as
COLVALcLent

Filter Criteria Source Default Value

Additional Info CCP_REFERENCE CCP Reference Based on 95R facing to Client | N/A
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Filter CCP Facing IM MCC: Calculate Sum(Value) by Currency, CCP_REFERENCE and CCP henceforth referred as

COLVALcce

Filter Criteria

Source

Default Value

Additional Info
CCP_REFERENCE

Value from ACCOUNT attribute post hyphen on IM MCC
facing to client

N/A

Following fields are considered for generating Non Cash Collateral margin call trade facing to Client:

Column Sample Data Description

Action NEW “NEW"”

ExternalRefld

CounterPartyRole Orderer Role from MCCcuenr, If not set then it
Client should be blank

Counterparty CPTY_1 Client based on CCPREFe1vs

OrdererRole Set as "CounterParty" if Orderer Role is set on
CounterParty MCCcuent else it should be blank

ProcessingOrg Set as CCPSAFE if Orderer Role is set on MCCcLient
CPTY 1 else set as PO of FIRMIDwnem

TransferType SECURITY "SECURITY"

TradeCurrency GBP TXNCCY

Quantity 4555 Min(COLrraa, COLcova)-COLVALcLent

TradeDate 20150706 DATEvawn

SettlementDate 20150706 DATEvawn

TradeBook

PO1_CLIENT_CLEAR
ING@CMF

Book from MCCcuient

SalesPerson NONE “NONE"
ProductType MarginCall “MarginCall”
TradeDirection ‘Pay’ if Quantity is Negative. ‘Receive’ if Quantity is
positive. DO NOT generate any margin call if
Pay quantity=0
CollateralType SECURITY "SECURITY"
Contractld 1601 Contract ID of MCCecuient
SecCode ISIN ISIN
SecCodeValue US3620ABHW95 Bondmxncey
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Column

Sample Data

Description

Price

Dummy Bond’s Price based on QuoteUsage defined
in Pricing Param Intraday Pricing Environment
defined on of MCCcuent . This should be available
through collateral API using intraday PE as a

99 parameter
Keyword.CCP LCH CCPsare
Keyword.CCPSettlementType ITD_CS “ITD_CS”
Keyword.CCPAccountReference LCHTESTS88 CCP_REFERENCE Additional Info from MCCctient
Keyword.ClearingColTransRef CSI1000003 EXTREF, :20C::CLTR//CSI000003

Nominal Calculated Value using collateral API, Qty * Face
Value from Bond Product Definition
Accrual Calculated Value using collateral API, based on IM

MCC attribute USE_RAW_PRICE=True/False, Last
coupon date - current date based on day count
factor

Following fields are considered for gen

erating Non Cash Collateral margin call trade facing to CCP:

Column Sample Data Description

Action NEW “NEW"”

ExternalRefld

CounterPartyRole Client Orderer Role from MCCccp, If not set then it should
be blank

Counterparty LCH Client based on CCPsare

OrdererRole CounterParty Set as "CounterParty" if Orderer Role is set on
MCCccp else it should be blank

ProcessingOrg LCH Set as CCPSAFE if Orderer Role is set on MCCccp
else set as PO of FIRMIDwnem

TransferType SECURITY "SECURITY"

TradeCurrency GBP TXNCCY

Quantity 4555 Abs(COLVALccp) - Min(COLtraa, COLcova)

TradeDate 20150706 DATEvan

SettlementDate 20150706 DATEvawn

TradeBook

PO1_CLIENT_CLEAR
ING@CMF

Book from MCCccp

SalesPerson

NONE

\\NONEH
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Column Sample Data Description
ProductType MarginCall “MarginCall”
TradeDirection ‘Receive’ if Quantity is Negative. ‘Pay’ if Quantity is
positive. DO NOT generate any margin call if
Pay quantity=0
CollateralType SECURITY "SECURITY"
Contractld 1601 Contract ID of MCCccp
SecCode ISIN ISIN
SecCodeValue US3620ABHW95 Bondrxncey
Price Dummy Bond'’s Price based on QuoteUsage defined
in Pricing Param Intraday Pricing Environment
defined on of MCCccr. This should be available
through collateral API using intraday PE as a
99 parameter
Keyword.CCP LCH CCPsare
Keyword.CCPSettlementType ITD_CS “ITD_CS”
Keyword.CCPAccountReference LCHTESTS88 CCP_REFERENCE Additional Info from MCCccr
Keyword.ClearingColTransRef CSI000003 EXTREF, :20C::CLTR//CSI000003

Nominal Calculated Value using collateral API, Qty * Face
Value from Bond Product Definition
Accrual Calculated Value using collateral API, based on IM

MCC attribute USE_RAW_PRICE=True/False, Last
coupon date - current date based on day count
factor

Following are the scenarios for direction based on signs of Quantity:

Scenariol: Posted Collateral More than MT569

Source Client CCP Currency
MT569 5000 5000 | GBP
MCP 10000 -10,000 | GBP
Movement -5000 5000 | GBP
Direction Pay Receive
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MT569 5000 5000 | GBP
MCP 2000 -2000 | GBP
Movement 3000 -3000 | GBP
Direction Receive Pay

MT569 5000 5000 | GBP
MCP 0 0 | GBP
Movement 5000 -5000 | GBP
Direction Receive Pay

MT569 5000 5000 | GBP
MCP 5000 -5000 | GBP
Movement 0 0 | GBP
Direction No Call No Call

Clearing Member Setup Guide



Clearing Member Setup Guide 26

2.5 Clearing Solution Flow

Affirmation Platform

Client trades

«— 1 —»

Trade Event messages ¢ T Consent/Reject messages

Clearing House (CCP)

Trade Event Consent/Reject 5 EOD CCP Files
messages messages

Exchange Feed Scheduled Tasks

CDML files processing

A "
Upload Documents l (Note: Configured per CCP)
Data Uploader
4 Consent/Reject PAI - Fees - Coupons
Messages l messages Initial Margins
Variation Margins
) Reference Data
Client/CMF trades .
g a Legal Entities and Accounts
CMF/CCP trades
SDIs - Drive t fers t t:
c s ] rIYe ranz c-;rs © accounts Client/CMF Clearing Transfer trades
omrmissions and Fees CMF/CCP Clearing Transfer trades
Limits Check Collateral Exposure trades
Margin Call trades 6
3 ERS Limits Accounts Positions
Settlement accounts
Market Data Clearing accounts Cash Collateral Margin Call 8
balances Exposure Allocations
Scheduled Tasks l \b
CLEARING_IMPORT_MARKET_DATA Collateral
Scheduled Tasks Margin Call Contracts
CLEARING_STATEMENT (IM - VM)
‘ Calypso - Clearing Member 7 Client Statement
a

Steps Details

Client trades are captured in the Affirmation Platform and routed to Calypso through the CCP and
1 Calypso Exchange Feed using Trade Event messages.

The Calypso Exchange Feed transforms the messages into Upload Documents, and triggers the Calypso
Data Uploader.

The Calypso Data Uploader creates mirrored trades in Calypso to reflect the clearing member position
2 at the CCP, and the client position at the clearing member.
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Limits are checked on the trades using ERS Limits.

Once the trades are validated/rejected in Calypso, a consent/reject message is sent to the CCP so that
the trades can be cleared, or rejected back to the executing broker.

Once the trades are cleared, they update the accounts positions.

Intraday commissions are computed on the trades. Periodic fees, rebates, and maintenance fees are
invoiced to the clients.

EOD - The CCP files are imported into Calypso using scheduled tasks.

The scheduled tasks perform the following:

e CDML files processing - You first need to store the files into the system using the scheduled
task CLEARING_TRANSLATE_TO_CDML. Then you can process the files using the scheduled
task CLEARING_PROCESS_FROM_CDML.

The scheduled task CLEARING_PROCESS_FROM_CDML consumes the imported
tradeValuationReport and initialMarginRreport CDML reports.

e A set of scheduled tasks allow importing market data:
- CLEARING_IMPORT_MARKET_DATA
-  CLEARING_IMPORT_SCENARIO_SHIFTS

e  COLLATERAL_MANAGEMENT computes cash margin calls on initial margins and variation
margins.

e ERS_ANALYSIS kicks off the calculation and storage of the limits usage and availability.

Generation of the client statements using the scheduled task CLEARING_STATEMENT.

Once the client receives the client statement, the client decides how to meet the margin calls computed
by the COLLATERAL_MANAGEMENT scheduled task: in cash, securities, or both.

The margin calls are modified accordingly using the Collateral Manager, and are settled as applicable.
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Section 3. Before you Begin

Before you begin, you need to define the following reference data.

3.1 Eligible Currencies

If you want to generate the Sequestered Report by currency, you need to define the eligible currencies for clearing.

The eligible currencies are defined using Configuration > Definitions > Currency Defaults from the Calypso
Navigator.

Click Attributes, and set the attribute ClearingEligible = True.
_A Currency Default Attributes Window EUR

Mame Walue

learingEligible | True

3.2 Pricing Environments

You need to create the following pricing environments, pricer configurations, quotes sets, and pricing parameter
sets.

Pricing Env FROMDB | CME_IM CME_VM | LCH_IM LCH_VM
Pricer Config FROMDB CME_IM CME_VM LCH_IM LCH_VM
Quote Set FROMDB CME_IMReplication default LCH_IMReplication default
Pricing Parameter Set | FROMDB CME CME LCH LCH

The pricing environment FROMDB is used for back office activities, and CME_IM, CME_VM, LCH_IM, LCH_VM are
used for ERS activities.

All pricing parameter sets listed above should have:

e USE_MARKS = true

e ADJUST_FX_RATE = false
e  Pricing Parameter Set FROMDB: ZD_PRICING = false

Pricer configurations CME_IM, CME_VM, LCH_IM, LCH_VM:

e  Swap product = PricerSwap

e FRA product = PricerFRA

[NOTE: The quote sets CME_IMReplication and LCH_IMReplication must be defined in the Data Mapping window for
InterfaceName = CME/QuoteSet or LCH/QuoteSet, and Interface Value = IMReplication — See Market Data for
details]

Pricer configuration FROMDB:

e  Swap product = PricerFromDB

e  FRA product = PricerFromDB
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e  FXNDF product = PricerClearingFromMarks (same as PricerFromDB, but it always uses the settlement ccy
of a trade for loading marks).

e  (ClearingTransfer product = PricerFromDB
e  CollateralExposure product = PricerCollateralExposure

e  MarginCall = PricerFromDB

The pricing environment names in this documentation are only suggestions. Please feel free to assign names
according to your business needs.

3.3 Data Uploader Setup

3.3.1 MQ Series Setup

Please refer to Calypso Data Uploader documentation for details.

3.3.2 Incoming Messages Setup

The Data Uploader creates GATEWAYMSG incoming messages into Calypso, and creates the trades.

By default, the system sets the message sender to CLIENT and the message RECEIVER to CALYPSO. If these
entities do not exist as Legal Entities, the system will create them.

You can change those values as needed in the file "<calypso
home>/client/resources/gatewayservice.properties”.

Rename “<calypso home>/client/resources/gatewayservice.properties.sample” to “<calypso
home>/client/resources/gatewayservice.properties” and modify as needed.

GatewayServiceClientName=CLIENT
GatwayServiceHostName=CALYPSO

Message Workflow

You need to define a message workflow to handle these messages.
e EventClass: PSEventMessage
e  Subtype: GATEWAYMSG
e  Product: ALL

Orig Status Resulting Status | Different User | Use STP | Priority Product Type
NONE  |NEW PENDING_VALID ] ] o Wl |GATEWAYMSG |ALL
PENDING_TRADE |CAMCEL CANCELED r r ol T |cATEWAYMSG |ALL CancelCleanUp
PENDIMG_TRADE |LOAD COMPLETED - [+ ol [T |GATEWAYMSG |ALL CheckLink,Loader
PENDING_TRADE |REPROCESS |PENDING_TRADE r r ol T |caTEwAYMSG |aLL ReMap
PENDIMG_VALID |CAMCEL CAMCELED - - ol ™ |sATEWAYMSG |ALL CancelCleanUp
PENDING_VALID |REPROCESS |PENDING_VALID r r ol T |caTEwAYMSG |aLL ReMap
PENDING_VALID |VALIDATE  |PENDING_TRADE r ~ ol ™ |caTEWAYMSG |ALL CheckLink, Validate

[NOTE: Any status code change to this workflow needs to be recorded in the file “[calypso
home>/client/resources/gatewayservice.properties”]

# Gives list of BO Messages states that are used to link pending messages
# These messages are blocked messages due to some validation error.
BOMessageIncompleteStates=PENDING VALID, PENDING TRADE, BACKLOAD
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3.3.3 Trade Workflows
Note that the trade workflows are set per processing organization.
The PO is the clearing member. For example, PO = CGM LLC.
ALL Product Types
Product Type = ALL
Orig Status Action Resulting Status Use Rules / Filter Create
STP Task
CLEARED AMEND VERIFIED true Rule AutomaticFees true
Filter CCPStatus-NOT-ALLEGED
CLEARED UPDATE CLEARED false  Rule AutomaticFees true
CLEARED TERMINATE TERMINATED false Rule false
AutomaticFees,UpdateTermination
CLEARED ENRICH VERIFIED false  Rule AutomaticFees,CheckSDI true
Filter Cleared_On_OR_Before_Today
CONSENT GRANTED UPDATE CONSENT GRANTED false true
CONSENT GRANTED ACCEPT CREDIT_CONSENTED false true
CONSENT GRANTED REFUSE REJECTED false true
CONSENT GRANTED STP-ACCEPT CREDIT_CONSENTED true true
CONSENT REJECTED REFUSE REJECTED false true
CONSENT REJECTED REJECT REJECTED false true
CONSENT REJECTED UPDATE CONSENT REJECTED false false
CREDIT_CONSENTED TERMINATE TERMINATED false  Rule UpdateTermination false
CREDIT_CONSENTED UPDATE CREDIT_CONSENTED false false
CREDIT_CONSENTED AMEND CREDIT_CONSENTED false false
CREDIT_CONSENTED REFUSE REJECTED false  Filter CCPStatus-NOT-CLEARED false
CREDIT_CONSENTED ACK CLEARED true  Filter CCPStatus-CLEARED true
CREDIT_CONSENTED CLEAR CLEARED false  Rule AutomaticFees true
LIMIT_CHECK ACCEPT REQUIRES_CONSENT  false false
LIMIT_CHECK UNDO PENDING false false
LIMIT_CHECK CHECK_LIMIT REQUIRES_CONSENT  true  Filter Limit-WhatIfCheckErrorN true
LIMIT_CHECK CANCEL CANCELED false false
LIMIT_FAILED REJECT CONSENT REJECTED false true
LIMIT_FAILED UPDATE LIMIT_FAILED false false
LIMIT_FAILED AMEND LIMIT_FAILED false true
LIMIT_FAILED RECHECK_LIMIT  PENDING false true
LIMIT_FAILED ACCEPT CONSENT GRANTED false true
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Orig Status Action Resulting Status Use Rules / Filter Create
STP Task

LIMIT_FAILED REFUSE REJECTED false false
NONE NEW CLEARED false  Rule false

AutomaticFees,ClearingLimitPortfolio

Filter CCPStatus-NOT-ALLEGED
NONE NEW PENDING false  Rule false

AutomaticFees,ClearingLimitPortfolio

Filter CCPStatus-ALLEGED
PENDING AMEND VERIFIED false  Rule CheckWhatIfLimits true
PENDING ACCEPT CONSENT GRANTED true false
PENDING WHATIF LIMIT_CHECK false Rule CheckWhatIfLimits true
REJECTED UPDATE REJECTED false false
REQUIRES_CONSENT REJECT CONSENT REJECTED false true
REQUIRES_CONSENT STP-REJECT LIMIT_FAILED true Filter Limit-WhatIFCheckPassN true
REQUIRES_CONSENT REJECT LIMIT_FAILED false Filter Limit-IsViolated true
REQUIRES_CONSENT UPDATE REQUIRES_CONSENT false true
REQUIRES_CONSENT STP-ACCEPT CONSENT GRANTED true Filter Limit-WhatIfCheckPass true
REQUIRES_CONSENT ACCEPT CONSENT GRANTED false false
REQUIRES_CONSENT REFUSE REJECTED false true
TERMINATED AMEND TERMINATED false Rule AutomaticFees false
TERMINATED UPDATE TERMINATED false false
VERIFIED CANCEL CANCELED false false
VERIFIED TERMINATE TERMINATED false Rule true

AutomaticFees,UpdateTermination
VERIFIED MATURE MATURED false false
VERIFIED UPDATE VERIFIED false true
VERIFIED AMEND VERIFIED false  Rule AutomaticFees false
VERIFIED ACCEPT CONSENT GRANTED false true
VERIFIED REJECT REJECTED false true

[NOTE: The transitions CREDIT_CONSENTED — ACK — CLEARED and LIMIT_CHECK — CHECK_LIMIT -

REQUIRES_CONSENT must have “Generate Intermediate Event” checked to force the generation of a trade event

so that the messages can be generated]

Filter CCPStatus-ALLEGED
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ZStatic Data Filter Window [1300075P2/CLEARING_Z9/] (User: slee)

Name:lCCPStatus-.ﬁ.LLEGED Atkributes. .. Sirnul:
Cu:umment:l Pending
Gru:uups:l.ﬁ.N‘f _l
Akkribuke Criteria Filker Waluels) |
KEWORD, Status IN Add ALLEGED

Filter CCPStatus-NOT-ALLEGED

Zﬁtatic Data Filter Window [1300075P2/CLEARING_29/] (User: slee)

Name:ICCF‘Status-NDT-P.LLEGED Attributes. . Sirnulake
Cu:-mment:l Pending
Gruups:l.ﬁ.N‘f _I
Aktribike Criteria Filker Yaluels) |
M Skatic Data Filker MOT_IM Add CCPSkatus-ALLEGED

Filter Cleared_On_OR_Before_Today

Zﬁtatic Data Filter Window [1300075PZ/CLEARING_Z9/] (User: slee)

Name:ICIeared_On_OR_BeFDre_Tnday Attributes. . Sirnulate
Cu:umment:l Pending [
Gru:-ups:l.ﬁ.N'w" _l
Attribute Criteria Filter Yaluels) |
leared Date TEMOF_RAMNGE Range From -50% ko 0D

Filter CCPStatus-CLEARED

Zﬁtatic Data Filter Window [1300075PZ/CLEARING_Z9/] (User: slee)

Name:lCCPStatus-CLE.ﬁ.RED Atkributes. .. Sirnulal
Cu:umment:l Pending
Grnups:l.ﬁ.N'f _l
Aktribuke Criteria Filker Yaluels)
KEWORD, Status IN Add AMENDED, CLEARED
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Filter CCPStatus-NOT-CLEARED

Zﬁtatic Data Filter Window [1300075P2/CLEARING_29/] (User: slee)

Name:ICCF‘Status-NOT-CLEP.RED attributes, Simulake
Cu:umment:l Pending M
Grn:-ups:l.ﬁ.r'-]"f _I
Aktribike Criteria Filker Yalue(s)
IM Skatic Data Filker MOT_IM Add CCPSkatus-CLEARED

Filter Limit-WhatIfCheckErrorY

Zﬁtatic Data Filter Window [1300075P2/CLEARIMNG_29/] {User: slee)

Name:ILimit-WhatIFCheckErrar'f Atbributes. .. Simulate. ..
Cnmment:l Pending Modi
Gruups:l.ﬁ.NV _l
Aktribiike Criteria Filker Yaluels)
KEYWORD, LIMIT _WHATIF_CHECK _ERROCR. I Add v

Filter Limit-WhatIfCheckErrorN

Zﬁtatic Data Filter Window [1300075P2/CLEARING_29/] (User: slee)

Name:ILimit-'-.-'-.-'hatIfCheckErr:::rN aktributes, Simulate
Cu:-mment:l Pending M
Grn:nups:l.ﬁ.r'-]‘f _I
Akkribute Critetia Filker Waluels) |
IM Static Data Filker MOT_IN Add  ||Limit-WhatIFCheckErrory

Filter Limit-WhatIFCheckPass

Zﬁtatic Data Filter Window [1300075PZ/CLEARING_Z9/] (User: slee)

Name:ILimit-WhatIFCheckPass Attributes... Simulate. .
Cu:umment:l Pending Moc

Grnups:l.ﬁ.N'f _l
Akkribute Criteria Filker Waluels) |

KEY W QRO LIMIT _WHATIF_CHECK _PA3S IN add |
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Filter Limit-WhatIFCheckPassN

Zﬁtatic Data Filter Window [1300075P2/CLEARING_29/] (User: slee)

Name:ILimit-'-.-'-.-'hatIFCheckPassN Attributes. .. Simulate. ..
Cu:-mment:l Pending Modi
Gruups:l.ﬁ.N‘f a0o |
Aktribike Criteria Filker Yaluels)
FEYWORD, LIMIT _WHATIF_CHECK_ERROR MOT_IM add |y
KEYWORD, LIMIT_WHATIF_CHECK_PASS M Add ||

Filter Limit-IsViolated

Zﬁtatic Data Filter Window [1300075P2/CLEARING_29/] (User: slee)

Name:ILimit-Is'-.-'iu:uIated Atbributes. ., Simulate,
Cnmment:l Pending Me
Grn:nups:l.ﬁ.r'-]‘f |
Akkribute Criteria Filter Wahies) |
KEYWORD, LIMIT_IM_WIOLATION IN Add v
Clearing Transfer
Orig Status Action Resulting Status STP Product Type Rules
CANCELED AMEND CANCELED false ClearingTransfer
NONE NEW PENDING false ClearingTransfer
PENDING AUTHORIZE VERIFIED true ClearingTransfer CheckSDI
PENDING CANCEL CANCELED false ClearingTransfer
VERIFIED AMEND VERIFIED false ClearingTransfer
VERIFIED CANCEL CANCELED false ClearingTransfer
Collateral Exposure
Orig Status Action Resulting Status  Use Product Type Rules Create
STP Task
NONE NEW VERIFIED false CollateralExposure false
VERIFIED CANCEL CANCELED false CollateralExposure false
VERIFIED AMEND VERIFIED false CollateralExposure false
Interest Bearing
Orig Status Action Resulting Use Product Type Rules Create Gen Int.
Status STP Task Event
CLEARED AMEND VERIFIED false InterestBearing false true
NONE NEW VERIFIED true InterestBearing false true
VERIFIED AMEND VERIFIED false InterestBearing false true
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Orig Status Action Resulting Use Product Type Rules Create Gen Int.
Status STP Task Event
VERIFIED CANCEL CANCELED false InterestBearing false true
Margin Call
Orig Action Resulting Use Product Rules Create
Status Status STP Type Task
NONE NEW PENDING false MarginCall  UpdateClearingMarginCallKeywords true
PENDING AUTHORIZE VERIFIED true MarginCall CheckSDI true
VERIFIED AMEND VERIFIED false MarginCall true
VERIFIED CANCEL CANCELED false MarginCall true

The rule UpdateClearingMarginCallKeywords allows propagating the fields defined in the domain
“Clearing.MCC.propagateFields”, from the margin call contract additional info to the margin call trades.

If the domain “Clearing.MCC.propagateFields” is empty, the fields CCP, CCP_ORIGIN_CODE, MARGIN_TYPE and
PRODUCT_TYPE are propagated by default.

3.3.4  Calypso Engines

The Import Message engine and Sender engine use “<calypso
home>/client/resources/calypso _uploader config.properties” to connect to the input and output
queues of MQ Series.

You should run these engines after the full clearing member setup is completed (legal entities, message
configuration, etc.).

Version 14.0+

Make sure that the following engines are configured in “<calypso
home>/deploy/EngineStartupConfig.properties”:

engines.startup=TransferEngine,MessageEngine, InventoryEngine, AccountingEngine, Liquidat
ionEngine, PositionEngine, TaskEngine, LifeCycleEngine, UploaderImportMessageEngine, Upload
erSenderEngine

#UploaderImportMessage Engine
UploaderImportMessageEngine.class=com.calypso.tk.engine.UploadImportMessageEngine
UploaderImportMessageEngine.name=UploaderImportMessageEngine
UploaderImportMessageEngine.param.count=1
UploaderImportMessageEngine.param.l=config
UploaderImportMessageEngine.param.value.l=Uploader

# Uploader Sender Engine
UploaderSenderEngine.class=com.calypso.engine.advice.SenderEngine
UploaderSenderEngine.name=Uploader Sender Engine
UploaderSenderEngine.param.count=1
UploaderSenderEngine.param.l=config
UploaderSenderEngine.param.value.l=Uploader

You can then start the Import Message engine and Sender engine as part of the Engine server using "<calypso
home>/startEngineserver.bat" on Windows platforms, or "<calypso home>/startEngineserver.sh" on
*nix platforms.
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Version 14.1+

The Import Message engine and the Sender engine are configured in the Engine Manager of Web Admin: event
subscription and engine parameters.
You may need to add these engines if they are not available for configuration:

e  For the Import Message engine, create a new engine called UploaderImportMessageEngine, with class
name com.calypso.tk.engine.UploadImportMessageEngine

Engine parameter config=Uploader

e For the Sender engine, create a new engine called UploaderSenderEngine, with class name
com.calypso.engine.advice.SenderEngine

The Import Message engine and the Sender engine can be started from the Engine Manager in Web Admin.

Please refer to Calypso Web Admin documentation for complete details.

The Import Message engine is now listening to messages from the MQ input queue.

The Sender engine is now sending messages to the MQ output queue.

If you want to run another Import Message engine with “-config LCH_1" for example, you would need to:

e  Create the following classes:
LCH_1Message.java
LCH_1MessageHandler.java
LCH_1IEAdapter.java
LCH_1IEAdapterConfig.java
Contact Calypso Support for sample classes.

e Create afile LCH lbridge config.properties with the appropriate MQ connection information.

*If* the details in LCHbridgeservice.properties cannot be used for this second queue, you need to
create LCH lbridgeservice.properties.

Then you need to add an entry for the LCH_1 Import Message engine to “<calypso
home>/deploy/EngineStartupConfig.properties” as described above.

Please note that the queue *must* have the LCH (or CME) prefix for this process to work.

3.3.5 Task Station Configuration

You can view EX_GATEWAY exceptions in the Task Station for exceptions related to the integration of
GATEWAYMSG messages.

You can also view GATEWAYMSG messages using <status code>_GATEWAYMSG.

3.4 Exchange Feed Setup

3.4.1 Property Files

The Exchange Feed module requires the configuration of the following property files:

® <calypso home>/client/resources/CMEbridgeservice.properties and <calypso
home>/client/resources/LCHbridgeservice.properties

® <calypso home>/client/resources/ErrorCodeBundleExchangeFeed.properties

® <calypso home>/client/resources/Core.DataServer.serviceconfig.xml
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e <calypso home>/client/resources/CMEbridge config.properties and <calypso
home>/client/resources/LCHbridge config.properties

“CMEbridgeservice.properties” and “LCHbridgeservice.properties”
You need to set the following properties:

e  bridge.counterparty.attribute.identifier - Counterparty attribute that stores the counterparty.
e  bridge.book.attribute.identifier - Book attribute that stores the book.

e BridgeMessageDefaultSender - Default message sender = CME or LCH

e BridgeMessageDefaultReceiver — Default message receiver (clearing member PO)

e <MESSAGE_TYPE>_<PRODUCT>_BRIDGE_XSLT - To override default product specific XSLT invoked
within TransformBridgeMessageRule (optional)

e <MESSAGE_TYPE>_<PRODUCT>_BRIDGE_XSLT_CLASS - To override default product XSLT java class
used for transformation invoked within TransformBridgeMessageRule (optional)

e file.bridge.log.directory -Directory for all original messages for logging purpose.
e  ThreadPoolSize - Number of threads

e ValidatorFiles — Set of XSLT files which are used to validate if the incoming message can be handled by
the engine.

Sample “"CMEbridgeservice.properties”

REQUESTCONSENT SWAP BRIDGE XSLT=

CLEARINGCONFIRMED SWAP BRIDGE XSLT=

REQUESTCONSENT SWAP BRIDGE XSLT CLASS=

CLEARINGCONFIRMED SWAP BRIDGE XSLT CLASS=
bridge.counterparty.attribute.identifier=CME CPTY
bridge.book.attribute.identifier=CME ACCOUNT
file.bridge.log.directory=/mnt/presales/logs/clearing/cme
BridgeMessageDefaultSender=CME

BridgeMessageDefaultReceiver=CGM LLC

ThreadPoolSize=5
ValidatorFiles=exchange feed cme clearing confirmed check fpml5.0.xslt,exchange feed c
me request consent check fpml5.0.xslt,exchange feed cme clearing refused check fpml5.0
.xslt

“ErrorCodeBundleExchangeFeed.properties”
This file is used to define Exchange Feed module specific exception IDs and message content mapping.

Please note that this is an extension of "ErrorCodeBundle.properties”. The system requires both property
files.

This file contains the following information:

#Exchange Feed Msg override datauploader

EF 10014=Channel is not running

EF 10015=Cannot parse file

EF 10016=Cannot read file

EF 10017=Cannot find gateway message with linked ID
EF 10018=Invalid trade id in gateway message

EF 10019=Cannot find trade

EF 10020=Missing values from clearing status

EF 10021=More than 1 trade found for external reference
EF 10022=No Previous BridgeMessage Found

EF 10023=Trade Not Found

EF 10024=Invalid Interest Compounding Method

EF 10025=Invalid Interest Compounding Frequency
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EF 10026=No prefered FX Rate definition found

EF 10027=Trade Source not found in Trade Keyword

EF 10028=Domain value not found

EF 10029=No Trade found with Correlation ID provided
#Error Types

EF 23000=MQ Exception

EF 21002=Miss Data for Transform

#Exchange Feed Error Msg

EF 50001=Invalid FPML Message

EF 50002=Folder Not Exist

EF 50003=ExchangeFeedBridgeEngine is not registered
EF 50004=Missing FeedConfigType in message

EF 50005=Message Handling failure

#Exchange Feed Field
EF 00001=External Reference

“Core.DataServer.serviceconfig.xml”

Add the following lines to register the RMI Server in the Data Server:

<bean id="baseDataUploadServer” class="com.calypso.tk.service.DataUploadServerImpl”>
</bean>
<bean id="rmiBaseDataUploadServer” parent="rmiServiceExporter”>

<property name="service” ref="baseDataUploadServer” />

<meta key="servicelnterface” value="com.calypso.tk.service.RemoteDataUpload” />
</bean>

“CMEbridge_config.properties” and “LCHbridge_config.properties”
These files are required by MQ Series as a channel for incoming and outgoing messages.

The Import Message engine reads the data from the file to establish connection to the MQ to retrieve/send data
from/to the queue.

e jms.modetypeclass - Factory class in the JNDI service provider

e jms.url - JNDI directory where the MQ binding files reside

e jms.queue.connectionFactory — JMS Connection factory name is set under the MQ server setup
e jms.channels - MQ channel to be monitored

e  monitor.frequency - Monitoring intervals

e input.queue.name - JMS Queue name is bound to the MQ queue for incoming messages from

e output.queue.name - JMS Queue name is bound to the MQ queue for outgoing messages

Sample "CMEbridge config.properties”

# JMS properties file

#

Jjms.modetypeclass=com.sun.jndi.fscontext.RefFSContextFactory
jms.url=file:/c:/calypso/software/JNDI-Directory
jms.queue.connectionFactory=CME MATCHING.CF

#indicate that messages will be sent to a JMS WebSphere MQ client
jms.sender.queue.targetClient=MQJMS CLIENT NONJMS MQ
Jjms.receiver.queue.targetClient=MQJMS CLIENT NONJMS MQ
jms.channels=TO.CALYPSO, CME.TO.CALYPSO2

# monitor for the queue channel listed above, in terms of second
monitor.frequency = 60
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input.queue.name=JQUEUE.CME.CALYPSO

JQUEUE.
JQUEUE.
JQUEUE.

output.
JQUEUE.
JQUEUE.
JQUEUE.

CME.CALYPSO.queue.

CME.CALYPSO.queue

queue .name=JQUEUE.
CALYPSO.CME. queue.
.persist=false
CALYPSO.CME. queue.

CALYPSO.CME.gqueue

ackType=auto

.persist=false
CME.CALYPSO.queue.

transacted=false

CALYPSO.CME
ackType=auto

transacted=false

Sample "LCHbridge config.properties”

# JMS properties file

#
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jms.modetypeclass=com.sun.jndi.fscontext.RefFSContextFactory
Jjms.url=file:/c:/calypso/software/JNDI-Directory
jms.queue.connectionFactory=LCH MATCHING.CF

monitor.frequency = 60

input.queue.name=JQUEUE.LCH.CALYPSO

JQUEUE.
JQUEUE.
JQUEUE.

output.
JQUEUE.
JQUEUE.
JQUEUE.

3.4.2

LCH.CALYPSO.queue.

LCH.CALYPSO.queue

queue.name=JQUEUE.
CALYPSO.LCH.qgueue.
.persist=false
CALYPSO.LCH.qgueue.

CALYPSO.LCH.qgqueue

Version 14.0+

ackType=auto

.persist=false
LCH.CALYPSO.queue.

transacted=false

CALYPSO.LCH
ackType=auto

transacted=false

Exchange Feed Bridge Engine Registration

Add ExchangeFeedBridgeEngine to the Engine configuration using Configuration > System > Engine Config
from the Calypso Navigator.

Configure ExchangeFeedBridgeEngine to subscribe to PSEventMessage using Configuration > System > Event
from the Calypso Navigator.

Add the event filter BridgeMessageEventFilter to ExchangeFeedBridgeEngine.

This event filter takes the selection criteria from the static data filter "BridgeMessageEventFilter”. It should be
defined as:

Zﬁtatic Data Filter Window [1400225P2/CLEARING_ETD/calypso_user]

Name:IBridgeMessageEventFilter

Cl:umment:ISD filker for BridgelmportMessageEngine

Gru:-ups:l'-.-'-.-'F_Message

Attribukes, . Simula

Pending

o

Message Type

Version 14.1+

Attribuke Criteria Filter Waluels)
Message Ackion M Add AMEMD,MEW, REDC, REPROCESS, TRAMNSFORM, MATCH
Message Skatus M Add TRAMNSFORMED, COMPLETELD

ola
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The ExchangeFeedBridge engine is configured in the Engine Manager of Web Admin: event subscription and engine
parameters.

You may need to add this engine if it is not available for configuration: Create a new engine called
ExchangeFeedBridgeEngine, with class nhame com.calypso.tk.engine.ExchangeFeedBridgeEngine.

3.4.3 Incoming Messages Setup

The Exchange Feed processes CONSENT messages and BRIDGEMSG messages. It transforms BRIDGEMSG
messages into Calypso Upload Document objects through the TransformBridge rule. The Exchange Feed Bridge
engine generates the GATEWAYMSG messages that trigger the Data Uploader to create trades in Calypso based on
the Calypso Upload Document objects.

BRIDGEMSG Message Workflow

This workflow can be imported using the file “<calypso
home>/client/resources/workflow/BRIDGEMSG.wL".

If you are clearing with LCH, this workflow should be imported using the file “<calypso
home>/client/resources/BRIDGEMSG FOR CVR.wf"” instead. It adds the transition highlighted below for
managing incoming collateralAllocation messages.

Orig Status Action Resulting STP Rules Comments
Status

COMPLETED REDO PENDING false RedoBridge

COMPLETED AMEND COMPLETED false

NONE NEW PENDING false

PENDING TRANSFORM  TRANSFORMED true TransformBridge Swap_BRIDGE_XSLT=

SWAP_DEFAULT.xslt

PENDING LOAD COMPLETED false  TransformBridge Swap_BRIDGE_XSLT=
SWAP_DEFAULT.xslt

PENDING CANCEL CANCELED false

PENDING MATCH COMPLETED true  MatchCollateralAllocationResponse
Filter: isLCHCVRMessage

TRANSFORMED  REDO PENDING false RedoBridge

TRANSFORMED  LOAD COMPLETED false MergeTradeld

TRANSFORMED  CANCEL CANCELED false

Static data filter “isLCHCVRMessage”:
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| £ Static Data Filter Window [1400225P2/LAPTOP_REL14/calypso_user] El_l

Mame; isLCHCYWRMessage [ Akkributes, ., ] [ Simulate

Comment: | Accepts LOCHCYR messages only Pending M
Groups: | AMNY E]

Aktribike Criteria Filker Waluels)
MSG_ATTRIBUTE. Connectar |~ N | lLoHCvR |

CONSENT Message Workflow

This workflow can be imported using the file "<calypso home>/client/resources/workflow/CONSENT.wE".

Orig Status Action Resulting Status STP Message Type Rules
NONE NEW PENDING false CONSENT
PENDING AUTHORIZE TO_BE_SENT true CONSENT CheckContact
TO_BE_SENT SEND SENT true CONSENT

3.4.4  Task Station Configuration

You can view EX_BRIDGE exceptions in the Task Station for exceptions related to the integration of BRIDGE
messages.

You can also view BRIDGEMSG messages using <status code>_BRIDGEMSG.

3.4.5 Data Mapping

Add the Calypso Mapping Window to the Calypso menu (menu action mapping.CalypsoMappingWindow), SO
that you can define mapping values between the CCPs and Calypso.

Mapping values are provided out-of-the-box, and need to be reviewed / validated for the interface names “CME”,
“ExchangeFeed.CME", “ExchangeFeed.LCH"”, and “LCH".

ZEalypsu Mapping YWindow

_:I Interface Mappings :
SREEHnterfaceName .
.. ] CME Marne:  [CME

-- = ExchangeFeed.CME
] ExchangeFeed.LCH
- _JLcH Calypso VYalue:
-] MW

Interface Yalue:

Reverse Defaulk: [

To audit changes to the Data Mapping, add CalypsoMapping to the domain “classAuditMode”.
Important Note:

Make sure that the overnight reference indices defined in Calypso (EONIA, FEDFUNDS, etc.) have the reference
index attribute IndexCalculator = OISNew.
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Trade Keywords

42

A set of trade keywords allow standardizing the Clearing solution.

It is possible to map a keyword name/value to another one by setting the mapping through the Calypso Mapping

Window.

_1 Interface Mappings
=] InterfaceName
- CME
=[] ExchangeFeed.CME

-] DiscountMethod
4% FXResetSource
-[Z] FeeType
- Holidays

-] KeywordName

i 4#* Cleared Date

Clearing Keywords

-] DateRolIConvention
-] DayCountConvention

- ECCP Account Reference

-] 4
b

Mame:  |ExchangeFeed. CME[Keywordhame

Inketface Yalue:  |CCP Account Reference

CCPAccountReference

Calypso Walue:

Reverse Defaul: [

(] InterestCompoundingFrequency << Add |
- InterestCompoundingMethod

»= Remove |

Confiqure Interfaces

Trade Keywords

Description

CCP Clearing house: CME, LCH, etc.

Short name of the clearing house legal entity.

CCPAccountReference Clearing house account name - SDI selection is based on this trade
keyword, which value must match the “ExternalName” of the Calypso
client/house account.

CCPBlockTradelD Block trade ID.

CCPClearedDate Date that the trade is processed by the clearing house.

CCPCollateralPolicy

Collateral Policy that overrides the collateral policy of the Margin Call
Agreement associated with the trade.

Collateral policies are defined in the domain "CollateralPolicy". They are
used to select discount curves through the Pricer Configuration
provided the pricing parameter COLLATERALIZED_PRICING is set to
On.

CCPFirmReference

Clearing Member Firm identifier.

CCPMessageTimestamp

Message timestamp.

CCPOriginCode

Set to either HOUSE or CLIENT to reflect house activity or client
activity.

CCPTradeID

Trade ID assigned by the clearing house. It is also set on the trade’s
External Reference.

ClearingConfirmedCorrelationID

LCH trade confirmation number.
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Trade Keywords

Description

ClearingConfirmedIncomingMessagelD

LCH message confirmation nhumber.

ClearingConfirmedSentBy

LCH confirmation sender reference.

ClearingConfirmedSentTo

LCH confirmation receiver reference.

client_trade_id

Trade ID provided by the client.

CMFAccountReference Set by the system when a trade is created: ID of the Calypso clearing
account.
IS_CLIENT Set to “false” for HOUSE trades and clearing member mirror trades.

Set to true for client mirror trades.

LIMIT_WHATIF_CHECK_PASS

Y if the limits check passed, or N otherwise.

LIMIT_WHATIF_LIMIT_MAX

Limit amount.

LIMIT_WHATIF_PORTFOLIO

ERS Limits portfolio.

LIMIT_WHATIF_RISK_USAGE

Trade amount contributing to the limit check.

PlatformTradelD Trade ID assigned by the platform where the trade is captured
(Markitwire for example).

Status Trade status at the clearing house.

TradeSource Platform where the trade is captured (Markitwire for example).

USUPrefix Unique swap identifier - CFTC namespace.

USIValue Unique swap identifier — trade ID.

Mirror Keywords

The following trade keywords need to be propagated on the mirror trades.

They need to be added to the domain “MirrorKeywords”: CCP, CCPAccountReference, CCPClearedDate,
CCPOriginCode, CCPSettlementType, CCPTradelD, LIMIT_WHATIF_CHECK_ERROR,
LIMIT_WHATIF_CHECK_ERROR_MSG, LIMIT_WHATIF_CHECK_PASS, LIMIT_WHATIF_LIMIT_MAX,

LIMIT_WHATIF_PORTFOLIO, LIMIT_WHATIF_RISK_USAGE, PlatformTradelD, RelatedProductType, Status,

USIPrefix, USIValue.

Examples:

o Raac

- 42 CCPClearedDate

- 2 CCPOriginCode

- A2 CCPSettement Tvpe
-4 CCPTradelD

- 42 RelatedProductType
- 2 LISTPrefix

-2 USIValue

- 42 CCPAccountReference
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Trade Templates
Trade templates are required to populate missing information from the incoming messages.
You can create trade templates from the Trade windows using “Save As Template” from the product specific menu.
In the Calypso Mapping Window, you can set the trade template for a given product type.
Select the InterfaceName “ExchangeFeed.CME” and add a TradeTemplate:
e Interface Value = product type (Example “InterestRateSwap”)

e Calypso Value = trade template (Example “"USD3L1")

mame:  |ExchangeFeed,CME[TradeTemplate

Interface Yalue:  |InkterestRateSwap

Calypso Yalue:  |USD3LL

Repeat for more product types as needed, and for the InterfaceName “ExchangeFeed.LCH"” as needed.

Mame:  [ExchangeFeed,LCH|TradeTemplate

Interface Yalue:  [InterestRateSwap

Calypso Yalue:  |USD3LL

3.5 Clearing Member Setup

The following files are available under ““<calypso home>/client/resources/config/":
® clearingconnection.properties.sample
® clearing.properties.sample
(] clearing.reportPaths.properties.sample
® CustomClearingReports.xml.sample

® clearingServiceCodes.properties.sample

These files are optional — They are used to override out-of-the-box properties, see below for usage.

“clearingconnection.properties”

Rename “clearingconnection.properties.sample” to “clearingconnection.properties”, and modify
as needed.

This file contains connection information to the CCP.

Key format is

<CCP short name>.<Firm ID (PO LE attribute)>.<key>

URI format must include protocol, host and port (where applicable)
For public key SFTP authentication, keyPassphrase is optional. Key

path can be an absolute filesystem path, or a resource path within
the classpath. Filesystem paths take precedence

H = S S S

CME.40Q0.URI=sftp://sftpng.cmegroup.com:22
CME. 40Q0.user=<user>
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CME. 400 .password=<password>

LCH.CCl.URI=sftp://195.246.228.9:6020
LCH.CC1l.user=<user>
LCH.CCl.key=<path to CCl key>

LCH.CC2.URI=sftp://195.246.228.9:6020
LCH.CC2.user=<user>

LCH.CC2.key=<path to CC2 key>
LCH.CC2.keyPassphrase=<CC2 key passphrase>

Firm Id

They are stored in the attributes of the clearing member processing org: “<CCP><Clearing Service>FirmId”, for
example “"CMEIRDFirmId”.

If no such legal entity attribute is found, the system will look for the legal entity attribute *<CCP>FirmId”, for
example “"CMEFirmId”.

In this example, the CMEFirmld is "4Q0” - This is a test environment for Calypso - You need to replace it with your
own firm ID.

In this example, the LCHFirmId for LCH US is CC1, and the LCHFirmId for LCH UK is CC2 - There are test
environments for Calypso — You need to replace them with your own environments.

URI
Then set the values for the parameters URI.

In this example, “sftp://sftpng.cmegroup.com:22” is a test environment for Calypso - You need to replace it with
your own environment.

The following types of URI are currently supported: HTTP/S, SFTP, FTPS, FTP and local file system.
Examples of local file system:

CME.4Q0.URI=file://C:/CLEARING/Data/CME
LCH.CCl.URI=file://C://CLEARING//Data//LCH

User / Password or User / Key
Then set the values for the parameters user/password, or user/key/keyPassphrase.

If you set both user/password, and user/key/keyPassphrase for a given URI, user/key/keyPassphrase will be used
for authentication.

keyPassphrase is optional — It is only needed if the key is protected.

“clearing.properties”
This file is used to override default properties as needed.

If you want to override the default properties, rename “clearing. properties.sample” to“clearing.
properties”.

clearing.import.folder

The default import folder is "<user home>\Calypso\clearing\” on the server where the Scheduler engine is
running, and for the user running the Scheduler engine.

If you want to override the default import folder, rename “clearing.properties.sample” to
“clearing.properties” and set the import folder “clearing.import.folder”.

#
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# Clearing configuration properties

#

# Import data base folder. If not defined, it will

# default to $calypso user home/clearing, were Scalypso user home
# is the running user's Calypso home (-userhome arg)

#

#clearing.import.folder=/home/clearing/Calypso/clearing
clearing.import.folder=X:\\shared\\Calypso\\clearing

clearing.custom.packages

You can set custom packages as needed using the property clearing.custom.packages.
Example:

clearing.custom.packages=pkgl, pkg2, ...,pkgN

where pkgN is the custom packages to add, for example:
clearing.custom.packages=com.customer.packagel, com.customer.package?2

If the property clearing.custom.packages does not contain the package “com.calypso.clearing”, it will be
added at the end of the list.

If the property clearing.custom.packages contains the package “com.calypso.clearing”, its order in the list
will be respected.

clearing.import.IchFirmIdPathSuffix

By default, when clearing members access their LCH environment, the "LCH<Clearing Service>FirmId” is used to
identify the path to the CCP files. If such attribute is not present, it is the attribute “"LCHFirmId”.

If the clearing members want to access their test environment at LCH instead, the path to the CCP files is identified
by the "LCH<Clearing Service>FirmId” / "LCHFirmID” with the suffix “(mbr)”.

This property allows setting the suffix to access the test environment.
Example:

clearing.import.lchFirmIdPathSuffix= (mbr)

clearing.import.Ich.swapClearFolderSuffix

By default, the CCP files are stored in the SwapClear folder but LCH could setup another folder for testing
purposes.

The other folder can be accessed using the folder suffix defined in this property.
The folder will become “Swap Clear <folder suffix>".
Example:

clearing.import.lch.swapClearFolderSuffix=\ Member Test Refresh

The folder /<mnemonic>/SwapClear/ will be transformed to /<mnemonic>/SwapClear Member Test
Refresh/.

clearing.import.cme.UATNRSuffix
If defined, the value of this property will be added in front of all CSV and XML file extensions.
Example:

clearing.import.cme.UATNRSuffix=.nr

© 2018 | Calypso Confidential - Copyright © Calypso Technology, Inc. All Rights Reserved



47 Clearing Member Setup Guide

The suffix will be added as follows: "/cme/ftp/PUB/IRS/IRSDFR_LIBORIM ${date}.nr.csv”.

“clearing.reportPaths.properties”

This file is used to override report paths. It contains the default report paths for reference. You can override as
needed.

If you want to override the default report paths, rename “clearing.reportPaths.properties.sample” to
“clearing.reportPaths.properties”.

#

# Report paths overrides

#

# Paths defined in this properties file will override those loaded from the
# OOTB configuration and CustomClearingReports.xml. Only paths can be

# overridden here, no other report attribute will be modified. Refer to
# Clearing documentation for more information.

#

# The following syntaxes are accepted

#

# <reportBeanName>=<new report path>

# <CCP>.<reportName>=<new report path>

#

# where

#

# reportBeanName : report bean name, with bean as in Spring bean. See
# CustomClearingReports.xml for more info

#

Example:

CME .CMEPAAQuote = /cme/ftp/PUB/IRS/cme.paa.rate.{date}.csv

The following placeholders are supported:

e ${date}: Valuation date. Formatting depends on CCP.

e ${firmId}: Firm ID, as defined in the legal entity attributes “<CCP><Clearing Service>FirmId” or
"< CCP>FirmId” if not present.

e  ${IchDynamicDateFolder}: Only for LCH. It is based on the value of the legal entity attribute
“LCHRemoteFolderStructure”:

o Ifitis set to “Dynamic”, then ${IlchDynamicDateFolder} is the formatted valuation date, plus a final
forward slash (/). Only for LCH and for Dynamic folders, as defined in the legal entity attribute
“LCHRemoteFolderStructure”.

o Ifitis set to “Static” then ${IchDynamicDateFolder} is an empty string.

You can also use this file to handle individual Zip files: You need to override the report path by adding one of the
following suffixes:

e zZip
° gz
Example:

LCH.HistoricIndexRates = /Public (mbr)/SwapClear/Trade/${date} REP00003 - Historic
Index Rates 1.TXT.zip
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Additional capability — The following syntax is also supported:

S{key=value?expandedValue}

For example:

${firmId=CC2?.zip}

meaning:
e If firmId is CC2, then the “.zip” suffix is added.
e If not, nothing is added.

Example:

LCH.CashSettlementReport =
/${firmId}/SwapClear/${lchDynamicDateFolder}S${date} REP000l6c - OTC Portfolio Cash
Settlement (Client) 1.TXTS${firmId=CC2?.zip}

“CustomClearingReports.xml”
This file is used to override default reports and market data.

If you want to override the default reports and market data, rename “"CustomClearingReports.xml.sample”
to "CustomClearingReports.xml”.

[NOTE: The report configuration is done using Spring]

Adding a new report: For example, we need to add a new CME DFR curve, IRSDFRCurve_AONIA. The way to do
it is to add the following XML to the file "CustomClearingReports.xml”:

<bean id="IRSDFRCurve AONIA"
class="com.calypso.tk.clearing.external.report.CMEReport">
<property name="name" value="IRSDFRCurve AONIA" />
<property name="CCP" value="CME" />
<property name="displayName" value="IRS DFR Curve - AONIA" />
<property name="type" value="MARKET DATA" />
<property name="path" value="/cme/ftp/PUB/IRS/IRSDFR AONIA ${date}.nr.csv" />
<property name="XSLResourcePath" value="stylesheet/cme/CME DFR.xslt" />
<property name="defaultFormat" value="CSV" />
<property name="attributes">
<map>
<entry key="marketDataType">
<util:constant static-
field="com.calypso.tk.clearing.external.report.MarketDataType.CURVES" />
</entry>
</map>
</property>
<property name="plugins">
<list>
<ref bean="cmeCurveProcessorPlugin" />
</list>
</property>
</bean>

Description of each property:

e name (mandatory) : Name of the report. Along with the CCP, it fully identifies a report.
e CCP (mandatory).
o displayName (optional) : Will default to the name.

e type (mandatory) : We currently support 2 types of reports:
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e  EOD _REPORT : reports used in BO processing (e.g.: margin)

e MARKET_DATA

e path (mandatory) : Remote path of the report. Note the ${date} placeholder: some variables can be
used, always enclosed in ${}

e date : valuation date

e firmId : e.g. 4Q0 or CC1 in our case. Taken from the PO LE attributes “"<CCP><Clearing Service>FirmId”
or “<CCP>FirmId” if not present

e XSLResourcePath (mandatory): CLASSPATH path of the XSLT style sheet to process the report

e defaultFormat (optional) : Raw report format. 3 types currently supported
. XML

e CSV (Comma Separated Values) (e.g.: used in CME)

e TSV (Tab Separated Values) (e.g.: used in LCH)

e attributes (optional)

« marketDataType: within market data type we support several subtypes. The marketDataType is
important, because, OOB, the report groups that used to be defined in the clearingmarketdata.properties
files are now dynamically built by grouping reports that have the same marketDataType. E.g.: all reports
with marketDataType=com.calypso.tk.clearing.external.report.MarketDataType.CURVES will form the
OOB group "Curves". The supported types are

com.calypso.tk.clearing.external.report.MarketDataType.CURVES ("Curves" group)
com.calypso.tk.clearing.external.report.MarketDataType.QUOTES ("Quotes" group)
com.calypso.tk.clearing.external.report.MarketDataType.RATE_RESET ("Rate Resets" group)
com.calypso.tk.clearing.external.report.MarketDataType.HOLIDAYS ("Holidays" group)

e plugins (optional)

For the specific case of CME DFR curves, there is an easier way to add a new one: this would be an equivalent
definition:

<bean name="IRSDFRCurve AONIA" parent="parentDFRCMEReport">
<property name="path" value="/cme/ftp/PUB/IRS/IRSDFR AONIA ${date}.nr.csv" />
</bean>

Note the parent=parentDFRCMEReport : that will complete the rest of the configuration.

Modifying the OOB market data groups: For example, you do not want to download all the OOB curves, but
only 2 of them: IRSDFRCurve_AONIA and IRSDFRCurve_TONAR. You can add the following XML to

“"CustomClearingReports.xml”:

<bean name="curvesGroupBean"
class="com.calypso.tk.clearing.external.report.ReportInfoGroup">
<property name="name" value="Curves" />
<property name="reportNames'">
<set>
<value>IRSDFRCurve AONIA</value>
<value>IRSDFRCurve TONAR</value>
</set>
</property>
</bean>

The property name=Curves will make the OOB Curves group to be ignored, and the new one will contain only those
2 reports. Needless to say, the report names must point to existing report: if you add names of unknown reports,
they will be ignored.

“clearingServiceCodes.properties”

This file is used to override default service codes. Service codes are used in the scheduled task
CLEARING_EXPORT_CVR_WORKSHEET to determine the file name.
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#
#
#
#
#
#
#
#
#
#
#
#

#

#CME . IRD=01
#CME . NDF=02
#LCH.IRD=03

Clearing Service Codes
Arbitrary codes that identify Clearing Services.
would identify a product,

margined together,

Current supported syntax is

Uncomment and redefine, if needed

3.6 Collateral Setup

or family of products

< CCP short name>.<Product type>=<Service Code>

Initially,

50

a clearing service
(product type) that are usually
although in the future this definition could change

3.6.1 Collateral Workflow

The Collateral workflow provided out-of-the box by the Collateral module must be modified as follows.

All the transitions from NONE to EXECUTED should be STP.

Orig Status Action Resulting Status Use STP Rules
ALLOCATED VALIDATE VALIDATED true

EXECUTED AMEND EXECUTED false

EXECUTED SUBSTITUTE EXECUTED false Execute
EXPOSURE_AGREED ALLOCATE ALLOCATED true

NONE NEW PRICING true

PRICED_NO_CALL AGREE_EXPOSURE EXPOSURE_AGREED false

PRICED_PAY AGREE_EXPOSURE EXPOSURE_AGREED true AutoAdjust
PRICED_RECEIVE AGREE_EXPOSURE EXPOSURE_AGREED true AutoAdjust
PRICING PRICE PRICED_NO_CALL true CheckNocCall
PRICING PRICE PRICED_PAY true CheckPay
PRICING PRICE PRICED_RECEIVE true CheckReceive
VALIDATED EXECUTE EXECUTED true Execute

3.6.2  Buffer Functionality

The multi-buffer functionality is only enabled if the domain “Collateral.Multiplier” contains the value “Buffer”.
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3.7 ERS Limits Setup

Please refer to the Calypso ERS Limits Installation Guide for details.

3.8 All Property Files and Resource Files

All resource files and property files need to be copied to <calypso home>/ tools/calypso-
templates/resources.

You will then need to deploy the files to your applications servers]

Please refer to the Calypso Installation Guide for details on deploying resource files.
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Section 4. Legal Entities and Accounts Setup

Notes

Legal entities must be defined to identify the clearing house, the clearing member (processing org),
and the clients. They should all have at least one contact.

When defining legal entities, accounts, and books, a number of attributes will be set as well. Please
remember that attributes and their values are case sensitive.

4.1 Defining Books

The book in Calypso is used to store trades.

When trades are imported into the system, and trades are created as a result of the EOD processes, the books are
set according to the following logic. This applies to cleared trades, clearing transfer trades, margin call trades and
collateral exposure trades.

You have two options to define books:

e Option 1 - Define books at the clearing account level (CCP facing trades and client / house facing trades
are in the same book for a given clearing account)

e Option 2 - Define books at the legal entity level (CCP facing trades and client / house facing trades are in
different books for a given clearing account)

Option 1 has priority over Option 2 if both options are configured. In other words, books defined at the legal entity
level will be ignored if a book is defined at the clearing account level.

[NOTE: If you choose Option 1, it has to apply to ALL clearing accounts. If you choose Option 2, it has to apply to
ALL legal entities — It is not recommended to have a mix of both options]

4.1.1 Option 1 — A Book per Clearing Account

You define a book at the clearing account level.

This book contains for a given clearing account, the CCP facing trades and the client / house facing trades. So
basically, this book always has a flat position.
Sample Clearing Account Book

The clearing account book is set on the account attributes of BOTH the CCP Facing Clearing Account and the
Client Facing Clearing Account.

[NOTE: This is the same setup, whether the clearing account is a client clearing account or a house clearing account]

. Account Attributes Window CLIENTA-CME (68703)

Mame Value -
AccountType Client
IlC Earing Book m
CCPOriginCode CLIEMNT
LCHACcountMame <For LCH only - Account reference for EQD files >

From the Calypso Navigator, navigate to Configuration > Books & Bundles > Trading Book to define books.
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z Book Window - Version -0 [1300075P2 /LAPTOP_RELEASE/ca 0 = II:||

View Help
Book Id [53694 Attributes |
Name ICLIENTA @CGM Name Value -
PricingEnv * FROMDE
Activity ICLEAF‘.ING BookType
AccAdjustmentDays
Accounting Link ITF‘.ADING = Acaterue
AccReversalRule
Legal Enti ICGM LLC J
= ty BookBundle
LomﬁonlUS;"Pan:iﬁc j CAMoneyDiff Book -
CMF_ID -
End Of Day| 23 Hour I 59 Min @ ... |CTCCDmDDunding *
CTC Consolidator -
Base Cey |USD ¥ | |[cTC Offset

It is not requires to set any book attribute.

4.1.2 Option 2 — A Book per Legal Entity

For the clearing member, you need to have a book to store the trades related to the house activity, and a book to
store the trades related to the client activity. When trades are imported, the book will be assigned in the following
order of priority:

e The book set at the Clearing House level, if any.

NOTE: You can only set the book at the CCP level if you have defined only one clearing member in your
system.

e The book set at the clearing member level, if any.
e The book set in the User Defaults.

For the clients, you can have a book per client, or a book across multiple clients. This choice should mostly be
driven by P&L reporting requirements, since the P&L is computed at the book level. When trades are imported, the
book will be assigned in the following order of priority:

e The book set at the client level, if any.

e The book set in the User Defaults.

Sample Clearing Member Books

The clearing member books are set on the clearing house OR the clearing member attributes.

Id Processing Org Legal Enity Role Attribute Twpe — Attribute Yalue
1110]aLL M LLC ALl Minimum Cther Requirement -200
1109ALL Ziah LLiC aLL Minirnurn CFTC Requirement 000004,z
1602 | ALL Ziah LLiC aLL LZHFirmId ZiZ1
1107 |ALL Ziah LLiC aLL House Clearing Book ZigM-HOUSE
1105 ALL Ziah LLiC aLL Client Clearing Book, ZigM-CLIEMT
1106 |ALL Ziah LLiC aLL ]
1601 |ALL Ziah LLiC aLL CMEFirmId 43

Clearing Member House Clearing Book
The clearing member House Clearing book holds trades for the clearing member’s house trades.

From the Calypso Navigator, navigate to Configuration > Books & Bundles > Trading Book to define books.
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- Book Window - ¥ersion -2 [1300035P1 /cft-staging-130003sp1 /calyps

=10/ x|
Wiew  Help
Book Id [1125 Attributes _I
Name [CGM-HOLISE Name value
ookTyvpe + House
Ackivity ICLEF'-RING Fricing Eree FROMDE
Accounting Link. IOTC j
Leaal Entity ICGM LLC J
Location IP.merica,l'Daws-:un_Creek j
End Of Day | 24 Hour I_n Min _||
Base Coy ILISD j
Holidarys INVC J
Cn:nmmentl

Set the following book attributes:

OPTIONAL - BookType = House (optional attribute to identify House activity in filters)

Clearing Member Client Clearing Book

The clearing member Client Clearing book holds the mirror trades of the clearing member’s clients at the clearing
house.

From the Calypso Navigator, navigate to Configuration > Books & Bundles > Trading Book to define books.

P Book wWindow - Yersion -2 [1300035P1 /cft-staging-130003sp1 /calyps

=100 x|
Wiew  Help
Book 1.;||1125 Attributes .. |
Narme ICGM-CLIENT Name Value
ookTyvpe - Clignt |
Ackivity ICLE-':'-RING Pricing Erv FROMDE
Accounting Link, IOTC j
Legal Entity ICGM LLC J
Location I.ﬁ.merica,l'Dawsnn_Creek j
End OF Day | 24 Hour I 0 Min "
Base Coy ILISD j
Halidarys ||W-: J

Comment I

Set the following book attributes:
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e OPTIONAL - BookType = Client (optional attribute to identify House activity in filters)

Sample Client Book

A book should be defined for client trades at the clearing member. It can be a dedicated book, or a book shared
across multiple clients.

Id Processing Crg Leqal Entity Fole Aktribuke Type Akkribute Value
63697 [CiEM LLC |CLIEMTA aLL |[Clearing Baok [CLIENTA@CGM LLC
B3695|CEM LLC |CLIENTA AL |ClearingRepartingCurrency  |USD

From the Calypso Navigator, navigate to Configuration > Books & Bundles > Trading Book to define books.

_A Book Window - Version -0 [1400205P2/LAPTOP_REL14/calypso_user] & ‘. o=

Wiewe  Help
Book Id | 63700 attributes E
Marne | CLIEMTA@CGM LLC Marme Yalue
Activity | Cleari AccadiustmentDays
cHvity [-earind acchateRule -
Accounting Link | MONE L | [pecReversalRule h
L ! BookBundle
Legal Entity | CM LLC B CAMoneyDiff Book
- ~CMF_ID
Location | AmericalLos_Angeles » | |CTC Compounding -
: _|CTC Consalidator -
End Of Day 23 | Hour 59 | Min v |[CTC OFF=et -
r 1 ICTC Role -
Base Cey |LSD ~ | |cusTomER 1D
Holidays [MYC B iZan Take P.Ds.itinns -
i“herkER 5L imnik

It is not required to set any book attribute.

Sample Internal Counterparty Book

From the Calypso Navigator, navigate to Configuration > Books & Bundles > Trading Book to define books.

ZBuuk Window - ¥ersion -1 [1300035P1 /cft-staging-130003spl - |I:I|5|
Yiews Help
Book Id |1 127 Attributes ... |
Narme ICTI@CGM Marne Value
BookTyvpe + House
Bickivity: IHn:nuse Clearing Book, Pricing Ere FROMDE

Accounting Link, IOTC

=l
Legal Entity ICGM LLE J
-l

Location I.ﬁ.merica,l'r'-]ew_\“nrk

End OF Dav | 24 Hour I 0 Min . ||

Base Cry ILISD j
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It is not required to set any book attribute.

e OPTIONAL - BookType = House (optional attribute to identify House activity in filters)

e  Pricing Env = <Pricing environment name>

4.2 Defining the Clearing Houses (CCPs)

A clearing house only requires the definition of a legal entity and its contact information.
From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities.
Each clearing house must be defined with at least the following roles: “"CCP, “Agent” and “CounterParty”.

[NOTE: The Client role is also required if you plan to define Variation Margin contracts for CCP facing contracts —
Optional — See Clearing Member Contracts — CCP Facing Contracts for details]

Trade Classification

You can set the legal entity attribute VMClassification to CTM (Collateralized-To-Market) or STM (Settled-To-
Market). The trade keyword VMClassification will default to that value when importing EOD files to generate
Clearing Transfer trades. If it is not set, the value will be retrieved from the import files, and if there is no value in
the import files, it will default to STM.

Recommended setup per CCP:
e CME: VMClassification legal entity attribute = STM
e LCH: VMClassification legal entity attribute = Not set (it will be retrieved from report 91).
e  For the other CCPs, do not set the VMClassification legal entity attribute - It will default to STM.

You can setup an MCC contract for each trade classification using the attribute VM_CLASSIFICATION, set to CTM or
STM.

This applies to both Client and CCP facing Clearing Transfer trades.

CME
A Legal Entity- Version - 7 [14JUHEDSP2.-’LAPTDP_REL14fcalypso_um
Utilities  Help
Short Mame |ZME Skatus :Enal:uled -
Full Mame |Chicago Mercantile Exchange Role(s) [Agent
Parert E] EzinterF'arty
Country :LINITED STATES '[I]
Inactive As From User |calypso_user
Entered Dake |10/17/2005 3138:08 PM E]
External Fef Disabled Rolels)
@ Financial
Holdays [NvC E] () Mon Financial

Click Contact to define at least one contact.

Click Attributes to set the following legal entity attributes:
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Id Processing Crg Legal Entity Role Aktribute Tvpe Attribute Yalue
1002[ALL ZME ALL CME_CPTY ZME
1003[ALL ZME ALL lient Clearing Book, ZGM-CME-CLIENT
1004 |ALL ZME ALL House Clearing Book ZGM-CME-HOUSE
1005 |ALL0 _ME ALl SwapswireP articipant ACMELSGFR R
e OPTIONAL - “Client Clearing Book” = <Book name for the Clearing Member’s client trades>

See Defining Books for details — The book can be defined at the Clearing Member or Clearing Account

level instead.
e OPTIONAL - “House Clearing Book” = <Book name for the Clearing Member’s house trades>

See Defining Books for details — The book can be defined at the Clearing Member or Clearing Account

level instead.
e "CME_CPTY"” = CME

LCH
—
A Legal Entity- Version - 0 [l-ﬂﬂﬂﬁﬂﬂpmpmp_ﬁﬂldfcalypm_ E=nnc
Utilities  Help
Short Mame |LCH Status |Enabled -
Full Mame |London Clearing House Agent
CounterParty
Parent E] P
Country | UNITED STATES T'E]
Inactive As From User |calypso_user
Entered Date |12/18/2013 5:135:59 PM E]
Disabled Rolels)
External Ref
@ Financial
Holidays i
E] (7 Mon Financial

Click Contact to define at least one contact.

Click Attributes to set the following legal entity attributes:

Id Processing Crg Leqal Enkity Fole Attribuke Type Aktribuke Yalue
1007 |aLL LZH ALl SwapswireParticipant CALYPSORES
1010]aLL LZH ALl LCH_CPTY LZH
10035 | ALL LCH aLL House Clearing Book (ZGEM-HOUSE
1009]aLL LZH ALl Client Clearing Boak, CGM-CLIENT

OPTIONAL - “Client Clearing Book” = <Book name for the Clearing Member’s client trades>

See Defining Books for details — The book can be defined at the Clearing Member or Clearing Account

level instead.

OPTIONAL - “House Clearing Book” = <Book name for the Clearing Member’s house trades>

See Defining Books for details — The book can be defined at the Clearing Member or Clearing Account

level instead.
“LCH_CPTY” = LCH

EUREX
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P Legal Entity- ¥ersion - 5 [143005,/CLEARING_310/calypso_user]

LItilities  Help

Shiort MNarme IELIREX

Skatus IEnaI:uIeu:I

Raolels) [fgent

Full Marme IEurex

_CP
Fela: I _l Clearer
Country IGERMANH’ =] . | CaunterParty
MarketPlace
Inactive As Fram I Lser Ical';.fpsn_user
Entered Date [10/03/2006 [12:17:12 am I~ Triparty
External R.ef I
{* Financial
Holidarys IXELIR |
" Mon Financial
Id Processing Org Leqal Entiky Role Attribuke Type Akkribuke Yalue
271696 (ALL ELIREX ALL learingHouse ELIREX
2876038 [ALL ELIREX ALL EurexParticipankt AMOMNYMOLS

ICE CLEAR EUROPE

P Legal Entity- ¥ersion - 1 [143005/CLEARING_310, calypso_user]

Ltlities  Help

Shiort Marne IICE CLE&R EURCPE

Skakus IEnaI:nIed

Role(s) [Aagent

Full Marme IICE CLE&AR EURCOPE

Parent I

Country |LNITED KINGDOM =2 | CounterParty
Inactive A5 From I Iser Imax
Entered Date [09/05/2013 [6:42:55 am [~ Triparty
External Ref I
e ILON + Financial
alidays |
" Mon Financial

Id Processing Crg Leqal Enkiky Role Atkribuke Type Aktribuke Yalue
145695 |ALL ICE CLEAR. ELIROPE aLL Client Clearing ook, CALYPLE-C
145699 |ALL ICE CLEAR. ELIROPE aLL House Clearing Book, CALYPLE-H
145700ALL ICE CLEAR. ELIROPE aLL ICELinkParticipant iceclear

Books are optional.

ICE CLEAR CREDIT
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P Legal Entity- ¥ersion - 1 [143005,/CLEARING_310/ calypso_user]

Ltlities  Help
Short Mame IICE CLEAR CREDIT Skakus IEnaI:uIed
Full Marme IICE CLEAR CREDIT Raole(s) [dgent
P
Felret I _l CounkerParty
Country ILINITED STATES j | ExtCounterParty
MarketPlace
Inactive As From I Lser Iqliu
Entered Date [10/14/2013 [1:52:51 1 [ Triparty Sub
External Ref I
. IN\"C {* Financial
nlidays |
" Mon Financial
Id Processing Org Legal Entity Role Attribute Tvpe Attribute Yalue
255197 |ALL ICE CLEAR. CREDIT ALL ICELinkParticipant icetrusk
2551938 ALL ICE CLEAR. CREDIT ALL Client Clearing Book, CALYPLIS-C
255199ALL ICE CLEAR. CREDIT ALL House Clearing Book, CALYPLS-H

Books are optional.

4.3 Defining the Agent Bank

The agent bank for all clearing activity is HARRIS BANK.

It should be defined with the following roles: “Agent” and CounterParty”.

From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities.

- Legal Entity- Yersion - 1 [1300035P1,/cft-staging-130003sp1/calypso_ =10l x|
Ltlities  Help

Short Mame IHF'.RRIS BAmE Skatus |Enabled

Full Marne IHarris Bark Raole(s) |[Agent

Parent I CounkerParty
Counkry ILII"-JITED STATES j _|
Inactive As From I User Ical':.fpscu_user
Entered Date ||:|5;13;2|:|12 |9:n1 1358 PM =|

Disabled Rolels)
External Ref I

% Financial
Halidarys |r~wc |

" Mon Financial

Click Contact to define at least one contact.

4.4 Defining the Clearing Member

Clearing Member Setup Requirements

A clearing member requires the following settings:
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A clearing member legal entity

OPTIONAL - A House book to represent CCP-facing house activity.

OPTIONAL - A Client Book to represent CCP-facing client activity.

A Nostro account for each currency that represents the cash position of the clearing member at the agent.

A Dummy Client account at the clearing member for payments between the clearing member and the
client.

4.4.1 Clearing Member Legal Entity

”ow

The clearing member should be defined with at least the following roles: “ProcessingOrg”, “Agent”, “CounterParty”.

From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities.

ZLEgaI Entity- ¥ersion - 1 [1300035P1 /cft-staging-130003spl /calypso | - | Ellil
Ltilities  Help
Shart Name [CGM LLC Status [Enabled |
Full ame ICaIypsu Global Markets Role(s) [Agent
CounkerParky
FEEL I ProcessingCirg

Inactive As From I User Icalypsn_user

Entered Date ||:|E.;19;2|:|12 |2: 16:12 PM

Country ILINITED STATES j |

3

Disabled Rolels)
External Ref I

e IN".’C ¥ Financial
olidays |
" Mon Financial

Click Contact to define at least one contact.

Click Attributes to set the following legal entity attributes:

Id Processing Org | Legal Entity Role Attribute Type - Attribute Value
o7a84|ALL CGM LLC ALL CMEFirmId 343

F3681ALL CGM LLC ALL CMEProcessingOrgld 343

3163 1[ALL CGM LLC ALL Clearing Business Calendar CCP

o7a90|ALL CGM LLC ALL Client Clearing Boak CGM-CLIENT
o7a89|ALL CGM LLC ALL House Clearing Book CGM-HOUSE
o7a83|ALL CGM LLC ALL LCHFirmId CC1

74682 ALL CGM LLC ALL Mirirnurn CFTC Requirement (5000000, 2
74683 |ALL CGM LLC ALL Minimum Other Requirement  |-200

OPTIONAL - “House Clearing Book” = <Book name for house trades>

See Defining Books for details — The book can be defined at the Clearing House or Clearing Account
level instead.

OPTIONAL - “Client Clearing Book” = <Book name for client trades>

See Defining Books for details — The book can be defined at the Clearing House or Clearing Account
level instead.
"< CCP><Clearing Service>FirmId” = <ID given by CCP to identify the clearing member>

For example: CMEIRDFirmId, CMENDFFirmId, LCHIRDFirmId - You need one FirmId for each CCP and each
clearing service that you use.

Clearing services are defined in the domain “mccAdditionalField.PRODUCT_TYPE".
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If you do not need to specify the FirmlId by clearing service, you can use the attribute <CCP>FirmId
instead.

For example: CMEFirmId, LCHFirmId.

OPTIONAL - “"<CCP>CVRSenderCode” = <ID given by the CCP to identify the Collateral Valuation Report
(CVR) sender>

If it is populated, it will be used to identify the CVR sender, otherwise the legal entity attribute
"< CCP><Clearing Service>FirmId” or *<CCP>FirmId” will be used.

“LCHRemoteFolderStructure” = <LCH folder option: Select “Static” or "Dynamic”>

LCH offers two folder options for storing the EOD files: “Static” stores all reports under the SwapClear
folder, and “Dynamic” stores the reports per date folder under the SwapClear folder.

“Minimum CFTC Requirement” - Used for regulatory reporting

Refer to the Calypso Clearimg Member User Guide for information on regulatory reporting.
“Minimum Other Requirement” - Used for regulatory reporting

Refer to the Calypso Clearimg Member User Guide for information on regulatory reporting.
OPTIONAL - “Clearing Business Calendar” = <Holiday calendar>

Used to represent the calendar on which the clearing member will run EOD processes, and generate
statements for the clients. If any CCP is open, the clearing member will be running EOD processes.

If this attribute is not set, the calendar specified in the clearing member definition is used instead.
Refer to the Calypso Clearimg Member User Guide for details.

4.4.2  Clearing Member Accounts

Clearing Member - Nostro Account @ Agent

Cash accounts of the clearing member at the settlement bank (agent) for cash settlement and margin call trades.

You need one nostro account for the House account and another one for Client segregated accounts.

From the Calypso Navigator, navigate to Configuration > Accounting > Accounts to define accounts.

Define an automatic SETTLE account with:

Processing Org = <Clearing member name>
Legal Entity = <Agent name>

Role = Agent

Example of House Nostro Account.
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Account  Utilities Reports  Process  Help

Account |Siatemenis I Attributes I Interests |L'.|-||'15 I Consolidation IT{amdaﬁmﬁ.evabaﬁm I Bmme|

Account Name ‘CALYPUS HOUSE

v] Coy [AL.ITO vl Id|141252

Processing Org | CALYPUS
Type |SETTLE v [ ] [Eseaty Auto Template Acc
External Name | (@] Interface Rl Aggregate
Description | CALYPLS HOUSE
Legal Entity (F2) ‘BANK OF AMERICA | ™ Role ’Agent
Creation Date Create by Acr Engine only | Properties/Attributes (F4)

| | o | LastClosingDate ‘

62

Closing Account ‘
Parent Account ‘ | [ ] Parent Id I:l
Amu.ntl Sialzmenisl Attributes |Int-:—.- 515 ]urils|Co:‘n::o= dation |Traﬂaﬂwmevﬂ.nﬂnn|&me|
| Order Attribute Value
1|~ Constant ICALYPUS HOUSE NOSTRO
2|~ Constant -
3|+ XferCey

Example of Client Segregated Nostro Account.

Account  LUtilities Reports Process Help

Account |5:3tanmt-; I Attributes I Interests | Limits | Consolidation ITrandaﬁmﬁevabaﬁm I Bmwse|

Account Name |CALYPUS SEG-CLIENT]

v] Coy [#UTD vl Id‘141251

Processing Org ’CAL‘FPUS

Type |SETTLE > [ | [security [¥] Auto/Template Acc
External Name | | @ Interface Rule ’Aggregate
Description |CAL‘|"PUS SEG-CLIENT
Legal Entity (F2) |BANKDF AMERICA | ™ Role ’Agent v]
Creation Date |6,-'14;’13 6:07:383 FM | Create by Acc Engine only ’ Properties /Attributes (F4) l
Closing Account | | [ l Last Closing Date ‘
Parent Account | | [ ] Parent Id I:l
| mll SBMJ Attributes | Interests I Limits | Consolidation | Translation/Revaluation [ &m|
Order Attribute Value
1|~ Constant (CALYPUS SEG-CLIENT
2|~ Constant B
3|~ XferCcy
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Click Properties/Attributes (F4) to set account attributes as needed.

e  Attribute “SequesteredAccount” = Bank

Clearing Member — Nostro Dummy Account @ Agent

This account will be used for swap interest.

A Accounts Definition - Autherization mode OFF CALYPUS DUMMY / 141260 - version 1

Account  Utilities  Reports  Process  Help

Account | Statements | Attributes | | Limits | Translation/Revaluation | Browse|

Account Name |CALYPUS DLIMMY|

Processing Org | CALYPUS - | Ccy AUTO - Id |141260
Type |SETTLE - E] [ security Auto/Template Acc
External Name Interface Rule Agagregate -

Description |CALYPUS DUMMY

Legal Entity (F2) BAMK OF AMERICA E] Role Agent -
Creation Date |6/14/13 11:53:52 PM Create by Acc Engine anly Properties fAttributes (F4)
Closing Account E] Last Closing Date
Parent Account E] ParentId |0
| Account Stal.emenls: Attributes I Limits I [Trarnslamnmevaluation Browse |
Order Attribute Value
1|~ Constant CALYPUS - DUMMY
2|~ Constant -
3|~ XferCey

4.5 On-Boarding an Individual Client/Affiliate

Client Setup Requirements

On-boarding a client requires the following settings:
e A Client legal entity.
e A book that contains client trades (defined at Client legal entity level or Client Account level)
e A Position account at the clearing house for each CCP / service (e.g. CME/NDF).

e A pair of Clearing accounts at the clearing member for each CCP/ service. One account configured with the
client’s LE and a second one, also known as mirror account where the Legal Entity is the CCP.

Both accounts are linked through the Description field that contains the account id of the other account.
Both accounts must contain the CCP position account Id in the External Name field.

e Internal Cash accounts for each currency.

e  Dummy accounts for each currency.

It is recommended to use the Onboarding Manager as it creates all the required data at once, including the
settlement and delivery instructions and the margin call contracts.

See Settlement and Delivery Instructions for details on SDI setup requirements.
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See Margin Calls Setup for details on Margin Call Contracts setup requirements.

45.1 Onboarding Manager

You need to add a menu item for the Onboarding Manager for menu action onboarding.OnboardingWindow.

It brings up the Clearing Client Onboarding window. It allows defining a client based on a client template,
previewing the data that will be created, and saving the required data: legal entity, book, accounts, interest
bearing configurations, settlement and delivery instructions, and margin call contracts.

Access Permissions
The following access permission functions apply to the Onboarding Manager.
e CreateModifyOnboardingTemplate — Permission to save, Save as new, and delete onboarding templates.
e CreateOnboardingObjects - Permission to save onboarding templates, but not save as new.
e ModifyOnboardingTemplate - Permission to save the objects generated by the onboarding tool.
e  AuthorizeOnboardingCreation — Permission to authorize client onboarding data in Authorization mode.
You can also assignh read-write access or read-only access to onboarding templates under the “"Onboarding
Templates” category in the Groups panel of the Access Permissions window.
Static Data Filters
You need to create static data filters for the transfer types.

Sample XferType_NOT_Int/Upfront_Fee
4 Static Data Filter Window [1400225P2/LAPTCP_REL14/calypso_user]

Mame:| xferType_MOT_Int/Upfront_Fee ALk
Camment:
GGroups: ALY B
Attribute Criteria Filter Yaluels)
COMMISSION, FEE, INTEREST, TERMIMATION_FEE,UPFROMT _FEE

Sample XferType_Interest/Upfront_Fee

_A Static Data Filter Window [1 PT_EI_J'_M;D_USE], - ‘I o

Mame; ¥ferType_Inkterest/Upfront_Fee ALk
Comment:
Groups: ANY E]
Attribute Criteria Filter Yalue(s)
wfer Type |+ IN | Cadd ) [CoMMISSIoN, FEE, INTEREST, TERMINATION_FEE,UPFROMT_FEE

Margin Call Contract Type

In order to populate the contract type properly, you need to add the following values to the domain
“legalAgreementType”:
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e Client - This value will be set as the Contract Type for client facing margin call contracts.

e Client@<CCP>, such as Client@CME and Client@LCH - This value will be set as the Contract Type for CCP
facing margin call contracts.

Client Template

A template is provided out-of-the-box “"CLIENT_default”. It contains the basic required data. They are described
below.

You can choose Manage Templates > Configure to save the out-of-the-box template as a new template, in
order to modify it.

You can add values for the following types of information:
e lLegal Entity Roles
e |Legal Entity Attributes
e  Book Attributes
e  Account Properties
e Account Attributes for Auto Accounts

Choose File > Save or File > Save As New to save your changes if any.

Default Client Template Values

Fields Default Value

Processing Org <not set>

Legal Entity Roles Client, CounterParty, Statement Recipient
Financial true
Status Disabled
Country <not set>
Holidays <not set>

Legal Entity ClearingReportingCurrency  <not set>

Attributes

Clearing Book Book Name <ClientName>@<POName>
Activity Clearing
Accounting Link <not set>
Processing Org <not set>
Location <not set>
End of Day <not set>
Base Ccy <not set>
Holidays <not set>
Comment <not set>

Book Attributes Pricing Env FROMDB
BookType Client

Book Currency [ ALL_]

Permissions
Currency Pair [ ALL ]
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Fields Default Value

Product [ ALL ]

Clearing Clearing Book <ClientName>@<POName>
Account . leari
Properties Description Clearing

ClearingCashAccount false

CCPOriginCode CLIENT

AccountType Client
Clearing Mirror Account Name <ClientName>@CCP_<POName>_<CCPName><ServiceName>
Account .

Processing Org <not set>

Call Account false

Type SETTLE

Security false

Currency AUTO

Auto/Template Acc true

Interface Rule Aggregate

Role Agent

Create by Acc Engine Only  true

Balance true

Frequency DLY
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Fields Default Value
Day 1
Rule <not set>
Roll END_MONTH
Billing true
Interest Bearing false

Clearing Mirror Auto account attributes <not set>
Account
Attributes

Cash Account_ Interest Config <not set>
Interest Bearing Interests Valid From <not set>
Interest Valid To <not set>
Interests Type <not set>

Interests Penalty false
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Fields

Default Value

Cash Account
Attributes

Direct SDI

Internal SDI

CCPOriginCode
AccountType

Auto account attributes

Role

Currency
Pay/Receive
Cash/Security
Contact
Processing Org
Products

SD Filter
Preferred
Priority
Method

Trade Counterparty
Is Direct

DDA

Role

Currency
Pay/Receive
Cash/Security
Contact
Processing Org
Products

SD Filter
Preferred
Priority

Method

Trade Counterparty
Is Direct

G/L Account
DDA

A/C

Agent

Agent Contact
Agent Identifier

Sub-Account

CLIENT
Client

<not set>

CounterParty
ANY

BOTH

BOTH
Default

ALL

ANY

<not set> Recommended: XferType_NOT_Int/Upfront_Fee
true

0

Direct

ALL

true

<ClientName>_AUTO_CASH@<POName>

CounterParty

ANY

BOTH

BOTH

Default

ALL

G.Clearing Products
<not set> Recommended: XferType_Interest/Upfront_Fee
true

0

Internal

ALL

false

<not set>

<not set>

Dummy Account
<not set>

Default

<not set>

<not set>
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Fields Default Value
Msg To Agent <not set>
VM Margining Scenario Single_Ccy - See below for details.
Legal Entity Role Client
Has Clearing Service <not set> - See below for details.
Currencies [ANY]
Start Date <not set>
EOD Pricing Environment <not set>
ITD Pricing Environment <not set>
Position Type THEORETICAL
Position Date POSITION_DATE_DEFAULT
Method Standard
Currency <not set>
Cash 0
Book <ClientName>@<POName>
Base Currency usD
Currency <not set>
Adjustment Currency <not set>
IM Margining Scenario OSA - See below for details.

Legal Entity Role
Collateral Type

Start Date

EOD Pricing Environment
ITD Pricing Environment
Position Type

Position Date

Method

Currency

Cash

ANY

Corporate

Government

Thill

Book

Base Currency

Client

BOTH

<not set>

<not set>

<not set>

THEORETICAL
POSITION_DATE_DEFAULT
Standard

<not set>

0
0
0
0
0

<ClientName>@<POName>

<not set>

[NOTE: If the user does not select a contact in the SDI section of the template, the user will need to define a contact
in the Client Information Panel. If there is a list of two or more contacts in the Client Information Panel, the first
contact in the list is used as the default contact for all SDIs]

VM Contract — Margining Scenario
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You can select the following scenarios:

e Single_Ccy - There is one VM Margin Call Contract per Client.

e  Multi_Ccy - There is one VM Margin Call Contract per Client and per currency (regardless of CCP and
product type).

e Hybrid - You may have multiple VM Margin Call Contracts per Client and per currency on an ad-hoc basis.
The currencies that are not selected all belong to the same VM Margin Call Contract.

VM Contract — Has Clearing Service

If “Has Clearing Service” is checked, and only one clearing service is selected for the client, the clearing service
details are set in the CCP and Product Type additional info on the VM contract.

These fields have to be manually populated on the VM contract otherwise.
IM Contract - Margining Scenario

You can select the following scenarios:

e OSA - There is one Margin Call Contract per CCP and product type that handles initial margins for all
clients for CCP facing contracts. If this contract already exists, it is not created again when a new client is
added.

e ISA - For SwapClear Members of LCH, it is also possible to have one Margin Call Contract per CCP, client,
and product type that handles initial margins for CCP facing contracts.

See Margin Calls Setup for complete details on Margin Call Contracts setup requirements.

Authorization Mode
You can enable the Authorization mode for the Onboarding Manager.

Add “ClientOnboardingData” to the domain “classAuthMode”. If the Authorization mode is enabled, new and
modified client data will have to be authorized before being available.

You can authorize the data in the Onboarding Manager using File > Load Pending Modifications. Accept or reject
the data as applicable. This is an all-or-nothing authorization.

Client Onboarding
Select a client template, and fill in the client information described below.
You can add more values for the following types of information, as needed:
e Contacts
e (Clearing Houses
e lLegal Entity Attributes
e  Book Attributes
e  Account Properties
e Account Attributes for Auto Accounts

The Onboarding Preview displays all the data that will be created.
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Client Imformation

Cnboarding Preview

----- Template

CLIENT _default

[

--Legal Entity
--Cl:nntact Details

I_é_|--CIearing Houses

E----Time ZOne
I.E:_|--C|earing Service
~Pasition &cco..,
-Margin Account
~Trade Massa,..
-Eligible Securi...
-Haircut Rule
-Eligible CCY
- Adjusted CCY
~Buffer
-I5 IS8
--fid-Hoc

-IUnallocated Excess

[=]-Wariation Margin

E--VM Conkrack

‘wIncluded Flows

E----Separate Paw...

H-Additional Attributes

Americaflos_Angeles

CME IRD
AAAT11
AAAZEE

[EUR, GEP, USDY]

Ao

r

Add

Add

F.amnone

Add

F.ernionre

[=]-Legal Enkity

[#-Shart Mame CLIENTE
[=]-Bonks

[+-Baok Mame CLIENTE@CALYPLIS
[=]-Contact Dekails

[#-Cantact Tvpe Default

[=]-Accounts
--P.l:l:u:uunt Marne CLIENTE@FCM_CALYPUS_CMEIRD
CLIENTE@CCP _CALYPUS _CMEIRD

CLIENTE_AUTO_CASHECALYPUS

--.ﬁ.ccaunt Mame

--.ﬁ.ccu:uunt Mame
[=]-Settlement Delivery Instructions
--Direct

--Internal

Direct/CLIENTE_AUTO_CASHECAL...

Internal

[=]-Margin Call Contracks

1M CLIENTE_CME_IRD

Then click Save Client if you are satisfied with the results. A summary of the results will be displayed.
Fields Details

Fields

Description

Template

Processing Org

Legal Entity

Short Name

Full Name

Parent

LE External Reference

Country

Holidays

Location

End of Day

Reporting Currency

Select a client template. See “Client Template” for details.

Select the clearing member.

See Defining the Clearing Member for details.

Enter the client short name.

Enter the client full name.

Select a parent as needed (optional).

Enter a client external reference as needed (optional).
Select the country.

Select the holiday calendars.

Select the location timezone.

Enter the EOD time. It must be an integer between 0 and
2359.
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Fields

Description

Contact Details

Clearing Houses

Contact Type
Role

Product Type
Processing Org
Last Name
First Name
Title

Address Line 1
Address Line 2
Address Line 3
City

State

Zip Code
Country
Phone

Fax

Email

Swift

Time Zone

Clearing Service

Position Account

Margin Account

Segregated Account

Trade Message Ref

Eligible Securities
Haircut Rule
Eligible CCY

Select the currency used to convert amounts for the Total
column in the client statement.

Select the contact type, and define the contact details.

Select the timezone.

Click to select a service used by the client. A service is a
combination of the CCPs defined in domain
"mccAdditionalField.CCP" and the product types defined in
domain "mccAdditionalField.PRODUCT_TYPE"

Enter the account reference at the Clearing House (position
account).

NOTE: For LCH it is the account reference for trades only.

Enter the margin account at the Clearing House for EOD files.

It corresponds to the following columns of the EOD files:
. CME IRSMR3 report — Column “A/C ID”
e CME Margin Summary report - Column “PBA”
e LCH Report86c report - Column “ClientAccountID”

Segregated account for SOD pass-through function — Column
Account of REP00030 report.

Multiple positions accounts may share the same margin
account.

For LCH only, enter the account reference at the Clearing
House for Cash Settlement trades.

Select the static data filter that determines eligible securities.

Select the haircut rule if any.

Select the eligible currencies.
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Fields

Description

Variation Margin

Additional
Attributes

Adjusted CCY

Buffer

Is ISA

Book
CCP Margin Account

Ad-Hoc

Valuation Date Frequency

Unallocated Excess

Currencies

Underlying Currencies

Included Flows

Separate Payment

LE Attributes
Book Attributes

Account Properties
Clearing

Account Properties Cash

Select the adjustment currency.

Check to define a buffer to apply to the initial margin. You can
enter a contractual multiplier and/or a contractual amount,
and a discretionary multiplier and/or a discretionary amount.

Check for ISA accounts (individual client activity), or clear for
ISO (clearing activity for their own individual clients).
For ISA accounts, select the client activity book.

Enter the account reference of the CCP facing IM margin call
contracts for ISA structures.

Check for intraday margin calls.
Select the valuation frequency and valuation date time.
The system allows maintaining additional collaterals held at

the clearing member by a given client, but not posted at the
CCP, in a specific margin call contract.

Check to create an additional margin call contract, and enter
the details of the contract.
For Multi_Ccy, select the currencies.

For Hybrid, select the currencies that follow the multi-currency
scenario. The non-selected currencies apply the single-
currency scenario.

Select the flow types associated with the contract, or leave
blank for ALL.

Check to add “Separate Settlements” sections to the Client
Statement.

Add attributes as needed.

4.5.2

Client Legal Entity

[NOTE: These are created by the Onboarding Manager]

Each client should be defined with the following roles:

e  “CounterParty” for the trades

e Arole for the payment of margin call trades - We are using the role “Client” in this setup. It can also be
“ExtCounterParty”.

e “Statement Recipient” to generate client statements

From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities.
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T —
A Legal Entity- Version - 1 [1400225P2/LAPTOP_REL14/calypso_user] | I o=

Utilities  Help

Short Mame |CLIENTE Status |Enabled o

Client
CounterParky
Staterent Recipient

Full Mame (CLIEMT B

Parent E]

Country | UNITED STATES T'E]
Inactive As From ser | calypso_user
Entered Dake |03/20/2014 11:28:46 AM E]

Disabled Roleds)
Exkernal Ref

@ Financial
Holidays MY E] (7 Mon Financial

[NOTE: The client legal entity is created in status Disabled by default. You need to enable it in order to use it]
Click Contact to define at least one contact.

Click Attributes to set the following legal entity attributes:

1d Pracessing Org Leqal Enkiky Role Akkribuke Type Akkribuke VYalue
£7199|CGM LLC |CLIENTE lalL  |[ClearingRepartingCurrency  |USD

e OPTIONAL - “Clearing Book” = <Client book nhame>
See Defining Books for details — The book is defined by default at the Clearing Account level instead.

e "“ClearingReportingCurrency” = <Currency used to convert amounts for the Total column in the client
statement>

e  Attribute for LSOC CVR Static Data report: CFTCID (Required - CFTC Reportable Number), LEID (Optional
- US LEI of the client), OfficeCode (Optional) and CustAccountType (Optional - H for hedger, M for
member, O for omnibus, or S for speculator).

Refer to the Calypso Clearing Member User Guide for information on the LSOC CVR Static Data report.

45.3 Client Accounts

[NOTE: These are created by the Onboarding Manager]

Client Facing Clearing Account
Mirror account of the CCP Facing Clearing Account.

You need a client account at the clearing member for each clearing house: position of the client at the clearing
member per clearing house.

[NOTE: If the client has multiple accounts at the clearing house, you need to create an account for each client, for
each clearing house, and for each account]

From the Calypso Navigator, navigate to Configuration > Accounting > Accounts to define accounts.
Define a SETTLE account with:

e  Processing Org = <Clearing member name>

e |LegalEntity = <Client/Affiliate name>

e Role = CounterParty

e Description = <ID of the CCP Facing Clearing Account>

© 2018 | Calypso Confidential - Copyright © Calypso Technology, Inc. All Rights Reserved



75 Clearing Member Setup Guide

e  External Name = <Account reference at Clearing House (position account)>
NOTE: For LCH it is the account reference for trades only.

e Create by Acc Engine only = Checked
Example for "MAPPING CUS01 CME-SWAP” - Repeat for each CCP/service and for each client.

_4 Accounts Definition - Authorization mode OFF MAPPING CUS01 CME-SWAP /141221 - version 9

Account  Liilities Reports  Process  Help

Account | Statements | Attributes I Limits I Translation/Revaluation I Erowse|

Account Mame |MAPPING CUSD1 CME-SWAP

Processing Org | CALYPUS - | Ccy ARy - Id [141221
Type |SETTLE il E [7] Security [ Auto/Template Acc
External Mame |AAAA @ Interface Rule Agagregate -

Description | 141250

Legal Entity (FZ) (CUS01 E] Role CounterParty -
Creation Date | 6/14/13 9:52:39 AM Create by Acc Engine only Properties/Atiributes (F4)
Closing Account E] Last Closing Date
Parent Account E] ParentId |0
Balance  =req DY = |Day |1 | Rule (e ] Roll |EnD_MoONTH -
Account | Statements | Attributes | Limits | | Translation/Revaluation | Browse |
Order Attribute Value
1|~ Book |

It is likely that maintenance fees will be charged to the account. The "Billing” checkbox should be checked in order
to compute maintenance fees on the account.

See Clearing Fees for details.
Click Properties/Attributes (F4) to set the account attributes.

Marne Yalue —
learingCashaccount - false

Propagate False

AccounkType - lient
Description - lzaring
learing Book, CLIEMTE@EZGM LLC
CCPOriginCode - CLIEMT
InitialMarginAccount - AALZEZ

e  Attribute "CCPOriginCode” = CLIENT

e  Attribute “InitialMarginAccount” = <Margin account at Clearing House for EOD files>
It corresponds to the following columns of the EOD files:
- CME IRSMR3 report = Column “A/C ID"
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- CME Margin Summary report — Column “PBA”
- LCH Report86¢ report — Column “ClientAccountID”
Multiple positions accounts may share the same margin account.

e OPTIONAL - Attribute “Clearing Book” = <Clearing Account book name> - It is set by the Onboarding
Manager by default.

See Defining Books for details — The book can be defined at the Client / Clearing Member level instead.

e  For LCH, attribute "LCHAccountName” = <Account reference at Clearing House for Cash Settlement
trades>

e OPTIONAL - Attribute "CCPAccountStructure” = ISA - To allow the generation of the Condensed Account
Clearing Statement.

CCP Facing Clearing Account
Mirror account of the Client Facing Clearing Account
Position of the client at the clearing house. You need one account for each client and for each clearing house.

[NOTE: If the client has multiple accounts at the clearing house, you need to create an account for each client, for
each clearing house, and for each account]

From the Calypso Navigator, navigate to Configuration > Accounting > Accounts to define accounts.

Define a SETTLE account with:

e  Processing Org = <Clearing member name>

e |legalEntity = <Clearing house name>

e Role = Agent

e Description = <ID of the Client Facing Clearing Account>

e  External Name = <Account reference at Clearing House (position account)>
NOTE: For LCH it is the account reference for trades only.

e Create by Acc Engine only = Checked
Example for *“MIRROR MAPPING CUSO01 LCH-SWAP” - Repeat for each CCP/service and for each client.
)‘_ Accounts Definition - Authorization mode OFF MIRROR MAPPING CUS01 LCH-SWAP /141226 - version 14

Account  Utilities  Reports  Process  Help

Account | Statements | Attributes I Limits I Translation/Revaluation I Browsel

Account Name |MIRROR MAPPING CUS01 LCH-SWAP

Processing Org | CALYPUS w | Coy ALUTO - Id 141226
Type |SETTLE [ security [¥" “uto/Template Acc
External Mame |GIGACALP_FUND3 Q Interface Rule Aggregate -

Description | 141227

Legal Entity (F2) |LCH Role Agent -
Creation Date |6/14/13 10:15:53 AM Create by Acc Engine only Properties/Attributes (F4) |
Closing Account Last Closing Date
Parent Account ParentId |0
Balance Freg |DLY - [Day |1 Rule «o | Roll |END_MONTH -
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| Account | Statements | Attributes I Limits [ Translation/Revaluation I Brcrwse:

Order

Attribute Value
1|~ Book

It is likely that maintenance fees will be charged to the account. The “Billing” checkbox should be checked in order
to compute maintenance fees on the account.

See Clearing Fees for details.

Click Properties/Attributes (F4) to set the account attributes.

Mame Yalue —
ClearingCashAccount falze

AccountType Clienk

Drescripkion Clearing

Clzaring Book, CLIENTE@CSM LLC
CCPOriginCode CLIEMT
InitialMarginAccount LAAZ22

OPTIONAL - Attribute “Clearing Book” = <Clearing Account book name> - It is set by the Onboarding
Manager by default.

See Defining Books for details — The book can be defined at the Client / Clearing Member level instead.
Attribute “CCPOriginCode” = CLIENT
Attribute “InitialMarginAccount” - <Margin account at Clearing House for EOD files>
It corresponds to the following columns of the EOD files:
- CME IRSMR3 report - Column “A/C ID"
- CME Margin Summary report - Column “PBA”
- LCH Report86¢ report — Column “ClientAccountID”
Multiple positions accounts may share the same margin account.

For LCH, attribute "LCHAccountName” = <Account reference at Clearing House for Cash Settlement
trades>

Client Cash Accounts

You need a cash account for each client.

From the Calypso Navigator, navigate to Configuration > Accounting > Accounts to define accounts.

Define an automatic SETTLE accounts with:

Processing Org = <Clearing member name>
LegalEntity = <Client/Affiliate name>

Role = CounterParty

Example for “Clearing Cash Flows CUS01” - Repeat for each client.
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A Accounts Definition - Autherization mede OFF Clearing Cash Flows CUSD1 / 262196 - version 3

Account  Utilities  Reports  Process  Help

Account | Statements | Attributes I Limits I ITranslatioan.evaluaﬁon I Brow5e|

Account Name |Clearing Cash Flows CUSD1]

Processing Org | CALYPUS « | Ccy ALUTO - Id |262196
Type |SETTLE v E] [] Security AutoTemplate Acc
External Mame @ Interface Rule Agagregate -

Description |Clearing Cash Flows

Legal Entity (FZ) |CUS01 E] Role .CuunterParty v.
Creation Date |9/14/13 10:17:34 PM [ Create by Acc Engine only Properties/Attributes (F4)
Closing Account E] Last Closing Date
Parent Account E] ParentId |0
Balance req DLy ] Day |1 Rule E] Roll .END_MCINTI-| -
| Account [ Statements | Attributes | [ Lirrl'tsl ITransJaﬁon,‘Revaluaﬁm I Browse |
Order Attribute Value
' 1|~ Constant Clearing Cash Flows CUS01
2|~ Constant -
3|v XferCey |

It is likely that interest will be paid on the account. The “Interest Bearing” checkbox should be checked in order to
compute interest on the account balance.

Please refer to Calypso Cash Management documentation for details on setting up interest bearing.

Click Properties/Attributes (F4) to set the account attributes.

znccuunt Attributes Window Clearing Cash Flows CUSD1

Marme Yalue -
Propagate frue
ClearingZashaccount True
CCPOriginCode CLIEMT

e  Attribute “"CCPOriginCode” = CLIENT
e  Attribute “ClearingCashAccount” = True

e Propagate = true to propagate the attributes to the child accounts

Client - Cash DUMMY Account @ the Clearing Member

This account is used for interests that are not settled.
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_A Accounts Definition - Authorization mode OFF DUMMY CUSOL / 141258 - version 5

Account  Utilities Reports  Process  Help

Account | Statements | Attributes I Limits I I Translation/Revaluation I Brow5e|

Account Name | DUMMY CUS01

Processing Org | CALYPUS | Coy AUTO - Id |141258
Type |SETTLE - | E [ Security Auto/Template Acc
External Name @ Interface Rule Agagregate -

Description |DUMMY CUS01

Legal Entity (F2) (CUSD1 [I] Rale lCounterParty - .
Creation Date |6/14/13 11:45:10 FM [ Create by Acc Engine enly Properties/Atiributes (F4)
Closing Account [I] Last Closing Date
Parent Account E] ParentId |0
Balance  Sreq |DLY v |Day |1 | Rule [I] Roll | END_MONTH -
Account | Statements | Attributes | Limits | | Translation/Revaluation I Browse
Order Attribute Value
1|' Constant DUMMY CLISO1

4.6 Defining an Internal Counterparty

One or multiple internal counterparties are required for capturing house trades.

Sample internal counterparty:

- Legal Entity- ¥ersion - 4 [1300035P1 /cft-staging-130003sp1 /calypso_use =10l x|
Ltlities  Help
Short Marme ICTI Stakus IEnaI:uIeu:I j
Full Marme ICaI';.-'psu:u Trading Inc Role(s) |Client

CounterParty
Parent |CGM LLC |

Country ILII"-.IITED STATES j |

Inactive As From I User Icalypsu_user

3

Entered Date ||:|E.;19;2|:|12 |2: 16:13 PM

Disabled Rolels)
External Ref I

e II"-.I‘HC ¥ Financial
olidays |
" Mon Financial

You also need to add the role “Statement Recipient” if you want to generate client statements.

Id | Processing Org | Legal Entity | Role Attribute Tvpe Attribute Value
1114[ALL ZTI ALL  |Clearing Book, CTIEnZGM

The setup is the same as an individual client with the following differences:
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e Clearing Book = <Internal Counterparty book name>
See Defining Books for details — The book can be defined at the Clearing Account level instead.
e OPTIONAL - Book attribute BookType = House (optional attribute to identify House activity in filters)

Internal Counterparty clearing accounts: CCP Facing Clearing Account and Client Facing Clearing Account
e  Account attribute CCPOriginCode = HOUSE

e OPTIONAL - Account attribute Clearing Book = <Clearing Account book name>

See Defining Books for details — The book can be defined at the Internal Counterparty / Clearing
Member level instead.

Sample CCP Facing Clearing Account:

Account | Statements | Attributes | 1nterests | Limies | Consclidation | Translation/Revaluation | Browse |

Account Marme ICTI-CME [ Call Accounk
Processing Crg ICGM LLC j Coy I.ﬁ.LITO j Id |1133
Type |5ETTLE LI | [~ Security v AukaTemplate &oc
External Mame I4.ﬁ.1HOLISE EI Interface Rule I.ﬁ.ggregate j
Description |1132
Leqal Entity (F2) ICME _I Role I.ﬁ.gent j

Mame Value -
AccountType House
CCPCOriginCode * HOLISE
InitialMarginAccount 44 IHOLISE

Sample Client Facing Clearing Account @ Clearing Member:

Account | statements | Attributes | Interests | Limies | Consolidation | Translation/Revaluation | Browse |

Bccount Marme ICTI-CGM-CME [~ Call Account
Processing Org ICGM LLC j Coy I.ﬁ.LITD j 1d |1132

Type ISETTLE ;I | [~ Security v AutoyTemplate &cc
External Mame |4.ﬁ.1HOLISE ] | Interface Rule I.ﬁ.ggregate j

Diescription |1 133

Leqal Entity (F2) ICTI | Role ICDunterF‘arty j

Mame Value -
AccountType House
CCPCriginCode * HOLISE
InitialMarginAccount 44 1HOLISE
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Internal Counterparty cash account @ Clearing Member: same as Client cash account @ Clearing Member with:

e lLegalEntity = <Internal Counterparty name>
e  Attribute CCPOriginCode = HOUSE

4.7 On-Boarding an Omnibus Client

Omnibus Client Setup Requirements
On-boarding an omnibus client requires the following settings:
e An Omnibus Client legal entity
e  Child Client legal entities
e OPTIONAL - A book that contains client trades (dedicated book, or shared book across multiple clients)

e A Client Clearing account at the clearing house for each clearing house. This account is linked to the Client
Clearing account at the clearing member through the account description.

e A Client Clearing account at the clearing member for each clearing house. This account is linked to the
Client Clearing account at the clearing house through the account description.

e A Client Cash account for each currency.

4.7.1  Omnibus Client Legal Entity

Each omnibus client should be defined with the role “CounterParty” for the trades, and the role “Client” for the
payment of margin call trades.

You also need to add the role “Statement Recipient” if you want to generate client statements.

From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities.

Z Legal Entity - Version - 1 (User: calypso_user) - | I:Ilil

Utilites Help
Short Name IDMNI_A Status IEnaI:-Ieu:I |
Full Mame I Role(s) |CounterParty

ExtCounterParty
Parentl |
Country INONE | - |

Inactive As From I User Icalypsn_user
Entered Date |1|:|,f15,f2|:|12 IG: 13:43 PM _I
Disabled Role(s)
External Ref I
e I i+ Finandal
olidays |
= Mon Finandial

Click Contact to define at least one contact.

4.7.2  Child Client Legal Entities

Each child client should be defined with the role “CounterParty” for the trades, and have the omnibus client as a
parent.

You also need to add the role “Statement Recipient” if you want to generate client statements.
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From the Calypso Navigator, navigate to Configuration > Legal Data > Entities to define legal entities.

z Legal Entity- Version - 0 [1300035P1/LAPTOP_RELEASE[calypso_user] ( - |I:I|£|
Utilites Help
Short Name IDMNI_CP’TY_AI Status IEnabIEd |

Full Mame I / Role(s) |CounterParty
Parent [OMNI_A |
Country INDNE = .- |

Inactive As From I User I-:alyps:::_user
Entered Date |1u,f15p_u12 |5: 16:49 PM _I
Disabled Role(s)
External Ref I

{* Finandial
Holidaysl |

{~ Mon Finandal

Z Legal Entity- Version - 0 [1300035P1/LAPTOP_RELEASE [calypso_user] [ - II:Ilil
Utilites Help
Short Name IDMNI_CPTY_AS_' Status IEnabIEd ~|

Full Mame I Role(s) |CounterParty
Parent |OMNI_A y |
Country INDNE =] . |

Inactive As From I User Icalypsu_user
Entered Date IID,.’IE,.’ZDIJ_ IG:IB:DE PM _I
Disabled Role(s)
External Ref I

{* Finandal
Hulidaysl |

= Mon Financial

Click Contact to define at least one contact.

Click Attributes to set the following legal entity attributes:

Id | Processing Org Legal Entity Role Attribute Type - Attribute Value
G634 ALL COMMI_CPTY _A2 ALL |Clearing Book COMMI_AZ
Gea35|ALL OMMI_CFTY_AZ2 ALL |ClearingReportingCurrency  [USD

e OPTIONAL - “Clearing Book” = <Client book name>
See Defining Books for details — The book can be defined at the Clearing Account level instead.

e “ClearingReportingCurrency” = <Currency used to convert amounts for the Total column in the Client
Statement>

4.7.3 Omnibus Accounts

Child CCP Facing Clearing Account

The clearing account is at the Child Client level. Position of the client at the clearing house. You need one account
for each client and for each clearing house.

Mirror account of the Child Client Facing Clearing Account.
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It is the same as an individual client clearing account with:

e LegalEntity = <Child client name>

See CCP Facing Clearing Account for setup details.

Child Client Facing Clearing Account
Mirror account of the Child Client Facing Clearing Account.

You need a child client account at the clearing member for each clearing house: position of the client at the
clearing member per clearing house.

It is the same as an individual client clearing account with:
e LegalEntity = <Child client name>

See Client Facing Clearing Account for setup details.

Child Client Cash Accounts
You need a cash account for each child client and for each currency.
It is the same as an individual client cash account with LegalEntity = Child Client name

See Client Cash Accounts for setup details.
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Section 5. Settlement and Delivery Instructions

The settlement and delivery instructions (SDIs) drive the trade transfers to the Calypso accounts.

Sample SDIs flow for house activity and individual client activity (this diagram only shows the SDIs that impact
Calypso accounts).

Swap Trade PO SDI - Internal
o "
between Client / Clearing Member v Client Dummy Account @ CCP
PO SDI - Internal
Swap Trade .
, | Clearing Member Dummy Account @ CCP
between Clearing Member / CCP
CASH_SETTLEMENT Trade PO SDI - Direct Clearing Member Dummy Client Account
Margin Call Trade
between Client / Clearing Member Client SDI - Direct Client Cash Account
CASH_SETTLEMENT Trade
PO SDI - SWIFT g Clearing Member House Nostro Account @ Agent

Margin Call Trade Clearing Member Client Nostro Account @ Agent

between Clearing Member / CCP

From the Calypso Navigator, navigate to Configuration > Settlements > Delivery Instructions to define SDIs.

5.1 CCP Settlement Instructions

Beneficiary = CME
Role = CounterParty

List of settlement instructions — Sample setup is provided below.

301 Mame Method  Agent Currencies  Products Gl Account 3D Filker

SWIFT/HARRIS BANK Harris Bank [SWIFT  [HARRIS BAMK [aNt |ane | |

Internal/CMEInternal SOI For trading ackivity |Internal |CME |.C\N‘f |G.CIearingF‘r0c|ucts | |><FerType_Interest,l'Ument_Fee

SDI Name - Description Method Agent CCY Product Calypso
Account

Internal/CME/Internal SDI for Internal CME ANY  G.ClearingProducts N/A

trading activity

SWIFT/HARRIS BANK/ HARRIS SWIFT HARRIS BANK ANY ANY N/A

BANK

Cash payments between clearing
member and CCP.

Beneficiary = LCH
Role = CounterParty

List of settlement instructions - Same as CME settlement instructions.
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SDI Name - Description Method Agent CCY Product Calypso
Account
Internal/LCH/Internal SDI for trading Internal LCH ANY G.ClearingProducts N/A
activity
SWIFT/HARRIS BANK/HARRIS BANK SWIFT HARRIS ANY  N/A N/A
BANK

Cash payments between clearing
member and CCP.

CCP - Sample “Internal/CME/Internal SDI for trading” Settlement Instructions

Edit | Attributes & Notes | Browse|

SDI Id ae197
Reference 66197 Cash)Security iBOTH vi
Rale iCounterParty vi Cantack iDeFault vi
Beneficiary | CME E] Processing Org :F\LL v:
Benef. Mame Products |G, ClearingProducts
Coy | ANY E] 5D Filker | %ferType_Interest/Upfront_Fee
PaviRec :BOTH v: Trade CounterParky | ALL
Description |InkernaliCME/Tnternal 30T Faor brading ackiviky Preferred Priority 0
[ Link SDI

Method Internal - [ Direct Effective From
Effective To
Identifier E

[] by Trade Date

Agent: CME | [intermediary] | [intermediaryz] | |

Code [CME E] A/ | Internal SDI Faor trading ackiviky [Imsg

Zontact | Default w* | @l pgc

This SDI does not impact any account in Calypso.

Static data filter XferType_Interest/Upfront_Fee

rame: wferType_Interest/Upfront_Fee Bk
Commenk:
Graups: ANY []
Attribute Criteria Filker Wahiels)
wfer Type |+ IN | Casdld | COMMISSION, FEE, INTEREST, TERMINATION_FEE,UPFRONT _FEE
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CCP - Ssample “SWIFT/HARRIS BANK/HARRIS BANK” Settlement Instructions
Cash payments between the clearing member and the CCP.

Edit I Attributes & Notes | Browss |

sD11d | 1304
Reference I Cash/Security IBOTH j
Role ICUunterParty j Contack IDeFauIt j
Beneficiary ICME | Processing Org I.D.LL j
Benef, Namel Products IF\N‘.’ |
Cey I.D.N‘f | D Filterl |
PayiRec IBOTH j Trade CounterParky IP.LL |
Description ISWIFT,I'HF\RRIS BAMKHARRIS BAME ¥ Preferred Priority I u}
[ Link 501

Methad [SWIFT ~| had | [~ Direct | Effective From | N
Effective To I—

Identifier
I _l [~ by Trade Date

Agent: HARRIS BAMNE | [intermediary]l [intermediaryZ]I I

Cade IHF'.RRIS BAMK | afc IHARRIS BAHK [ Msg

This SDI does not impact any account in Calypso.

5.2 EMIR Segregated Accounts

For SwapClear Members of LCH, clients can choose to hold deposits of collateral that cover Initial Margin
requirements into separate accounts.

Margin Call Contracts

In order to allow this, the individual CCP-facing IM contracts must be created for each client who wants a separate
account (each unique EMIR Account). On this IM contact, the CCP_REFERENCE must be set to the LCH client’s sub-
account number instead of “C"”. The LCH client’s sub-account number can be found in the “Account” column of LCH
Report86¢ report, or Report 33a for intraday margins. The CCP_REFERENCE must match the Account value in this
report in order to import the Initial Margin from that row of the report.

See Clearing Member Contracts — CCP Facing Contracts for details.

CCP Settlement Instructions

CCP settlement instructions must be added to populate the separate account. One for each client.
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ZSEI:l:Iement Delivery Instructions [130007SP2,/CLEARING_Z9,7] {User: slee)

Utilities  Help

Edit I Attributes & Notes | Browse |

SOIId | 277302
Reference | 277302 CashySecurity IBOTH =]
R.ole ICnunterParty j Conkack IDeFauIt ﬂ
Beneficiary ILCH _l Processing COrg IP.LL ﬂ
Benef. Namel Products I.D.NY _l
Cey IF\N\" _l 5D Filker IDS.COLLF\TERAL-GIGDD‘IDISA _l
Pay/Rec IBOTH j Trade CounterParty IP.LL _l

Description I',I'HP.RRIS BAMESLCH NOSTRO ACCOUNT OF GIG0040I54 |+ Preferred Pricrity I 0

[ Link 501

Method [S%IFT | add | [ Direct Effective Fram |

Effective To I

Identifier
I _l [ by Trade Date

Agent: HARRIS BANK I [intermediary]l [intermediar\;2]| Direck |

Code IHP.RRIS BANEK | AC ILCH MNOSTRO ACCOUNT OF GIGO04DISA [~ Msg

Static Data Filter Window [1300075P2/CLEARING_29/] (User: slee)

NamE:IEIS.COLLP.TERAL-GIGEID-‘-}DISP. Attributes., . Sirmulate. ..
Cl:umment:l Pending Modifs
Gru:uups:l.ﬁ.N"r' |
Attribuke Criteria Filter Yaluels)
IM Static Daka Filber M Add |05, COLLATERAL
Fﬂargin Zall Contract Id IMT_EMUMERATION 337892

The attribute “Margin Call Contract Id” in the Static Data Filter is the CCP-facing IM contract created for the client
where the CCP_REFERENCE is set to the LCH client’s sub account (*Account” column of LCH Report86c).
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zMargin Call Window - ¥ersion - 0 {User: slee) =] B3
Margin Call Config Ukl Help
Edit I Browsel
Mame : IIM CALYPUK-C LCH GIGO040154 |33?392 |c| Subtype : IMaster j
Description : IIM CALYPUE-C LCH GIGO04DISA Parentk : I J
Additional Info | Eligible Books | Eligible Securities | Eligible Currencies | Concentration | Optimization | Child Configurations
Parties Details | Dates & Times Initial Margin Independent Amount
= 2] Ratings | = 2] R.atings |
E Processing Org = Legal Entity -
Rale Processingorg Rale CounterParty
Processing Crg CALYPUE Legal Entity LiZH
Full name CALYPUE Full name Londaon Clearing House
E Collateral Type = Collateral Type
E Others
P LZH
CCP_ORIGIM_CODE CLIENT
CCP_REFEREMCE GIG004DI54
5.3 Clearing Member Settlement Instructions
Beneficiary = <Clearing Member name>
Role = ProcessingOrg
List of settlement instructions — Sample setup is provided below.
SDI Mame Method  Agent Currencies  Producks GL Account 5D Filter
Direct{CGM LLCJCGM_SETTLE _ACCOUNT Direct  |CGEMLLC A FA CGM_SETTLE _MCCOUNT
InkternalfCMEDummy Account Internal  |CME AR . ClearingProducts  (CEM-CLIENT nferType_Inkerest/Upfront_Fee
SWIFT/HARRIS BANK/CGM-USD-NOSTRO-CLIEMT |[SWIFT  |HARRIS BAMK |USD BT CGM-UISD-NOSTRO-CLIENT [SDI_ClisntTrades
SWIFT/HARRIS BANK/CGM-USD-NOSTRO-HOUSE |[SWIFT  |HARRIS BAMK |USD MY CGEM-USD-NOSTRO-HOUSE [SDI_HouseTrades
SDI Name - Description Method Agent CCY Product Calypso Account
Direct/Clearing Member/Dummy Client Direct Clearing ANY  ANY Dummy Client
Account Member Account
CASH_SETTLEMENT trades between
clearing member and client.
Internal/CME/Dummy Account for Internal CME ANY Swap, FRA, Dummy Account
Swaps/FRAs/FXNDFs LCH FXNDF @CME
Internal/LCH/Dummy Account for Dummy Account
Swaps/FRAs @LCH
Trades between clearing member and
CCP.
[NOTE: Repeat for each CCP]
SWIFT/HARRIS BANK/Clearing Member SWIFT HARRIS USD ANY Clearing Member
HOUSE NOSTRO USD BANK HOUSE NOSTRO USD

Cash payments between clearing
member and CCP for house trades.

[NOTE: Repeat for each currency]
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SDI Name - Description Method Agent CCY Product Calypso Account

SWIFT/HARRIS BANK/Clearing Member SWIFT HARRIS USD ANY Clearing Member

CLIENT NOSTRO USD BANK CLIENT NOSTRO
usD

Cash payments between clearing
member and CCP for client trades.

[NOTE: Repeat for each currency]

Clearing Member - Sample “Direct/Clearing Member/Dummy Client Account”
Settlement Instructions

CASH_SETTLEMENT trades and margin call trades between the clearing member and the client.

Edit I Attributes & Notes | Browse |

SDId | 2559
Reference I ZGM-Direck CashfSecurity IBOTH j
Rale IProcessingOrg ﬂ Contack IDeFauIt j
Beneficiaty ICGM LLC _I Processing Org I.D.LL j
Benef. Namel Products IF\N‘T’ _I
Cey |any _I SD Fker | _I
PayfRec IBOTH ﬂ Trade CounkerParty IF\LL _I
Description [Direct/CGM LLC/CEM_SETTLE_ACCOLNT [¥ Preferred prioity | o
[~ Link 50T

Effective To I

Identifier
I _l [~ by Trade Date

Methad IDirect j add | Effective From I

Agenk: CEM LLC I [intermediary]l [intermediaryZ]I Direck |

Cade ICGM LLE | AIC ICGM_SETTLE_.C\CCOLINT ¥ Msg

c-:nta-:tloefault j Gl Ajc ICGM_SETTLE_F\CCOLINT |

Clearing Member - Sample “SWIFT/HARRIS BANK/Clearing Member HOUSE
NOSTRO USD” Settlement Instructions

House CASH_SETTLEMENT trades and margin call trades between the clearing member and the CCP.

Sample for USD - Repeat for each currency.
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Edit I Attributes & Notes | Browse |

DI Id | 1303

CashjSecurity [BOTH

Reference I

Lef L] L

Rale IPrncessingOrg ﬂ Cantack IDeFauIt
Beneficiary ICGM LLC | Processing Crg I.f\LL
Benef, Namel Products IF\N\" |
Cey ILISD | 5D Filter ISDI_Hu:uuseTrades |
PayiRec IBOTH d Trade CounterParty IF'.LL |
Descripkion ISWIFT,I'HARRIS BAMK fCEM-USD-NOSTRO-HOLUSE v Preferred Priority I ]
[ Link 50T

Effective To

Identifier or
I —l [~ by Trade Date

Method ISWIFT j Add Effective From I

Agent: HARRIS BANK | [intermediary] | [inkermediaryz] | Direck |

Cade IHF\RRIS BNE | s ICGM—USD—NOSTRO—HOUSE ¥ Msg

c-:.ntactlDeFault j Gl & ICGM-USD-NOSTRO-HOUSE |

Static data filter to filter house trades:

Static Data Filter Window [1300035P1/cft-staging-13000 - | EIL
Name:lSDI_HnuseTrades Attributes. .. Simulate, .. |
Cnmment:l Pending Modifs |
Gruups:l.ﬁ.NY a0o |
Atkribute Criteria Filter Yaluels)
BOOK_ATTRIBUTE BookTyvpe N fdd  |[House,House@ZME
IM Static Data Filker M fdd  ||5DI_MaokSwap

Clearing Member - Sample “SWIFT/HARRIS BANK/Clearing Member CLIENT
NOSTRO USD” Settlement Instructions

Client CASH_SETTLEMENT trades and margin call trades between the clearing member and the client.

Sample for USD - Repeat for each currency.
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Edit | Attributes & Motes I Browse I

SDId | 1301
Reference I m CashSecurity IBOTH j
Rale IPrncessingOrg j Conkack IDeFauIt j
Beneficiary ICGM LLC _l Processing Crg IP.LL j
Benef, Namel Products IF\N‘.’ _l
Cey ILISD _| SD Filker ISDI_CIientTrades _|
PaviRec IBOTH j Trade CounterParky IF\LL _l
Description ISWIFTII'HP.RRIS BAMKCGM-UISD-MNOSTRO-CLIEMT ¥ Preferred Priority I—D
[~ Link sDI
Method ISWIFT ﬂ Add Effective From I—
Effective Ta I—
tdentifier I —l [ by Trade Date
Agent: HARRIS BAME I [intermediary]l [intermediaryz]l Direck |
Cade IHF\RRIS BANE _| s ICGM-USD-NOSTRO-CLIENT ¥ Msg
Contact |Defaul ~| GLAJC [CaM-USD-NOSTRO-CLIENT _|

Static data filter to filter client trades:

Sl:al:ic Data Filter Window [1300035P1 /clt-staging-13000 - |I:I|
Name:lSDI_CIientTrades Attributes, ., Simulate. .. |
Cu:umment:l Pending Maodifs |
Grnups:l.ﬁ.r'-.l‘r' |
Akkribuke Critetia Filker Waluels)
BOOK_ATTRIBUTE. BookType -~ 1IN Add  ||Client, Client@CME
IM Skakic Data Filker - IM Add SDI_MotSwap

Clearing Member — Sample “Internal/CME/Dummy Account for Swap SDI”
Settlement Instructions

It can also be used for FRAs and FXNDFs as needed.

Trades between the clearing member and the CCP.

Example for CME - Repeat for each CCP.
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S01 Id
Reference

Raole :ProcessingOrg
Beneficiary |(CEM LLC
Benef. Mame

Coy | ANY

PayiRec |BOTH

GBEZ16
BEZ16 CashfSecurity
- Conkack
E] Processing Crg
Products
(] SD Filker
- Trade CounterParty

Description |Internal/iCME{Durny Accaunt

[ Link 501
Method 'Internal

Identifier

BOTH ]
.DeFault - ]
ALL

G.ClearingProducts
wFerType_Interest/Upfront_Fee
ALL

Preferred Priarity

= ] ] ]

L it
L]

Effective From

Effective To

["] by Trade Date

Agent: CME | [intermediary] I [intermediaryz] I |

Code | CME

Conkact | Default

B A/ Durmrny Account

v | Gl AMC |CEM-CLIEMT

Same static data filter as for CCP Settlement Instructions.

5.4

Msg

]

Individual Client Settlement Instructions

Beneficiary = <Client name>

Currencies = ANY

List of settlement instructions — Sample setup is provided below.

SDI Mame Method  Agent  Currencies  Producks GL Account SO Filker
Direct/CLIENT 1 AUTO_CASH@CEM LLC |Direct LY Ay CLIENT 1_AUTO CASH@CEM LLE [%ferType MOT_IntjUpfront_Fee
Internal/CME/Dummy Account Internal  |[CME AMY G, Clearing Products sferType_Interest/Upfront_Fee

Role = CounterParty

[NOTE: These are created by the Onboarding Manager]

SDI Name - Description

Method Agent

Currencies Products

Calypso Account

Direct/Client Cash Account
CASH_SETTLEMENT trades

between clearing member and

client.

Direct N/A

Margin call trades between clearing

member and client.

[NOTE: Repeat for each client]

ANY ANY

Client Cash Account
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SDI Name - Description Method Agent Currencies Products Calypso Account
Internal/CME/Dummy Account Internal CME ANY G.Clearing N/A

Products
Internal/LCH/Dummy Account LCH

Trades between clearing member
and client.

[NOTE: Repeat for each CCP]
[NOTE: Repeat for each client]

Role = Client
SDI Name - Description Method Agent Currencies Products Calypso Account
SWIFT/HARRIS BANK/Client SWIFT HARRIS ANY ANY N/A

. BANK
Margin call trades (external nostro

instructions).

[NOTE: Repeat for each client]

Individual Client - Sample “Direct/Client CASH USD” Settlement Instructions

CASH_SETTLEMENT trades and margin call trades between the clearing member and the client - Direct SDI, with
DDA = Client Cash Account @ Clearing Member.

Example for USD - Repeat for each client — Repeat for each currency.

Edit | Attributes & hotes | Browse|

S0IId G205
Reference CashjSecurity :BOTH -
Role iCnunterParty vi Cantack iDeFauIt vi
Beneficiary |CLIENTE e Processing Org | CGM LLC -
Benef. Name Products |aNY E]
Coy |ANY E SO Filker |FerType NOT _IntfUpFront_Fes E]
Pav/Rec :BOTH v: Trade CounterParky | ALL [I]
Description |Direct/CLIENTE_AUTO_CASH@OCGM LLC Preferred Priority ]
[ Link SCI

Method | Direct = [7]Direct | Effective From
Effective To
Identifier E

[ by Trade Date

| | | | Direct |

DDA |CLIENTE_AUTO_CASH@CGM LLC E]
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Individual Client - Sample “Internal/CME/Dummy Account” Settlement

Instructions

Trades between the clearing member and the client.

Example for CME - Repeat for each CCP - Repeat for each client.

Edit | Attributes & Motes | Browse |

SDIId
Reference
Role CounkerParty
Beneficiary |CLIENTE
Benef. Mame
Coy | ANY
Payv/Rec BOTH
Description |InternalfCME/null
[ Link 501

Method | Internal

Identifier

G709

Cash/Security |BOTH

- Conkact | Default

m Processing Org | CGM LLE

Products |G, Clearing Products

m SD Filker | XferType_Interest/Upfront_Fee

- Trade CounterParky | ALL

] [ birect
L]

Agent: CME | [intermediary] I [intermediaryz] I |

Preferred

L]
L]

0

Effective From

Effective To

[] by Trade Date

Code | CME

E AlC

This SDI does not impact any account in Calypso.

[[Imsg

Individual Client - Sample “SWIFT/HARRIS BANK/Client” Settlement Instructions

Client external Nostro instructions for margin call trades.

The Nostro instructions are defined for the client with role “Client”.

Example for Client A — Repeat for each client.
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Edit | attributes & Mokes | Browsel

SDId | 2522
Reference | CLIEMTA-SWIFT CashiSecurity IBOTH ]
Role ICIient j Contack IDeFauIt j
Bencficiary ICLIENT & | Processing Org ICGM LLC -]
Benef. Namel Products IAN'\"
Coy IANY | S0 Filterl |
Pay/Rec IBOTH j Trade CounterParty I.D.LL |
Description ISWIFTII'HP.RRIS BANEJCLIENT A- SWIFT [+ Preferred Priority I ]
I Link 501

Method |SWIFT | add | ™ Drect | Efectivefrom |
Effective To I—
Identifier I |

[~ by Trade Date

Agent: HARRIS BAMK I [intermediary]l [intermediary2] | Direck |

Code IHARRIS BANE | Al ICLIENT & SWIFT [~ Msg

This SDI does not impact any Calypso account.

5.5 Omnibus Client Settlement Instructions

Beneficiary = <Child Client name>

Role = CounterParty

SDI Name - Description Method Agent Currencies Products Calypso Account
Internal/CME/CME Internal CME ANY Swap, N/A
FRA,

Trades between clearing member
and child client.

[NOTE: Repeat for each CCP]
[NOTE: Repeat for each client]

Beneficiary = <Omnibus Client name>

Role = CounterParty

SDI Name - Description Method Agent Currencies Products Calypso Account
Direct/Omnibus Client CASH USD Direct N/A usbD ANY Omnibus Client Cash
usb

CASH_SETTLEMENT trades
between clearing member and child
client.
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SDI Name - Description Method Agent Currencies Products Calypso Account

Margin call trades between clearing
member and omnibus client.

[NOTE: Repeat for each
currency]

[NOTE: Repeat for each client]

[NOTE: In order for the above SDIs to be selected for CASH_SETTLEMENT trades with the child client, and margin
call trades with the omnibus client, the environment property LOOK_PARENT_SDI must be set to True]

Beneficiary = <Omnibus Client name>

Role = Client
SDI Name - Description Method Agent Currencies Products Calypso Account
SWIFT/HARRIS BANK/Omnibus SWIFT HARRIS ANY ANY N/A
Client BANK

Margin call trades (external nostro
instructions).

[NOTE: Repeat for each client]
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Section 6. Margin Calls Setup

Margin calls are handled through the Collateral Management module, which allows allocating margin calls on initial
margins and variation margins.

Initial margins (IM) are imported into the system as Collateral Exposure trades, based on Margin Call Contracts
configurations. For clearing member contracts (CCP-facing contracts), there is one Collateral Exposure trade per
Margin Call Contract and per client. For client contracts, there is one Collateral Exposure trade per Margin Call
Contract.

Variation margins (VM) are represented by the cash positions of the client cash accounts.

Margin calls on initial margins and variation margins are computed in cash by the COLLATERAL_MANAGEMENT
scheduled task, and are reported on the client statements. The clients can choose how to meet the margin calls: in
cash, securities, or both.

Haircut Rules

You can define haircut rules for foreign currencies and securities as specified by the CCP rules prior to defining
margin call contracts.

From the Calypso Navigator, navigate to Fees, Haircuts, & Margin Calls > Haircut Rule to define haircut rules -
Help is available from that window.

6.1 CCP Facing Contracts

Initial Margin

The clearing member contracts are used to store the initial margin on the positions of the clearing member at the
CCP.

Initial margin requirements being segregated for house and client activity, it is required to define margin call
contracts for each Clearing Member/CCP/activity combination.

e  For house activity, there is one Margin Call Contract per CCP and product type that handles initial margins.

e  For client activity we model as many ccp-facing margin contracts as segregation levels (e.g. omnibus
accounts, individual segregated accounts, etc.).

For SwapClear Members of LCH, it is also possible to have one Margin Call Contract per CCP, client, and
product type that handles initial margins. The client can decide whether to have segregated accounts or
not.

The initial margins can be stored in the base currency of the Margin Call Contract, or in the native currency. Margin
calls are computed in the corresponding currency, and can be substituted to collateral securities.

The actual margin calls are represented by margin call trades.

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Margin Call to
define margin call contracts.

Variation Margin

By default, there is no need to define variation margin contract as the variation margin is automatically settled in
cash with the CCP. However, you can also setup variation margin contracts with the CCP in order to use the
Collateral Manager to generate margin call trades, and allocate the margin calls in cash or security. These variation
margin contracts should be defined in the same manner as the client variation margin contracts with or without
breakdown of Variation Margin Components.

A sample setup is provided below.
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6.1.1 CCP Facing - Initial Margin Contracts

On these contracts, the legal entity configured in the contract is the CCP. These contracts are meant to represent
the margin requirements between the clearing member and the CCP. There are two types of ccp-facing contracts:

e House CCP-Facing
e Client CCP-Facing
The House CCP-Facing contract will represent the margin requirements for the house activity.

The number of Client CCP-Facing contracts is driven by the different types of segregation of the customers: e.g.
Omnibus accounts, ISA accounts.

Example

A Clearing Member (represented by the PO in Calypso) has the following clients:
Undisclosed Customers:
Clientl and Client2
Disclosed Clients
CUSO01 and CUSO02 (both clients benefit from the full segregation e.g. ISA accounts)
We would model the IM margin call Client CCP-Facing in Calypso as follows:
e  One contract representing the Omnibus Account (including Clientl and Client2)

e  One contract representing customer CUO1

e  One contract representing CUS02

Sample of House/Client CCP-Facing Contract:

Tab: Fields

Client Activity

House Activity

Parties: Processing Org

<Clearing Member>

<Clearing Member>

Parties: Legal Entity

<CCP>

<CCP>

Parties: Legal Entity Role

Counterparty

Counterparty

Details: Products

CollateralExposure

CollateralExposure

Details: Currency

<Cleared Currencies>

<Cleared Currencies>

Details: End of Day Pricing Environment

<Your pricing environment>

<Your pricing environment>

Details: Intraday Pricing Environment

<Your pricing environment>

<Your pricing environment>

Details: Contract Type

Client@[CCP]

House@[CCP]

Details: Haircut

<haircut rule>

<haircut rule>

Dates & Time: Valuation Time Zone

Same as pricing environment
time zone

Same as pricing environment
time zone

Dates & Time: Valuation Date Frequency

<rule for valuation date
frequency>

<rule for valuation date
frequency>
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Tab: Fields

Client Activity

House Activity

Dates & Time: Valuation Time Offset

<rule for valuation time offset>

<rule for valuation time offset>

ISA Account

Initial Margin: Initial Margin option Checked Checked
Additional Info: CCP <CCP> <CCP>
Additional Info: CCP_REFERENCE CLIENT (Omnibus Accounts) or | HOUSE

Additional Info: PRODUCT_TYPE

This is also known as the
clearing service.

Values are configured in the
domain
<mccAdditionalField.PRODUCT_
TYPE

This is also known as the
clearing service.

Values are configured in the
domain
<mccAdditionalField.PRODUCT_
TYPE

Additional Info: MARGIN_TYPE

IM

IM

ELIGIBILITY
Eligible Book -> Set Default Book

Checked

Checked

ELIGIBILITY
Eligible Book -> Books

<Clearing member Client Book>

<Clearing member House Book>

ELIGIBILITY
Eligible Securities

Add one or more bond filters

Add one or more bond filters

ELIGIBILITY
Eligible Currencies

<base currency>

<list of eligible collateral
currencies>

<base currency>

<list of eligible collateral
currencies>

Parties: Legal Entity

This is the Clearing House.

Details: Contract Type

This is useful in the case the user needs to filter the margin contracts per CCP AND [client or house].

The recommended format is: Client/House>@ <CCP>

Examples:

e C(Client@CME
e House@LCH, etc.

Dates & Time: Valuation Date Frequency

Recommended rule:
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A ateRules ol s

Name |COL_MIGR_DAILY_BUS Type |DALLY v
Day |0 Add Days|0 WeekDay |NONE
Month | JAN Rank |NONE

[ selectal | [ UnSelectal - ]

Date Roll | FOLLOWING -

[J3an [“|Feb []Mar
[Capr  [CJMay [C]dun
Flul  [Flawg [Fsep
[Floct [FNov [F]Dec

Add Relative Months 0 @) Bus " Cal  [[]BusDays

Holidays E]

[ Check Holiday

Relative Type:

Absolute -

Dates & Time: Valuation Time Offset

Recommended rule:

Aerues E=yE=n=
Name |COL_MIGR_VAL_REL Type .RELATI\I'E - ]
Day |0 Add Days|-1 WeekDay .NONE |
SR Rank [NONE
Select Al UnSelect Al I 1
Date Roll | PRECEDING -
Jan Feb Mar . )
. Add Relative Months 0 @) Bus 7 Cal  [[]BusDays
Apr May Jun
Relative Type: i
l Aug Sep ¥p Holidays E]
Absolute .
Oct MNow Dec - [ Check Holiday
Relative |COL_MIGR_DAILY_BUS 305685 E
Example:

Parties | Details | Dates &Times | Initial Margin | Independent Amount I Eligibility I Concentration | Optimization | Configurations | Linked ¢

g
= =5 2
= valuation
Valuation Agent Type

Valuation Date Frequency COL_MIGR._DAILY_BUS

Valuation Time Offset COL_MIGR_VAL_REL
Valuation Time 5:00 pm
Valuation Time Zone AmericaMew_York

Additional Info: CCP_REFERENCE

By default we configure CLIENT or HOUSE as needed but for European CCPs, clients that benefit from full
segregation (ISA accounts) must be represented individually in a ccp-facing margin call contracts or through their
position accounts.

Examples for Pre-CDML: LCH
Configure this filed with values from the column “Account” in the report RPT86c/Report 33a)
Examples for Post CDML (any CCP)

Configure this field from the value in the element <segregationAccount> of the initialMargin CDML report.
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CCP CCP EOD File Field/Element
CME IRSMR3 report. Pre-CDML
Column “A/C ID”
Post-CDML
<segregationAccount>
LCH Report86¢ (Client Pre-CDML
Report 86 (house) Column “Account”
Report 33a Post-CDML
<segregationAccount>
EUREX RPTCC204 //RC/rptSubHdr/membld
CDML
<segregationAccount>
ICE Client Gross Margin Report Client Legal Entity Account

CDML

<segregationAccount>

Additional Info: PRODUCT TYPE

The values of this field must be configured in the domain mccAdditionalField.PRODUCT_TYPE

Examples: IRD, NDF, etc.

Additional Info: MARGIN TYPE

The values (IM or VM) are configured in the domain mccAdditionalField. MARGIN_TYPE

Choose IM.

Eligibility: Eligible Securities

We must create a static data filter with the choice of securities collateral.

Example:

Comment:

Groups: ANY

Name:|CME_Bond_Colateral

A Static Data Filter Window [142007/AMC/Max 1GLESIAS]

Attributes. . [

l

Attribute
Product Id

Filter Value(s)
|~ INT_EMUMERATION | |v 3107,5673,5682,6803

Froduct Type

|C——mdd— |c.Bonds

Once created, the filter appears in the bond selector:
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| Parties | Details | Dates & Times I Initial Margin I Independent Arnountl Eligibility

-Eligible Books | Eligible Securities | Eligible Currencies

4 & I Tt 3
| IEF4 Corp Bonds Product Id
‘4 StaticData Filter Selector

O cme_b
Mame Description

CME_Bond_Collateral

6.1.2

CPP Facing - VM Margin Call Contracts (Optional)

Tab: Fields

Client Activity VM
- UsbD

[NOTE: Repeat for
each currency for
the multi-currency
scenario]

House Activity VM
- UsD

[NOTE: Repeat for
each currency for
the multi-currency
scenario]

Parties: Processing Org

<clearing member>

<clearing member>

Parties: Legal Entity Role

Client

Client

Parties: Legal Entity

<CCP>

<CCP>

Details: Products

CollateralExposure

CollateralExposure

Details: Currencies

usbD

usD

Details: End of Day Pricing Environment

<pricing env>

<pricing env>

Details: Intraday Pricing Environment

<pricing env>

<pricing env>

Details: Haircut

<haircut rule>

<haircut rule>

Dates & Times: Valuation Time Zone

Same as <pricing
env> timezone

Same as <pricing
env> timezone

Dates & Times: Send Statement Checked Checked
Initial Margin: Initial Margin Checked Checked
Initial Margin: Credit Multiplier

Additional Info: CCP <CCP> <CCP>
Additional Info: CCP_ORIGIN_CODE CLIENT HOUSE
Additional Info: CCP_REFERENCE C H

Additional Info: PRODUCT_TYPE
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Tab: Fields

Client Activity VM
- USD

[NOTE: Repeat for
each currency for
the multi-currency
scenario]

House Activity VM
- USD

[NOTE: Repeat for
each currency for
the multi-currency
scenario]

Additional Info: MARGIN_TYPE VM VM
Additional Info: INCLUDED VM_FLOWS

Additional Info: False False
SEPARATE_VM_SETTLEMENT

Additional Info: VM_CLASSIFICATION CTM or STM CTM or STM
Eligible Books: Set Default Book Checked Checked

Eligible Books: Book

<PO Client book>

<PO House book>

Eligible Securities

Eligible Currencies

<base currency>

usbD

<base currency>
usb

Eligible Currencies: Cash Margin Call True

Account

Eligible Currencies: Security Margin Call True

Account

Eligible Currencies: Orderer Role CounterParty CounterParty

6.2 Client Facing Contracts

The client contracts are used to store the initial margin / variation margin on the positions of the client at the
clearing member.

On these contracts, the Legal Entity configured in the contract is the client or a clearing member affiliate. This
category of contract represents margin flows between the customer or affiliates and the Clearing Member.

Initial Margin
There is one IM margin call contract per CCP, position account and Product type.

The initial margins can be stored in the base currency of the Margin Call Contract, or in the native currency. Margin
calls are computed in the corresponding currency, and can be substituted to collateral securities.

Variation Margin
Variation margins can be stored in multiple currencies, or in a single currency, based on the client’s choice.

e  Multi-currency scenario — There is one VM Margin Call Contract per Client and per currency (regardless of
CCP and product type).
In this case, there is one variation margin per currency, and the margin calls are computed per currency.
e  Single-currency scenario — There is one VM Margin Call Contract per Client.

In this case, all variation margins are converted to the base currency of the Margin Call Contract. There is
one variation margin in base currency, and the margin calls are computed in base currency.
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The actual margin calls are represented by margin call trades.

Collateral Held at Clearing Member, not posted at CCP

The system allows maintaining additional collaterals held at the clearing member by a given client, but not posted
at the CCP, in a specific margin call contract.

These margin call contracts must be defined as the Initial Margin contracts with CCP = Unallocated.

The collaterals attached to these contracts will be included in the regulatory reporting.

Margin Call Contracts Definition

For the client contracts, it is required that the margin calls update two different accounts in Calypso:

e The clearing member external nostro account (where cash and/or securities are actually paid or received)
e The client cash account @ the clearing member

For this, the margin call contracts are defined for the external role of the client (we are using the role “Client” in
this setup - It can also be “ExtCounterParty” - See On-Boarding an Individual Client for details), and you need to
define the following attributes in the panel Eligibility > Eligible Currencies:

e Cash Margin Call Account = True
e  Security Margin Call Account = True

e  Orderer Role = “CounterParty”, the role of the Client cash account at the clearing member.

Breakdown of Variation Margin Components

This functionality allows generating client VM Margin Calls based on user-defined combinations of the CMF
generated fees and the individual cashflows that are passed from the CCP, through the CMF to the client. It allows
the users to associate transfers that hit a single cash account to multiple VM Margin Call contracts using
configuration controlled by the user.

You need to define the following attributes in the Additional Info of the VM contracts:
e INCLUDED_VM_FLOWS (Optional) - Comma-separated list of flow types associated with the margin call
contract. If it is not set, all flow types will be associated with the margin call contract (default).

You can further specify the flow types by product types using the format “[<product type>]<flow type>".
For example: [InterestBearing]INTEREST, [CA]INTEREST.

e  SEPARATE_VM_SETTLEMENT - If True, the flows associated with the margin call contract, including the
Margin Call trades, will be included in a “Separate Settlements” section in the Client Statement.
Otherwise, the flows will contribute to the Financial Summary table of the Client Statement.

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Margin Call to
define margin call contracts.

6.2.1  Client Facing - Initial Margin Contracts

Tab: Fields

Client Activity

Parties: Processing Org

<Clearing Member>

Parties: Legal Entity

Customer or Clearing member’s
affiliate Legal Entity

Parties: Legal Entity Role

Client

Details: Products

CollateralExposure
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Tab: Fields Client Activity
Details: Currency <Cleared Currencies>
Details: End of Day Pricing Environment <Your pricing environment>
Details: Intraday Pricing Environment <Your pricing environment>
Details: Contract Type Client@[CCP]
Details: Haircut <haircut rule>
Dates & Time: Valuation Time Zone Same as pricing environment time

zone

Dates & Time: Valuation Date Frequency <rule for valuation date frequency>
Dates & Time: Valuation Time Offset <rule for valuation time offset>
Dates&Times: Send Statements Checked
Initial Margin: Initial Margin option Checked
Initial Margin: Credit Multiplier <Credit Multiplier>
Additional Info: CCP <CCP>
Additional Info: CCP_REFERENCE Position account at the CCP

(see comments below)

Additional Info: PRODUCT_TYPE This is also known as the clearing
service.

Values are configured in the domain
<mccAdditionalField.PRODUCT_TYPE

Additional Info: MARGIN_TYPE M

ELIGIBILITY Checked
Eligible Book -> Set Default Book

ELIGIBILITY <customer/affiliate Book>
Eligible Book -> Books

ELIGIBILITY Add one or more bond filters
Eligible Securities

ELIGIBILITY <base currency>

Eligible Currencies <list of eligible collateral

currencies>

Eligible Currencies: Cash Margin Call True
Account
Eligible Currencies: Security Margin Call True
Account

Eligible Currencies: Orderer Role CounterParty
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Additional Info: CCP_REFERENCE

We must report the client’s (or affiliate) position account id at the CCP.

Post CDML, the value can come from either the value in the element <initialMarginAccountld> or from the value in
the element <positionAccountID>, depending on the level of granularity.

This happens when the CCP provides margin calculations at portfolio level for a given customer.

Example of EUREX

Client: CAXXV
Portfolios:

a) CAXXV_P
b) CAXXV_A1
c) CAXXV_2

We report in the CDML, in the element <initialMarginAccountld> the aggregated margin amounts for the three
portfolios and three elements <segregationAccount>, each containing the margin requirements for a), b) and c).

The user in Calypso has the choice of creating one margin call that represents the aggregation of the three
portfolios. In that case it will create one margin call and will reference in the attribute CCP_REFERENCE the
value of the element <initialMarginAccountld>.

If the user needs more granularity, it can decide to create three margin calls where the CCP_REFERENCE
attribute will contain the value of the <segregationAccount> element.

6.2.2  Variation Margin Contracts

Tab: Fields Client VM - USD
[NOTE: Repeat for
each currency for
the multi-currency
scenario]

Parties: Processing Org <clearing
member>

Parties: Legal Entity Role Client

Parties: Legal Entity <client>

Details: Products CollateralExposure

Details: Currencies usD

Details: End of Day Pricing Environment <pricing env>

Details: Intraday Pricing Environment <pricing env>

Details: Contract Type Client

Details: Haircut <haircut rule>
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Tab: Fields

Dates & Times: Valuation Time Zone

Client VM - USD

[NOTE: Repeat for
each currency for
the multi-currency
scenario]

Same as <pricing
env> timezone

Dates & Times: Send Statement Checked
Initial Margin: Initial Margin Checked
Initial Margin: Credit Multiplier

Additional Info: CCP

Additional Info: CCP_REFERENCE

Additional Info: PRODUCT_TYPE

Additional Info: MARGIN_TYPE VM
Additional Info: INCLUDED VM_FLOWS

Additional Info: False
SEPARATE_VM_SETTLEMENT

Additional Info: VM_CLASSIFICATION CTM or STM
Eligible Books: Set Default Book Checked

Eligible Books: Book

< client book>

Eligible Securities

Eligible Currencies

<base currency>

usbD

Eligible Currencies: Cash Margin Call True
Account

Eligible Currencies: Security Margin Call True
Account

Eligible Currencies: Orderer Role Counterparty

Sample USD VM Client Contract

For the multi-currency scenario, repeat for each client and for each currency.

For the single-currency scenario, repeat for each client.

The differences with the house contracts are listed below.

Parties

e Legal Entity Role = Client

Clearing Member Setup Guide
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Legal Entity = <Client name>

Dates & Times

Valuation Time Zone = Same as <pricing env> timezone

“Send Statement” = Checked

Initial Margin

“Initial Margin” = Checked

Additional Info

CCP = Not set
CCP_REFERENCE= Not set
PRODUCT_TYPE = Not set
MARGIN_TYPE = VM

INCLUDED_VM_FLOWS (Optional) = Not set.

Comma-separated list of flow types associated with the margin call contract. If it is not set, all flow types
will be associated with the margin call contract (default).

SEPARATE_VM_SETTLEMENT = False.

If True, the flows associated with the margin call contract, including the Margin Call trades, will be
included in a "Separate Settlements” section of the Client Statement. Otherwise, the flows will contribute
to the Financial Summary table of the Client Statement.

Eligible Books

Set Default Book = Checked

Book = <Client’s book nhame> - For example “Client A @ CGM”

[NOTE: The timezone of the book must be the same as the margin call contract’s valuation timezone]

Eligible Securities

None.

Eligible Currencies

Set the base currency - Example, "USD”

Only add the base currency as an eligible security, and check “Adjustment Currency”.

You must also make sure that you have the workflow rule AutoAdjust on the following transitions in the
Collateral workflow: PRICED_PAY - AGREE_EXPOSURE - EXPOSURE_AGREED and PRICED_RECEIVE -
AGREE_EXPOSURE - EXPOSURE_AGREED.

Example:

ZEIigthE Currency Definition
CUFrency I 'rl [T Compounding [ Include Inkeresk to Position v Adjustment Currency

[ | Frioject Interest to Position

Cash Margin Call Account = True
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e  Security Margin Call Account = True

e  Orderer Role = CounterParty

6.3 Omnibus Client Contracts

The omnibus client contracts are setup in the same way as individual client contracts for Omnibus client name.

See Client Facing Contracts for details.

6.4 Collateral Investment Program

The Collateral Investment Program allows FCMs to reinvest margin calls into the mutual funds and treasury bonds
participating in the program.

The mutual funds are defined as Funds, and the investment is represented using Collateral Substitution of the
margin calls into the Unitized Funds.

6.4.1 Funds Definition

From the Calypso Navigator, navigate to Configuration > Asset Management > Fund, and define the mutual
funds as in the example below.

ZFund Configuration {User: Bill Spota)

File Action Help

JS dd I XS d=aleo

Mame: [IPMCAPL ID: 1501
Settings rUnit schedule r.ﬁ.UM rLegaI Entities rDaiI';-' Dividend Definition rRebate Definition rCashFIDws ]
Marne I Yalug | Hame | Yalue
El Details El Units
Legal Entity Full Mame JPMCAPT W
Account JPMCAR]T nik Size 1
Tax ID 12345678 Init Decimals 4
Source Current Units 10,000,000
Struckture Pooled Current ALM 5,000,000
Currency s El Dividends
Asset Class Money Market Daily I
Diskribution Palicy Diskributive Guaranteed I
Cuk-off Time 11:59 pm Performance -
Cuk-off Time Zone Americajlos_Angeles Bl Benchmark
Settlement Days T+0 Risk Free Rate
Bl Issuance Type Mone
Stark Date 07012013 El Precision
Inception Date 07012013 Price decimals 5
Maturity Date Cumulative price decimals [
Redernption Ak Yalue Daily dividend decimals g
Product Code Collateral Investment: ;l

»  Select the “External” source, check “Unitized”, and check “Daily” dividend.

Along with creating this “UnitizedFund” product, you need to create the product codes “Collateral Investment”,
“SFR-8A", and “"SFR-8B” in the domain “FundAttributes”:
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=Rl undattributes
¥ Account
e i Collateral Investment
- 42 SFR-BA
i 4% SFR-GE

Then define the product codes using Main Entry > Configuration > Product > Code.

In the Fund Configuration window, click —El to open the Fund Attribute window, and set “Collateral Investment”
to TRUE.

Set SFR-8A to True if the fund should be added to column 8A of the SFR report (IEF5 funds), or set SFR-8B to True
if the fund should be added to column 8B of the SFR report (other IEF funds).

P code Window IPMCAP1

Product Cade Mame Yalue
Collateral Investment TRUE
SFR-54 True

Then create a static data filter to identify the fund. This will be used during the Collateral Substitution process.

ZStatic Data Filter Window [1300075P2/CLEARING_25,] {User: Bill Spota)

Name:lCnIIateral Inveskments Attributes. ., Sirmulate. .
C-:ummenl::l Fending Modifs
Gru:uups:l.ﬁ.N"r' |
Attribuke Criteria Filter Yaluels)
Product Twpe I ot |[UnitizedPund, Bond, Equity
PRODUCT _ZODE, Collakeral Investment I Add  |[TRLE

This static data filter must be added to the tab called “Eligible Securities” in respective CCP Facing Margin Call

Contracts. This will allow you to see all the Money Market Funds you have set up so you can later perform a
Collateral Substitution.

6.4.2 Margin Call Position Valuation Report

If you are an FCM and you want to invest a client’s collateral on deposit with you, you need to choose which of the
four CME Collateral Management Programs you as the FCM would like to invest in, how much, and finally how to
allocate within each fund. Using the example of CME’s IEF2 and IEF5 investment funds, the FCM can only send USD
cash and then enter the allocation of that cash in a separate CME system called “Clearing 21”. Using the existing
CCP facing Margin Call contract(s) already created Calypso can generate a margin call trade where the FCM will
wire funds to the CME. The cash can then be converted to a security that represents the investment in Calypso via
a collateral substitution within Collateral Manager. Now you have created a security that represents the FCM’s
investments in various CCP Collateral Management Programs.

In Calypso, we can report on the pre/post haircut amounts invested using the Margin Call Position Valuation Report
as seen below, where the pre haircut value is shown under the “Value” column and the post haircut value is seen
under the :All-In Value” column.

zMarginEaIIPusition\\'aIuatiDn Report {8,/10,/13 1:35:33 PM) {User: Bill Spota)

Report  Data  MWiew  Export  Market Dabz Utilities  Help

% Criteria
Tvpe | Id | Description Nominal Clean Price | Currency Value Haircut All-In Walue F¥ Rate Contract Yalue
Security TPMCAPL 50,506,859, 754.00 1.00[0sD -50,806,859,754.00)  0.03| -50,791,617,696.07| 1.00000( -50,791,617,696.07
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Note: In the above scenario, we have to mark the security at par on a daily basis. This can be done by using the
PROP_RATE_1BUSDAY scheduled task. Should the value of the invested money market fund increase or decrease
the user can manually change the price and manage the fluctuation accordingly.

Now imagine your client wants to invest in CME’s IEF3 and 4 programs where the only acceptable forms of
collateral are corporate bonds. The client must have sent in corporate bonds to the FCM to cover their collateral
requirements in which case the FCM would invest in IEF3 or IEF4. The FCM will then send the bonds to the CCP.
Unlike IEF2, which is an investment of cash into a money market, IEF3 and 4 are programs where the FCM can
post ineligible securities into a special account where they are rebranded as eligible collateral and can be used to
meet IM requirements. The FCM must commit to a certain "lockup amount" which is essentially a guaranteed
minimum amount that they will invest, as well as a term for that investment which dictates the minimum amount
of time that the bonds will be pledged.

6.4.3  Accounts Definition

The purpose of creating a Collateral Investment Account Definition and corresponding SDIs and static data filter is
to prevent the transfers that are tagged as a collateral investment from hitting the inventory engine and updating
the Nostro.

znccuunts Definition - Authorization mode OFF Collateral Investments / 143197 - version 4 (User: Bill spota)

Account  Ukilities  Reporks Process  Help

Account I Statementsl | | Limitsl | Translatiu:un,l'RevaIuatiu:unl Bru:uwsel

Account Mame ICDIIateraI Investments

Processing Org ICALH"F‘SO_LIS | coy ILISD vI 1d |14319?

Tvpe |5ETT|—E LI | [~ Security [~ Auko/Template Acc
External Mame I il Interface Rule I.ﬁ.ggregate j
Descripkion I
Legal Entity (F2) ICME _I Role I.ﬁ.gent ~|
Creation Diate |ax1|:|;13 12:16:45 PM Froperties/attributes (F4) |

Next create a static data filter that will enable you to achieve separation of trades and transfers which is further
explained in the next section.

ZStatic Data Filter Window [1300075P2/CLEARING_25,] {User: Bill Spota)

Name:lIEFE Investments Atkributes. .. Sirm!
Cnmment:l Pendi
Gru:uups:l.ﬁ.r'-.l‘f _I
Akkribute Criteria Filter Waluels)
KEYWORD. IEFZ I Add Erue

Note: You need to add the trade keyword “IEF2" to the domain “tradeKeyword”, and add the domain
“keyword.IEF2” to give it a list of available values.

Mame; [tradekeywaord

Yalue: |IEFZ
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ZDumain Yalues Window (U

e 2 brue

Then create the SDIs that will route both the cash and security transfers to this Collateral Investment Account.
Counterparty SDI

Settlement Delivery Instructions [130007SP2/CLEARING_26/] (User: Bill Spota)

LItilities  Help

Edit | attributes & Motes I Browse I

SOl Id | 144196
Reference I 144196 Cash)Security IBOTH j
Role ICDunterParty j Contack IDeFauIt j
Beneficiary ICME | Processing Crg I.ﬁ.LL j
Benef, Namel Products I.ﬁ.N‘f |
Cey |mw | 5D Filter IIEF2 Irvestments |
Pay/Rec IBOTH j Trade CounkerParty IF'.LL |
Descripkion IInternaI,l'CME,l'Cu:uIIateraI Investments [v Preferred Priority I 0
[~ Link 501
Methﬂd IInternaI j p'dd | I_ Direl:t EFFEEti\-‘E Fr':lm I
Effective Ta I
Identifier I |
[~ by Trade Date

#gent: CME | [intermediar‘;x]l [inkermediaryz] | Direck |

CDdEICME | aic ICI::IIaI:eraI Investments [~ Msg

PN T [ (S

Processing Org SDI
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Settlement Delivery Instructions [1300075P2/CLEARING_26,] (User: Bill Spota)

LItilities  Help

akkributes & Motes | Browse |

SDIId | 144197
Reference I 144197 CashfSecurity IBOTH j
Fole IPrDcessingOrg j Zonkack IDeFauIt j
Beneficiary ICF'.L\"F‘LIS | Processing Crg I.ﬁ.LL LI
Benef. Namel Producks I.ﬁ.l"-.l‘r' |
Cey ILISD | SO Filker IIEF2 Investments |
PawiRec IBDTH j Trade CounterParky I.ﬁ.LL |
Descripkion IInternaI,l'CME v Preferred Prioriky I 0
[~ Link 501
Method IInternaI j add | Effective Fram I
Effective Tao I
Identifier I |
[~ by Trade Date
Agent: CME I [intermediary]l [intermediaryz]l |
Code ICME | AjC | [ Mt
Zonkack ISettIement j Gl A ICDIIateraI Inveskments |

You can view in the Transfer Viewer that the USD cash settlement did not hit the Nostro.

Transfer

I Transfers | Messages | Poskings | Tasks |
eral w'orkFloww Accou

Transfer Id: [743065 i Status: ISETTLED
&y, Trade Id: [351434 i Twpe: ICOLL.C\TERAL
E, Counterparky: IChicago Mercentile Exchange Product: IMarginCaII
Financial Cakes

Side; IRECEI‘-.-'E Setkle Cow; IUSD Trade Date: IDEE,I'ZI,I'2013

Arnounk: |222,222 Walue Date: IDEH,I'21,|'2013
Other Amount: ID.DD Settle Date: IDEE,I'ZI,I'2013

Booking Date: IDEH,I'Z 1/2013

Settlerment Instructions

&, PO Agent: IChicagD Mercentile Exchange PO Agent Bic: I

&, Receiver Insk: IInternaI,l'CME ! ID Skaktus: IDeFauIt
®,  Their Agent: IChicago Mercentile Exchange Show Route I
&, Pawer Insk: IInternaI,l'CME,l’Collateral Investments ) ID Stakus: IDeFauIt

Proceed to the next section that explains how to tag both trades and transfers.
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6.4.4 Collateral Investment

Using the Collateral Manager, you can increase or decrease the amounts in a certain investment program by
choosing the security that represents the investment in Calypso and performing a Collateral Substitution.

Our recommendation to accomplish this would be the use of the “Collateral Context” feature which is located within
Collateral Manager as follows:

zcullateral Manager : Bill Test {User: Bill Spota)
File MarginCall Data ‘Yiew Export  Market Data | Window | Help

£} Load 7 Price ~ & Allocate - €33 Optimize Show View ¥ ¥ig ¥4 Reconcilation -~ a4 - ) -
Resek Layout

| Margin Call Filker o 4 | | Results |
; 5 Zanfiguration 3 i i i

A & Margin Call Configuration. ..

4l | = | = =l 2 2

Ackion - T
rade ]
[FA prarece naka (Time | I Collateral Context. . I

Here you can configure the system to tag the ‘investment’ allocations (both trade and transfer).

You can name the new attribute with a name that corresponds to the various investment vehicles you are investing
in which from the “Allocation Attributes” tab as seen below.

tributesl Allocation Attributes IDetails | wworkflow | Context Attributes |

_ategory Description Mandatory Mal

ZMargin Call Allocation Attribute E3

Name : IEFZ|

Attribute Tvpe : IBDDIean j

Attribute Category I

Descripkion : I

[+ Propagate ko kbrade
[ Mandatorsy

[~ Mandatory For execukion

Apply Cancel

When performing a collateral substitution, you will need to configure the Allocation Attribute by choosing Data >
Configure Columns, and add the name of the attribute you have configured.

- configure Columns Ed

&l Elernents; Selected Elements:
| O IEF Attribubes, TEFZ
- - Descripkion
-y MarginCallallocationBase
= D d Direckion

E- = Attributes

. kit
... @ [attributes. EF3 Cuanticy

rorminal
Currency
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When ready to perform the substitution tick off the checkbox as seen below.

Allocation - defaulk

o x| el -

IName j I

Descripkion

Marinal

otkributes, IEFZ [ Direction Quankity

50,506,859, 754,25

* Receive

After applying the allocation and pricing the contract all the way to EXECUTED status. This will put a keyword on
the margin call trades.

P Trade Attributes Window

Darnain ...

Marmne Yalue
_iZP ZME
collateralallocation Type Substitution
collateralZategory IEFZ Funds
igeneration by Sllocation Lrige
IEFZ Erue
MargnalContrack Type T
26T
AccountMumber
AFMAPricingZashRate
AFMAPricingSwapRate
AFMAPTicing T
After SettlementCutoffTime ;I

Apply Help Cancel |

This will get both the trade and transfer tagged.

LD

6.4.5 Haircut

Haircuts rules are setup on the Margin Call Contract under the details tab. You will need to create the haircuts
specific to each fund as per the CME website. Using CME’s IEF2 program as an example where there is a
mandatory 3% haircut you would perform the following steps in order to record the haircut values.

To create a haircut you load the relevant CCP facing Margin Call Contract but you must first define an SD filter that
will locate the security position you want to add a haircut to.

ZStatic Data Filter Window [1300075P2,/CLEARING_25,] (User: Bill Spota)

Name:IIEFZ Funds Attributes. Simulate. .,
Cl:umment:l Pending Mod
Gru:uups:l.ﬁ.N"r' |
Attribute Criteria Filker Yaluels)
Product Tvpe IM Add InitizedFund
PRODUCT _CODE, Collateral Invvestment M &dd  ||TRLE
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Then navigate to the details tab, and click Show Haircut:

ZMargin Call Window - ¥ersion - 21 (User: Bill Spota}
Margin Call Config Lkl Help
Edit | Browse |
Marne : ICME IRD Client IH |1543|:|2 |21 Subbype !
Descripkion ICaIypsn_LlS IM, Facing the CME For Client IRD Accounts Parent :
Eligible Securities Eligible Currencies | Concentration | Cipkimization | Child Configurations
Parties Details Diates & Times | Initial Margin | Independent Amourt | Sdditional Infao
ol showlé |  Define 5D |
Position Type THEORETICAL &
Position Date POSITION_DATE_DEFALLT
= Haircut
Haircut Rule IEF
Haircut Type Fegular
Exclude Trade Haircut v -
(Name)
(Descripkion)
e Save Save As Mew Delete
i

It brings up the Haircut Rule Configuration GUI where you enter the PE, SD filter and finally add a haircut value.
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ZHaircut Rule Configuration {User: Bill Spota) =]

Haircut Fule  Help

Marne : IIEF

Definition | Cross Currenc';.fl

~Haircut Paoints

e

Tenar Drate OFFsetI Haircuk

OPEM  [08/07... -1 flo.030...
|

~Details

[~ Criginal Maturiky

Cancel |

Mew Save Save A5 Delete |

You then choose the haircut rule you just saved in the details tab of the Margin Call Contract.

ZMargin Call Window - ¥ersion - 21 (User: Bill Spota)
Margin Call Config Ukl Help
Edit | Browse |
Mame : ICME IRD Client I |1E.43|:|2 |21 Subbype !
Description : ICaIypsn_LlS IM, facing the CME For Client IRD Accounts Parent :
Eligible Securities Eligible Currencies | Concentratian | Cpkinizakian | Child Configurations
Parties Details Dates & Times | Initial Margin | Independent Amaounk | &dditional Info
B By showld | Definesn | [i haw Harcut
Position Tyvpe THEORETICAL -
Pasition Date POSITION_DATE_DEFALLT
El Haircut
Haircut Rule IEF
Haircut Type Regular
Exclude Trade Haircut v -
{(Name)
[Descripkion)
Mew Save Save As Mew Delete
i
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6.4.6  Inclusion in the Sequestered Fund Report

The money invested in the funds should appear in line 8A or 8B at market value, based on the fund attribute “SFR-
8A"” or "SFR-8B".

This information gets pulled from the Margin Call Position Valuation Report: any securities with product code
“Collateral Investment = True” as of previous day’s close of business (T-1) converted to USD based on FX Rate
from quote set.

6.4.7  Configuration for Investing in Treasury Bonds

Imagine an FCM has excess client cash posted as collateral for which they are paying the client a fixed interest
rate. In addition to investing client funds, the FCM can also borrow internally from another funding desk and then
invest it into a non CCP Investment Vehicle (e.g. Government Securities).

Calypso recommends the FCM enter into a BOND transaction where the Counterparty can be Harris Bank or any
other CFTC approved investment vehicle.

Unlike what is described above when creating a UnitizedFund where a new Product_Code: Collateral Investment =
TRUE, the FCM would need to create a new “Bond Collateral Investment” bond product.

This will ensure the bond used to invest into a Harris type investment vehicle will allow the following code changes
to the SFR to work. Essentially, line 7b works off of account attributes instead of a Product Code. Here is a sample
of the Account definition setup along with the respective attributes.

Accounts Definition - Authorization mode OFF Bond Collateral Investments / 147696 - version 0 (User: Bill Spota)

Account  Uklities  Reports  Process  Help

Account Statementsl | | Limitsl Translation,l'Revaluatiunl Bruwse'

Accourt Mame IBDnd Collateral Investments|

Proressing Org Icnwpus j Coy IUSD j Id |14?595
Type ISETTLE "I | [~ Security [ AukojTemplate Acc
External Mame I Ly} | Interface Rule I.ﬁ.ggregate j
Descripkion I
| egal Entity (F2) IHF\RRIS BANK | Role  |agent ~|
Creation Date |9,|'1 113 2:23:37 PM Properties/attributes (F4) |
Enccuunt Attributes Window Bond Collater3
hlaone Wa o
Collakeral Investment krue
Sequesteredfccount Bank.
AccountType

The LE was set to Harris Bank as this is where the Bond cash was settled. Note: You will need to create a Bond
Collateral Investments account for each LE that will be holding the "Real Money Amount" for each Bond purchase
and subsequent SDIs.

Line 7B - From the Inventory Position Report as of previous days close of business (T-1) take all accounts that
have the "SequesteredAccount" attribute set to "BANK" as well as the attribute "Collateral Investment" set to True
and calculate the values of any securities that fall into the aforementioned account criteria converted to USD based
on FX Rate from quote set. The values will be determined by using the CleanVal(MTM) balance type which is the
position quantity multiplied into the security clean price.
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The premise behind the following configuration is to allow Calypso to generate the value of any bond using the
CleanPrice on the Settlement so that your SFR amounts are not overstated.

Within the Inventory Position report, choose Process > Create Balance Type, and create the balance type
“CleanVal(MTM)".

Z Additional Balance Type

InvSecBalanceTvpe

Cleant'al(fTr

== |

Then choose Process > Define Balance Type where you can create the formula to produce the CleanVal(MTM)

balance type which is the position quantity multiplied into the security clean price.

Pusil:iun Type definition : Clean¥al{MTM)

| # Balance
Balance_Unwvailable

= | . Specific walues

FxRate

-} # CleanPrice

~Wariables - Condikions

# Balance_SecurityBorrowed_Auko IF:I Then:I_L
- # Balance_Collateralized_Out :
- # Balance_Collateralized_In - Functions 1
- # Balance_PledgedCut I Insert
- # Balance_PledgedIn
-~ # Balance_RepoTrackingut Dperatars |
- # Balance_RepoTrackingln j I
- # Balance_Trading

Formula

Balance*CleanPrice

Once you are done with the formula click Apply.

- DirkyPrice
B | Composite position bypes
Insert
Position Yalue : | Template Position Yalue j

Check

Apply

Zancel

Then load up the Inventory Position report with the following parameters so that you can see the value of any
settled Bond trade.
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ZlnventoryPusitinn / Bill Test {User: Bill Spota)

Report Data View Export Market Data Process  Utilities  Help

EEIE |
| Criteria 0 x|
Template Description IC\eann Walue Bond Price [~ UseTenar [~ Use Snapshat

Skark |08/21/2013 m 'I End |03/21/2013 m 'I Books ICAL‘(’PUS-C _I ProcessingOrg _I
Position Date Settle VI Aggreqgation AgentjAccount A4 Securities I _I Security Template I j I
Position Class Internal vl Agent [BANK OF AMERICA _I Sec Code IBB_CA‘.. jl ¥ Include Issuances
Position Type  |Actual _I Account Id J SO Filter INONE 'I Agg. Type I jl j

Position Yalue Mominal VI Custom Filter - Initislization Dake  |MOME | [ Display Onky Multiple Agent I Exzplode Position
Position Direction |all 'I [~ COffset, Pos Cash/Sec ISacurity j | Mavement Type Cleanyal{MTM) | o | ™ Filker Zero Balance [¥ Propagate To Cash

I Closing Bal. Node Expansion Level I

Sy

EX

Maovement Type | ProcessingOrg | Product Id | PRODUCT_CODE.ISIN Prd Description Currency Agent Account Position Type || Aug 21, 2013
Cleantal(MTM} 278300|US912828N291 BondT 1 1/4 09/30/15 IEF Investment/SY/09/30/2015/1,25% |USD BANK OF AMERICA |(CALYPUS SEG-CLIENT ACTUAL 0.00;
CleantaliMTM) 6301 |US912826N291 BondT 1 14 09/30/15/5/02(30j2015/1, 25% uso BANK OF AMERICA |CALYPUS SEG-CLIENT-USD  [ACTUAL 7,500,000.00/
Cleantal(MTM) B303|USI12510EX29 BondT 6 i 0815126/ 307 [05] 15] 2026/6, 75% uso BAMNK OF AMERICA |CALYPUS SEG-CLIENT BCTUAL 0.00]

The 7,500,000.00 represents the actual clean value of a settled bond where the calculation takes the Quantity *
CleanPrice. Bond details: Bond purchased with quantity of 5,000,000.00 at a price of 100.00. The closing quote for
the bond is 150.00. So if you multiply 5,000,000.00 * 1.50 you get 7,500,000.00.

You should also setup a formula for dirty price calculations on the Inventory Position report in the same way.
Add and save new balance type

z Additional Balance Type

Cleanval{MTM)
I: Dir by l(THY |

InvSecBalanceTvpe

BEArosition Type definition : Dirty¥al{MTHM)

~Wariables ~ Conditions
- 4 Balance_SecuribylLent_Auto - IF:I Then:|-
- # Balance_sSecuritvBorrowed_Auko
-~ # Balance_Collateralized_Out  Funckions
- # Balance_Collateralized_In I - i [
- # Balance_Pledgediout
- # Balance_PledgedIn [ Operators
- # Balance_RepaTrackingiout I ;I I_L
- 4 Balance_RepoTrackingIn
- 4 Balance_Trading S
| Ealance*DirkwPrice
- 4 Balance_Unvailable

=1 Specific values
- i FrRate
- M CleanPrice —
|. DirkwPrice | -
Inserk
Paosition Yalue : ITempIate Pasition Yalue LI Check Apply Cancel

You also need create the domain "SFR7BMovementType” to control what value of the bond trade you would like to
be displayed on the SFR (i.e. Clean or Dirty) on line 7B. Example:

Elj SFRYEMovementType

L el '’
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6.4.8 Pledge the Bond at the CCP and Populate 8-B

The FCM will buy the bond from the street (reflected in SFR columns 7-a and 7-b) before pledging it to the CME
(reflected in column 8-b).

It is expected that IM Standardization is in place, meaning that we maintain internal and external client position for
IM.

Create new Allocation Attribute ‘InvestmentBonds’ in the Collateral Context windown that will be passed down to
the MarginCall Trade when the bond is allocated. This attribute will be used to drive the SDIs.

B Collateral Context Configuration _ (O] %]

Collateral Context Utl Help

Name : |Eon_coLLaTERAL_coNTEXT [1005 [61 I™ Default

Description : | [5.2.6-14.0.0.22.5P2-with-1400

Product Definition | Position Definition | Currency Definition | Entry Attributes Allocation Attributes | Workflow | Pricing] Context Attributes|

Rk = t 3 & 3
Name Type Category Description Mandatory Mandatory For Execu... Propagate

CCPSettlementType  |String r r I

FPRODUCT_TYFE String v

CCP String r I =

InvestmentBonds Boolean =

New | Save | Save As | Delete | Close |
Allocate Bond and tick attribute to true.
P! Collateral Allocation: FCM [1400225P2/V140TC/] (o] x]
Alocation Window Ut
< Apply C\ose‘ & optimize +| ™ Substitution Mode
Security Position Browser a8
Processing Org [PO1 =l
Position | | Processingorg | Book | Product 1d | ProDUCT_copE.ISI | Prd Description curency | Agent | Account | Position Type [ oct 5,
Books [ = [Fox PO1_CLIENT_CLEARING@CME 25401 BondCollatinvT EST/10Y/01/13/2025/3% |USD HARRIS BANK |T-Bond Collateral Investment@CME | THEORETICAL a
Security FOL PO1_CLIENT_CLEARING@CME 29401 BondCollatnvTEST/10Y/01/13/2025/3% |USD POL T-8ond Collateral Investment@CME _|THEORETICAL
- All_Bonds POL |PO1_CLIENT_CLEARING@CMF | 29401/ |BondCollatinvTEST/10Y/01/13/2025/3% |USD |HARRIS BANK_|PO1-USD-SECURITY-NOSTRO-CLIENT |THEORETICAL |
POL |PO1_CLIENT_CLEARING@CMF | 29401 [BondCollatinvTEST/10Y/01/13/2025/3% |USD POL (CPTY1_CASH_SEC_USD@POL [THEORETICAL | =
4 Pﬂi P01 _CITENT I FARTNGACME | 20401/ [RondCallat T TFST/ANY/N1 /13/20175/3% 115N HARRTS RANK \Rnrld Cnllataral Tnvestmants ITHENRFTICAL | ’_I
Loa q >
X5 security | 20" Cash | 3= Collateral Pool
Allocation - default El
2 5| W - |[Neme =T =l 23 EE Report + [ Data - 2 View -
Description | irection | qQuantity [ Nominal (Current) | currency [ Price | Accrual | Value | FxRate | Haircut | Book | Trade Date | Settlement Date | Attributs |
BondCollatInvTEST/10Y/01/13/2025/3% |~ Pay | 0.00] 0.00[USD | il o 0.00 1.00 0~ POL_CLIENT_CLEARING@CME _|10/07/2016 _|10/07/2016 ~V |
Total 1

49 Allocation ‘i% Netted Pusmuns"ii Pending SuhsutuuunsJID summary“t.% Concentration Limits “er Concentration Husturyﬂ‘}‘ Netted AHucaUUHJ

calypso_user |[Fem Il | Po1_cme_cuent I I || © Allocation: AtLocaTED
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& Margin Call SecurityTransfer(BondCollatInvTEST/10Y/01/13/2025/3%) -PO is CMF_1... [l[=] 3

Margin Call SecurityTransfer(BondCollatinvTEST/10Y/01/13/2025/3%) -POis CMF_1-US (:

foscve]

EETER S T

~

[ Trade Atiributes Window

ricingCashRat

ingTM

ftoffTime

On PO Side, this SWIFT PAY SDI should be used to debit Nostro Security account
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[ settlement Delivery Instructions [1400225P2/V140TC/]

EE— '

- A
TE— R —
R T

i
B

The Direct account set up with CME should have account attribute ‘Collateral Investment’ set to true
(SequesteredAccount should be null)

B Accounts Definition - Authorization mode OFF T-Bond Collateral Investment@CME / 1550... l_l_l_

B Account Attributes Window T-Bond Collateral Investm... |3

Similarly to SFR 7b, it is possible to configure the position type to be displayed by Clean or Dirty price. The system
will re-use the same configurable balance type set up for 7b and look up a new domain SFR8BMovementType set to
CleanVal(MTM) or DirtyVal(MTM) depending on the position type to be displayed.
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P Domain Values Window _ O] x|

Search: Isfr Find ||_ Value :

-] settlemethodKWRestricted :I Name: IiFRBBthementType
- SFR7BMovementType

- SFR7CBookType Value: |

-4 SFR7CMovementType
- ] SRS s

-4 CleanVal(MTM)

-4 showProductMapper << Add | Save Abo...
¥l SimpleMM.Pricer

- SimpleMM.subtype > ReM... |
[alila== T IR DR, Y S,

The Position is sourced from the Inventory position based on following criteria:

Position Date: Settle

Position Class: Internal

Position Type: Actual

Position Value: Nominal

Cash/Sec: Security

MovementType: CleanVal(MTM) or DirtyVal(MTM) if specified in above domain value, else defaulted to Balance

Sum of values will be converted to USD
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Section 7. ERS Limits

In order for the trades to go through limits checking, you need to perform the following configurations.

7.1 Trade Filters

You need to create trade filters for the trades for which you want to check limits using Configuration > Filters >
Trade Filter from the Calypso Navigator.

For example:

Hame |CME-2AAR Time fone | HONE - |
Comment Holidays |
[_] Check Holidays
] Use SOL | Generate SQL | Parent | HOME - |

[_] Cache trades on load [_] Set as default parent

Post Processing |/ Position Spec |/ Counterparty r Fund r Diary Criteria |
‘ Ranges |/ Date / Time |/ Product Criteria |/Trade Criteria r Underhing Security |/ Custom Criteria

W] BUY [¥] SELL

Internal Reference [v] IN | |

Bundie| [~ -]

Bundie Attribute | -

Book [ IN

Trader [v] IN

Status [v] IN EMT GRANTED CREDIT_CONSENTED, LIMIT_FAILED VERIFIED

Book Attribnte

|- ]
|- |
-]
Sales [v|IN | |
|- ]
e |

Keyword Value CCP Like [CWE], CCPACcountReference Like [A888] [S_CLIEMT Like [true]

7.2 Market Risk Hierarchy

You need to define a market risk hierarchy. Market risk hierarchies are created using ERS Risk.

Bring up ERS Risk and click Admin in the upper right-hand corner.
Then select the Hierarchy Editor.
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/= Enterprise Risk Service - Calypso - Windows Internet Explorer - |EI|5|
@1—-_: L Id http: ffsfperf3 1. calypso.com: 8280 risk/ j |E| |E| Iﬁ Google |P '|

.7 Favorites _A Enterprise Risk Service - Calypso | |

A caLypso Admin Mode

—— QO | e | v

Hierarchy Editor |  Batch Editor Risk Attribution Editor Jab Viewer Management Consale

| InitialMarginLimit =15 mew. |

Delete | Save As... |
= TritialMarginLimit *3 Rename ~ Portfolio J~
= CME-AAAA #3 Add 000_Test
"= CME-BBBE #3 Remove 00 CME MARGIM Bheem
W= LCH-GIGACALP_FUND3 3 Cut: 1
"= CME-CCC ‘E: Pante 400
W= CME_DUMMY | = 40081
AAAA
Alec CME
<< Alec Swaps
s ALL

All CME Today Futures And Options
Create a hierarchy as needed, and add nodes. The nodes correspond to Trade Filters.

If the trade filter contains a book, then the trade filter is used to select the trades. Otherwise, the system selects
the trades for which the trade keyword LIMIT_WHATIF_PORTFOLIO is the node name.

[NOTE: Each node name must be the same as a Trade Filter]

Please refer to the Calypso ERS Risk User Guide for details on using this window.

7.3 Pre-Deal Limit Configuration

Make sure that the product types for which you want to check limits are defined in domain “limit.products”.

7.4 Limits Configuration

Bring up ERS Limits, and define limits for the hierarchy you have created under Limits > View / Edit.

Select the hierarchy you have created, and click Load.
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Type: Market Risk

== g | InitialMarginLirnit

LE Dashboard
Violations
Adjustments
Expiry

Frozen

Then click New in the upper right-hand corner, and select a measure you want to check limits against.

You can then define the limit amounts.

|Ma'ketR§sk ~ InitiaMarginLimit (CME-AAAL) |

g9
IConh’nuous = IOJSD} =l IPredeaI Included = | IAII =
severity [1 x| warning Level [80% =] [25-Au0-2012 = FENWEETE . d

Limit Effective Date Expiry Date

- 1000000 29-Aug-2012 29-Aug-2013
: :

Adjustments 150,000,000 16-Aug-2012 16-Aug-2013

Excpiry 150,000,000 16-Aug-2012 165-Aug-2013
Once you have defined limits, you need to authorize them before they become effective.

Please refer to the Calypso ERS Limits User Guide for details on using these windows.

7.5 Limits Checking

The EOD limits usage is computed using the scheduled task ERS_ANALYSIS for the ERS batch process that runs the
Sim analysis on the market risk hierarchy.

You can create an ERS batch process under in ERS Risk under Admin > Batch Editor as in the example below.
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Hierarchy Editor Batch Editor | Risk Attribution Editor Job Viewer Management Conzole
|IniﬁalMarginLimit =| 14 Mew | Delete I Save As...
|CME AAAA ;I W v Analysis Forifolo Target Type Parameter Set
OTCMarginReport CME-AAAA Portfolio TYPED
ey I OTCMarginReport CME-BEEB Portfolic  TYPED
|sim =l OTCMarginReport CME-CCC Portfolo  TYPED
[cme_m I~ OTCMarginReport LCH-GIGACALP_FUND3 Portfolio  TYREH
ICME ;I Sim CME-AAAA Portfolio CME
Sim CME-BEEE Portfolio CME
r Sim CME-CCC Portfolio CME
- Sim LCH-GIGACALP_FUND3 Fortfolio LCH
(=] Add

The scheduled task ERS_ANALYSIS should be run at the end of the day on this batch process, after all other

clearing activity is completed.

Sample setup:

Task Type

Ex=ternal Reference |IZI?. - CWE and LCH IM Batch for ERS

Description |

Attempts |1

Retry after, In Minutes |0

Memory Settings  Min Memory @ m  Max Memorny (1024

Allow Task To | Send Emails [_] Publish Business Events

Batch Mame

Wizt

ERE Services URL
|5 Live

Initialbdarginlimmit
falze \

true

The batch process is set in the Batch Name attribute.

When trades are received from the CCP, they go through the limits checking using the workflow rule

CheckWhatIfLimits.

The following trade keywords are populated:

Trade Keywords

Description

LIMIT_WHATIF_CHECK_PASS

Displays Y if the What-If analysis returns a usage value that does not
violate the defined Market Risk Limit. It displays N otherwise.

LIMIT_WHATIF_LIMIT_MAX

Displays the maximum limit defined for the Market Risk Limit.

LIMIT_WHATIF_RISK_USAGE

Displays the usage value of the What-If analysis results.

LIMIT_WHATIF_CHECK_ERROR

otherwise.

Displays Y if there is an error while checking the limits, or N (or empty)
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Trade Keywords

Description

LIMIT_WHATIF_CHECK_ERROR_MSG

Displays an error message when LIMIT_WHATIF_CHECK_ERROR=Y.

LIMIT_WHATIF_PORTFOLIO

ERS Limits portfolio.
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Section 8. Clearing Fees

The following types of clearing fees can be setup in the system.

Clearing Member

The CCP charges commissions on the trades to the clearing member on a periodic basis, and the clearing member
charges those commissions to the clients immediately.

The clearing member may also charge execution fees on the trades to the clients immediately.

The CCP also charges maintenance fees on the accounts to the clearing member on a periodic basis, and the
clearing member charges those maintenance fees to the clients on a periodic basis as well.

Immediate trade fees, periodic trade fees, and account fees require a different setup.
Note on Swap Residual Maturity for Transaction Fees and Maintenance Fees
[NOTE: This only applies to version 14.4 of Core Calypso, and above]

By default, the swap residual maturity is computed as:

Swap residual maturity = MAX(CCPClearedDate,StartDate) - End Date

You can change the behavior by adding the CCP name to the following domains:

e “TransactionAdjustedEndDate” for Transactions fees - The end date is adjusted based on the Date Roll
convention if it falls on a holiday (applies to LCH).

e “TransactionStartDate” for Transaction fees — The start date is CCPClearedDate (applies to LCH).

e “MaintenanceAdjustedEndDate” for Maintenance fees - The end date is adjusted based on the Date Roll
convention if it falls on a holiday (applies to LCH).

e  “MaintenanceOriginalClearDate” for Maintenance fees — The start date is CCPOriginalClearedDate for
netted trades (applies to LCH).

e  “MaintenanceStartDate” for Maintenance fees — The start date is CCPClearedDate (applies to LCH and
CME).

8.1 Clearing Member Commissions and Execution Fees

The clearing member charges commissions and execution fees on the trades to the clients immediately.

They are computed on the trades using the AutomaticFees workflow rule, which should be set on the workflow
transitions once the trade is cleared: CLEARED - ENRICH - VERIFIED, VERIFIED - UPDATE - VERIFIED, etc.

See Trade Workflows for complete details on the trade workflow.
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From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Definition to

define the fee types, for example COMMISSION_FEE and EXECUTION_FEE.

Z Fee Definition (User: calypso_user)

Type : ICDMMISSIDN_FEE
Role : ICnunterPartg.-' j
Fee Offset : ID— Cal
Products : IALL
Default Calculator : IFEEGrid j
Include : [V Pricing W Accounting [~ Allocation
[ Transfer [T Settlement Amount
Comment : CMF//Client Commissions
Fee Type Pricing Tralsﬁar Role Accounting Setﬂeimnunﬂ
EXECUTION_FEE v [+ CounterParty ¥ r

COMMISSION_FEE

8.1.2 Fee Grids

jv]

CounterParty

jv]

The Fee Grid is just a link to the Fee Config window where you can define the actual fee amounts. You need to

define one fee grid for each fee type.

You can use a static data filter to restrict the application of the fees.

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Grid.
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z Fee Grid Window - Version - 0 (User: calypso_user)

Trade Fee Grid | Billing Grid I Browse I

Grid1d | 65681 I~ Round Turn
Processing Org IALL J Wl R
Legal Entity IALL J F‘.oleICounterParty' j
Fee Type ICDMMISSIDN_FEE ~|  soFiter ICpty Not CME _|
valid from | valid to |

Exchange IALL J
Products ISwap J Cey IANY J
Security | _I Lag |n IBus leD_CHANGE |

— Fee Details

Amount | 0 Attributes ... |

Description ICI"«"IF [ Client Commissions

Min Amount, ID Max Amount. |0 Calculator| FeeConfig j

The Calculator must be set to “FeeConfig”.

You also need to set the following attributes:

e TRADE_DATE_TYPE should be set to "CLEARED DATE” so that the fee will settle on the cleared date set in
the trade keyword CCPClearedDate.

e ZeroAmount should be set to “false” so that the system will not generate any fees with 0 amount.

I Fee Grid Attributes Window

Marmne Yalue
RELATED_FEE
TRADE_DATE_TYPE CLEARED DATE
Zerofmount False

8.1.3 Fee Configs

You need to define one fee config for each fee type.
Note that for trade fees, the config type must always be set to “Trade Fee”.
From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Config.

Commission fees as specified below will be computed based on the trade notional. Depending on the trade’s
maturity we will apply x USD per million notional. E.g. for a 10 million trade maturing in 6 month: commission =
10*2 = 20 USD.
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Z FeeConfigWindow !E

Menu

B 4d RO x

Edit | Browsel

References Farmula
Zonfig ID 32515 ; .
Mame Commission fees J —'JIL Add d? Edit | _x Delete
EE:;FEVL?B ;;TS;EFBE 1¥lin Ak I Mz ik I Min Tenar Mz Tenor Formula Zalc Unit
Scale By Mational 0 o 0D 1% UnitNaotional*2 1,000,000
Event Typs Trade u] o 1Y Y Unithotional*s 1,000,000
Fee Currency uso o InitMotional*3 1,000,000
Effective From o UnitMokional*12 1,000,000
Effeckive To o UnitMotional* 16 1,000,000
Deescription S5GM = CPTY 0 Unithotional*z0 1,000,000

0 UnitMokional*25 1,000,000

Filters 0 InitMational*30 1,000,000
ProcessingCrg S9GM LLC 0 nikMokional* 35 1,000,000
Leqgal Entity CFTVE
Role CounterParty
Fee Type COMMISSION_FEE

Sample formula definition.

Formula Definition »
Ranges
Min Arnounk ]
Max Armounk o
Min Tenar [n]n]
Max Tenor 1y
Calc Lnit 1,000,000
Formula
[uritrictional*2
Yariables Operators
LInitMational R i’
Motional Il
uankity +
ConkrackSize ;I - ;I
o4 | Cancel |

8.2 CCP Commissions and Maintenance Fees

The following periodic fees can be setup:

e The CCP charges commissions on the trades to the clearing member on a periodic basis — Example
CME_COMMISSION_FEE.

e The CCP charges maintenance fees on the accounts to the clearing member on a periodic basis - Example
CME_MAINTENANCE_FEE.

e The clearing member charges maintenance fees on the accounts to the clients on a periodic basis -

Example MAINTENANCE_FEE.
They are computed by the Billing engine based on billing grids and billing rules.

The fee types that you want to compute on a periodic bases must be defined in the domain BillingFeeType.
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=) BilingFeeType
E # CME_COMMISSION_FEE

8.2.1  Billing Grids

The Billing Grid is a onetime configuration that should be as generic as possible. At least one billing grid is needed
by billing event (trade, transfer, message, MaintenanceTrade, Account). The idea here is to link the fee calculation
to the Fee Config window (via the calculator), and determine what date type should be used to generate the fee
billing entry.

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Grid to define
billing grids.

Billing Grid for Trade Events
z Fee Grid Window (User: calypso_user)

Trade Fee Grid  Billing Grid | Browse |

Grid 1d | Account IALL

Processing Crg IALL Cey IANY

Legal Entity IALL Raole ICDunterParty'

Ldle L -

Event Type ITradE Fee Value Date ITradeclearEdDate

[+ Ll ] Ll

SD Filter |
Valid from | valid to |
Description ICu:ummissions
Calculator IFEECDI‘lﬁg j Add | Remove
[~ Use Multiple Calculators
Billing Calculators
1d Type StaticDataFilter | AmountType | Currency | Description | RefDateTime | TimeZone | StartT

0BilingFeeConfigCalculator AMOUNT MOME

e Role = CounterParty
e Fee Value Date = TradeClearedDate

e  Calculator = FeeConfig

Billing Grid for Trade Rebate Events
This billing grid only applies if a rebate is defined in the Fee Config.
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B Fee Grid Window - Version - 2

Trade Fee arid  Biling Grid I Bromwse |

Grid 1d | 32545 Account I.D.LL |
Processing Org ISSGM LLC | Coy |mw |
Legal Entity IF\LL | Raole ICDunterPartv j
Event Tyvpe ITral:Ie j Fee Value Date ITradeCIearedDate j
SO Filker | |

Yalid Froml Yalid to I

Descripkion IBiIIing Trade Fee Rebates ALL

Calculatar ITradeFeeRebate j Add | Remawve

[ Use Multiple Calculatars

Billing Calculators

Type StaticDataFilker | AmountType | Currency | Description | RefDateTime | TimeZon
43 BillingTradeFeeR ebateCalculator AMOLNT MOMNE

e Role = CounterParty
e Fee Value Date = TradeClearedDate
e  Calculator = TradeFeeRebate

Billing Grid for Maintenance Trade Events

This billing grid will apply for ALL counterparties on MaintenanceTrade billing events, in our case
MAINTENANCE_FEE and CME_ MAINTENANCE_FEE. Note that “date” should be set to “CustomDate” since the
billing frequency is determined on the Fee Config.

z Fee Grid Window (User: calypso_user)

Trade Fee Grid Biling Grid | Browse |

Grid Id | Account IALL

Processing Crg IALL Coy IANY

Legal Entity IALL Role ICDunterParty

Event Type IMaintenanceTrade

Ll e -

Fee Value Date ICusb:mDate

BRI ERJEEI

D Filter |
valid from | valid to |
Description IMaintenance Fees
Calculator IFeeCu:unﬁg j Add | Remove
[~ Use Multiple Calculators
Biling Calculators
Id Type StaticDataFilter | AmountType | Currency | Description | RefDateTime | TimeZone | StartT

0 BilingFeeConfigCalculator AMOUNT MOME

e Role = CounterParty
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e Fee Value Date = CustomDate

e  Calculator = FeeConfig

8.2.2  Billing Rules

The Billing Rule determines the billing period, settle date, billing currency of the billing trade on which the billing
fee entry will be generated. It is also possible to default certain billing trade entries such as the book and transfer

type.
You need to define one billing rule per fee type.

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Billing Rule to
define billing rules.

CONTRACT REBATE

This config will apply for ALL counterparties in case a rebate applies.

Note that the attributes BillingOnly and EntryType are mandatory. BillingOnly should always be set to true and
EntryType to the corresponding fee type.

P Fee Billing Rule Window - Version - 4

Edit | Browse |

= 1d | 32561 <D Filker |

Legal Entity IF'-LL | Effective To I

[
Processing Org ISSGM LLC j Role ICDunterF‘arty j
[

Effective Fram I Billing Ccy IUSD
Biling Asset Type [NEXT_BILLING DATE | Holidays | NYC
Billing Date Rule | EOMCAL ... | Sett, Date Rule | EOM-+1BUS
adjust, Days I 0 [ Bus. Days Billing Asset Threshold IIII

Billing Threshald ID Input Date Type ITradeDate j

N | Celete Save | Savedshlen | L Add Attributes

|E| Defaults Trade Billing Yalues
Bk, Bundle Kawdfgent wFerTyvpe
IBILLING_BDDK ¥ | L | ¥ IREBF'.TE ~|

I Attributes Window

Mame Yalue
Billingonky krue
CrefaulkBook, BILLIMG_ Bk
CefaulkTransferType REEATE
EntryType CONTRACT REBATE
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MAINTENANCE_FEE

You can select a given client (counterparty) as needed.

B Fee Billing Rule Window - Version - 2

Edit | Erowse I

= 1d | 32559 SD Filker |

Leqal Enkiky ICF‘W B | Effective To I

[
Processing Crg ISSGM LLZ j Role IC:::unterF‘artw;.-' j
[

Effective From I Billing Ccy IUED
Biling Asset Type [NEXT_BILLING_DATE | Holidays | NYC
Biling Date Rule | EOM CAL _I Sett, Date Rule | EOM-+1BLIS
adjust, Days 0 [ Bus Days Billing Asset Threshold IIII
Billing Threshald IEI Input Date Type ITradeDate j
Mew | Delete | Save | Savehshlew | | __]-!. &dd Attributes |

|E| Defaulks Trade Eilling Yalues

| Bk, Bundle Kindfaent HFerTyvpe

||BILLING_BODK | | IM.ﬁ.INTEN.ﬁ.NCE |

[ Attributes Window

Darnain

Marme Walue
BillingCnly krie
DefaultBook, BILLIMG_ Bk
DefaultTransfer Type MAIMTERAMCE
EntryTvpe MAIMTEMAMCE_FEE

CME_MAINTENANCE_FEE

This rule will only apply for maintenance fees that will be charged from the CCP (CME in this example).
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I Fee Billing Rule Window - Version - 5

Edit | Erowse I

=] d | 32562 S0 Filter |

Leqal Entiky ICME | Effective To I

[
Processing Org ISSGM LLC j Raole ICDunterF‘arty j
[

Effective From | Billing Ccy |LISD
Eillng Asset Type INEXT_BILLING_DF'.TE | Holidays | MY C
Billng Date Rule | EOM CAL _| Sett, Date Rule | EOM+1BUS
adjust, Days I—I:I [T Bus. Days Billing Asset Threshaold IIII
Billing Threshald ID Input Date Tvpe ITradeDate j
M | Delete | Save | Savehshlew | | __J-L fdd Aktribubes |

|E| Cefaults Trade Billing Yalues
| Book, Bundle Kwdfgent nherType

||E=ILLII"-.IG_BOOK | | ICME_MF'.INTENF'.... j

I Attributes Window

Marne Walue
Billirgonlky krue
DefaulkBook, BILLIMG Bk
DefaulkTransferType CME_MAIMTEMARCE
EntryType CME_MAINTENANCE_FEE
wferByBook, False

CME_COMMISSION_FEE

This rule is for CME only since the commissions charged by the clearing member are charged directly on the trades.
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B Fee Billing Rule Window - Version - 0

Edit | Eiru:uwsel

=] 1d | 32563 SD Filter |

Leqal Enkiky ICME | Effective To I

[
Processing Crg ISSGM LLZ j Raole= IC-:uunterF'arI:}.-' j
[

Effective From I Billing Ccy IUSD
Biling Asset Type [HEXT_BILLING_DATE | Holdays | MYC
Biling Date Rule | EOMCAL ... | Sett, Dats Rule | EOM-+1BUS
adjust, Days I 0 [ Bus. Days Billing Asset Threshold IIZI

Billing Threshald ID Input Date Type ITradeDate j

Mew | Delete Save | Savedshew | __]-!. &dd Attributes

|E| Defaulks Trade Eilling Yalues
Book, Bundle Kwdigent nfetTwpe
IBILLING_BOOK L | __,-L | ¥ ICME_CDMMISSION |

I Attributes Window

Marne Yalue
Billirugionky krue
DrefaulkBook, BILLIMNG Bk
DefaulkTransfer Type CME_COMMISSION
EntryType CME_COMMISSION_FEE
wferByBook, False

8.2.3 Fee Configs

You need to define one fee config for each type of fee. The billing rule is linked to the fee config via the attribute
EntryType.

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Config to
define fee configs.

MAINTENANCE_FEE

Maintenance fees are generated on account balances.
On the account for which you want to generate the fees, you need to check the Billing checkbox.

Maintenance fees are triggered by the event MaintenanceTrade which is generated by the scheduled task
ACCOUNT_BILLING.

NOTE: You can set the legal entity attribute WAIVE FIRST to true to waive the first billing fee.
Scheduled task ACCOUNT_BILLING:
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I Scheduled Task Window [1110045P5/ssgmtest/matthieu_calypso]

Report Tools  Help
Definition | Report |

7 Tvpe IF\CCOUNT_BILLING Descripkion I

Trade Filter IF\LL Pricirg Ens I

User Ical\;pso_user Filter Set I

Measures I

= [ 11

[

[

[
Time Zone ILIS;'Eastern j Exec Timel H I
Frarm Days ID To IEI

Holidays |ch _| Undo Timel H | M

[~ SkipExec  Cukdff [0 Hour ID I¥lin

7 Exerut
Attributes e

Waluation Tirnal 1z H | oM

Atkribote Yalue [~ Publish
ACCOUMT MNAME
LEGAL_ENTITY et
SO_FILTER
CHECE FEE COMFIG True
PROCESS Maintenance Trade

Fee Config:

B FeeConfigWindow

Menu

B v 4 HE e x

Edit | Brawse |

References Formula
Config ID 32578 ; :
Mame Maintenance Fees J _-}I~ Add | g Edic | _x Delete
EEEIEYE;DB E:!:;gt;fnce i Ak | ax Ak Min Tenar I Max Tenar
Scale By Motional o ooE0D 0¥
Tiered
Event Type MaintenanceTrade
Fee Currency
Effective From
Effective To
Description S55GM -= CPTY
Filkets
ProcessingCOrg 556GM LLC
Legal Entity CPTY B ‘ ‘
Rale i
Biling Fee Type MAIMTENANCE_FEE
Exchange
Product Tvpe Swap
Security 1D
EBook
Book Atk
Currency
Account ID
Fee Date QUARTERLY

e Config Type = Billing Fee
e Rule Type = Maintenance

e Event Type = MaintranceTrade
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e Billing Fee Type = EntryType set on Billing Rule = Billing fee type

e Fee Date = Fee frequency

Sample formula

Formula Definition X

Ranges

Min Arnaunk ]

Max Armounk oo

Min Tenar oo

Max Tenor S0y

Calc Linik 1,000,000
Farmula

frmm 100, M1, P*URiENGtonaly)

Variables Qperators

IInitMokional - * ﬂ
Mokional !

Period +

Caankiky j - LI

Ik | Zancel |

CME_MAINTENANCE_FEE
Similar setup to MAINTENANCE_FEE.

B FeeConfigWindow

Menu

BY & d A %0 x

Edit | Browse |

Clearing Member Setup Guide

References Formula
Config ID 32575 ; .
Marne CME Maintenance Fees J L Add | o7 Edt | Lx Delste
Eonﬁg Tvpe B|II|!1g Fee i &rnk | Max Ak | Min Tenaor I Max Tenar I Farmula
ule Type Maintenance =
Scale By Mational 1} co 0D S0y -ABS{MING100, MAX(1, 1*UnitMotional)))
Tiered I
Event Tvpe MaintenanceTrade
Fee Currency
Effective From
Effective To
Description CME - 55GM
Filkers
ProcessingCrg S5GM LLC
Legal Entity CME
Role CounterParty
Billing Fes Type CME_MAINTENANCE _FEE
Exchange
Product Type Swap
Security ID
Book
Book Akt
Currency
Account ID
Fee Date QUARTERLY
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CME_COMMISSION_FEE

This fee is generated by the Billing engine based on trade events.

B FeeConfigWindow

Menu
B 4 HdE e x
Edit | Erawse |
References Formula
Config ID 32565 . _ :
Marne CME Cammission Fees J b Add | g Edit | _x Delete
Canfig Type Billing F
SRk fing Fes i At I Mazx Ak | Min Tenar I Max Tenar | Farmula
Rule Type olums 1] (18] 1% ABS{nithational*2
Scale By Makional = -ABS( nitiotiona )
Tiered i} o 1Y 3 -AB5(Unithotional*s)
- il i i
Event Type Trade 0 oo FY &Y F\BS(Un?tNot?ona:*g)
Fee Currency LSO 0 w BY ay —ABS(Un!tNot!ona 123
Effactive From 0 oo Y 12 -ABS{UnitMotional*16)
Effective To i oo 124 164 -ABS{Unithotional*20)
- il i 4
Description CME - S5CM 0 w 16Y 21% ABS{UnitMotional*25)
1] o 21 26Y -ABS{Unithotional*30)
Filkers 0 oo 28Y ABS(UnitNotional*35)
ProcessingOrg S5GM LLC
Leqgal Entity CME
Rale CounkerParty
Biling Fee Type CME_COMMISSION_FEE

8.2.4  Billing Trades

The Billing engine is used to create the billing fees.
It must subscribe to the following events:

e PSEventTrade

e  PSEventAccountBilling

. PSEventMaintenanceTrade

Version 14.0+

Make sure that the Billing engine is set in the parameter “engines.startup” of *<calypso
home>/deploy/EngineStartupConfig.properties”:

engines.startup=TransferEngine,MessageEngine, InventoryEngine, AccountingEngine, Liquidat
ionEngine, PositionEngine, TaskEngine,LifeCycleEngine,BillingEngine

You can start the Billing engine as part of the Engine server using "<calypso
home>/startEngineserver.bat" on Windows platforms, or "<calypso home>/startEngineserver.sh" on
*nix platforms.

Version 14.1+

The Billing engine is configured in the Engine Manager of Web Admin: event subscription and engine parameters.
You may need to add this engine if it is not available for configuration: Create a new engine called BillingEngine,
with class hame com.calypso.engine.billing.BillingEngine.

The Billing engine can be started from the Engine Manager in Web Admin.

Please refer to Calypso Web Admin documentation for complete details.
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Sample CME_COMMISSION_FEE

I Billing(-900.00 USD) -PO is State Street Global Markets LLC (60894) - Version : 0 Mod User :(a... [l [m] %

Trade Back Office  Biling  Analybics  Pricing Ene Market Daka  Ublities  Help  Templake

Trade I Detailsl Feesl Billing Feesl

To ICME | CounterParty BDUkIBILLING_BO... vl Statusl'u'ERIFIED IID j|50394

From | | FrocessingOrg  Trade Date |n4jn1;2011 |11:43:44 &M Settle Date |05;0212|:|11
Start Date Inﬁmjznu End Date |D4,|'30,|'2E|11

Pay Transfer Type ICME_COMMISSION | Account 1d| 3138|:|| CPTYB@CME

Fee Eilling Id | 32363
Principal | 200,00 Cry ILISD v| Template  [NOE ~]

Adiustment | 0.00

Trade | Details | Fees Biling Fees

Legal Entkity |CME |CnuntarF'arty
Biling Event | Billing Grid
Date Walue Date armount Type amount | Currency | Converted Amounk | M
4/06/2011 |04/06/2011 |CME_COMMISSION_FEE | (900.00)UsSD (900, 00)

As more trades are entered into the system, more billing fees are added to the same billing trades.

Trade | Details | Fees EBiling Fees

Legal Entiky |CI'~'1E |CULII'ItEf'PHf't'p'
Biling Event | Billng Grid
Date Walue Date Amount Type Amount | Currency | Converted Amount
04/06/2011 |04/06/2011 |CME_COMMISSION_FEE {900.00) USD (900,00)
04/08/2011 |04/08/2011 |CME_COMMISSION_FEE | (1,100.00)USD (1,100.00)

Sample MAINTENANCE_FEE
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I Billing(B5.00 USD) -PO is State Street Global Markets LLC (60890) - Version : 1 Mod User : (ad... [j[m] B

Trade Back Office  Biling  Analytics  Pricing Ene Market Data  Utilikies  Help  Template

Trade I Detailsl Feesl Billing Feesl

From ICF‘T\"B | CounterParty BDDkIBILLING_BO... | status I'u'ERIFIED IID jlauagn

To | | Processingorg Trade Date II:I.'-",fI:Il,I'ZI:Ill |11:2?:1F" A Settle Date IDS,I'EII,I'ZDII
Skart Dake II:IF",I'I:IIII'ZEIII End Date ID?,I'SI,I'ZDII

Recsive Transfer Type IMAINTENF\NCE | Account Td | 31378 | CPTYB@SSEM

Fee Biling Id I 32559
Principal | &5.00 CWIUSD 'l Template INONE j

Adiustment | 0.00

Trade I Dekails I Fees Eiling Fees

Leqal Entiky ICME ICDunterF‘arty
Billing Event | Billirg tarid
Date YWalue Date arnount Type Amount | Currency | Converted Amounkt
07/06/2011 |07f06f2011 |MAIMNTEMAMCE_FEE 30,00|USD 30,00
07/08/2011 |07f0gf2011 MAINTEMAMCE_FEE 55.00|USD 55,00

Rebate Process

In case a rebate is configured on the Fee Config, rebate entries are generated using the EOD_REBATE_FEE
scheduled task.

The rebate process adjusts the fee rate based on all the events of the billing period (Default rebate type), or
applies a discount based on the total fee amount and the discount schedule (Discount rebate type).

The EOD_REBATE_FEE scheduled task must be run daily. It retrieves the billing trades for which the end date falls
on the scheduled task valuation date.

The system creates new billing entries of type REBATE to book the difference between the billing fee amount
originally computed, and the billing fee amount computed at the end of the period, once the actual fee rate is
known / discount is applied. There is one REBATE billing entry per trading book.
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ow [12010(

A Scheduled Task Wind

Report Tools  Help

Definition F‘.epcrtl

Type -EDD_F‘.EBATE_FEE - | Description | Compute rebate of BILLING fees
Trade Filter |SWAP TRADES - Pricing Env | default -
User | calypso_user - Filter Set -
Measures E
Time Zone | America/Mew_York - Exec Time H M
From Days |0 To 0 Valuation Time 12| H oM
Holidays E UIndao Time H 1
[] skip Exec  CutOff |0 Hour |0 Min
E te
Attributes el
Attribute Value ["] Publish
Contract Fee + Falze Comment
APPLY ACTION * ALTHORIZE
LegalEntity
r B
‘4 Enter Val Date and ... ﬂ
Val Date 03/31/2012|
Val Time 12:00:00 FM

Scheduling Engine|/| Fun locally

K ] [ Annuler

b

Refer to Calypso Fees documentation for details on using these windows.

8.3 Initial Margin Fees

The CCPs charge fees on the initial margin requirements.

Billing events are generated by the scheduled task CLEARING_BILLING based on account positions. The Billing
engine subscribes to the billing events to generate the fees (billing trades) based on billing grids and fee billing
rules.

The Billing Grid calculator “InitialMarginFee” computes fees of type IM_BASED_FEE, on a periodic basis, using the
scheduled task CLEARING_BILLING and the Billing engine.

The scheduled task CLEARING_BILLING will only process accounts for which the Billing checkbox is checked.
Make sure that you add IM_BASED_FEE to the domain “BillingFeeType”.
You also need to add BillingInitialMarginFeeCalculator to the domain “billingCalculator”.

Setup details are described in the following sections.
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8.3.1  Billing Grid

Choose Main Entry > Configuration > Fees, Haircuts, & Margin Calls > Fee Grid, and select the Billing Grid
panel to define billing grids.

ZFEE Grid Window - ¥ersion - 0 {User: calypso_user)

Trade Fee Grid Billing Grid I Erowse I

sid1
Processing Crg I.ﬁ.LL | Coy ILISD |

|

Legal Enkity I.C'.LL _l Role ICDunterF‘arty -
Ewvent Tvpe I.ﬁ.ccnunt j Fee Yalue Date ICustDmDate j
5D Filker ILCH IRD by keyword _|
walid From |n1j|31j2012 Yalid to |12131j2m?

Descripkion ILCH IRD Daily IM Based Fee in USD

Calculator IInitiaIMarginFee j Add | Remove

[~ Use Mulkiple Calculatars

Billimg Calculators

Id Tvpe StatichataFilter | AmountType | Currency | Description | RefCateTime | TimeZon

132701 [BilingInitialtarginFeeCalculator AMOLMT 1S MOME

Enter the criteria as needed.

Select the calculator BillingInitialMarginFeeCalculator and click Add.

Elnitial Margin Fee Calculator

d: |293598 Description: |
P ILCH ~| Product: IIRD ~|
Fee Type: IDF'.ILY ~| Eilling Type: IIM_BF'.SED_FEE ~|
Holidavys: |ch _I Day Count: I.ﬁ.CT,I'SEuIII j

Fee Rate (bps): ISD.EIEI CLIFFEncy: -

Post-buffer: [

The Daily fee type uses the previous day's IM Requirement to calculate each day's Fee, and carries the calculation
forward to include the non-business days that immediately follow a given date. For example, the Fee calculated for
a Friday will be generated for 3 days to cover Friday, Saturday and Sunday.

The Daily fee type inserts a unique Fee into the Billing Trade for each day that the scheduled task is run. The sum
of these Daily Fees will be the Monthly Total. The Fee currency for the Daily Fee is expected to be in the currency
of the Requirement, so there is no FX Conversion logic.

You can also select the currency as needed to define different IM requirements by currency.

If you check “Post-Buffer” the base amount to compute the fee is the Net Balance of the margin call contract
(which takes the buffers into account). Otherwise, it is the pricer measure MARGIN_CALL.
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Billing Account Segregation by Clearing Service

You can setup the account attribute ProductType on the billing account to segregate the billing fee by clearing
service.

The ProductType attributes needs to match the “Product” field specified for the BillingInitialMarginFeeCalculator.

Z.ﬂ.ccuunt Attributes Window MAPPING CUSO1 CME-SWAP (141221)

Manme Walue —

I5_IEF4 Lrue

{|Product Tvpe IRD |
AccountType Clignk
Clearing Book, CUs01
SERVICES CME-IRD
CCPOriginCode CLIENT
InitialMargindccount AAAL

8.3.2 Fee Billing Rule

The billing rule allows defining the billing frequency, and a billing threshold if needed.

Define the billing rule using Main Entry > Configuration > Fees, Haircuts & Margin Calls > Fee Billing Rule
(menu action refdata.FeeBillingRuleWindow).

ZFEE Billing Rule Window - ¥ersion - 0 {(User: calypso_user)

Edit | Browse |

= Id | 132704 SO Fileer |

Legal Entiky IP-LL | Effective To |12,|'31||'2IZI1?

=
Processing Org I.C\LL j Role ICDunterPart\; j
=

Effective From II:Il,fI:Il,I'ZI:IlZ Billing Cey IAN‘.’

Billing Asset Type INEXT_BILLING_DATE | Halidays | |

Billing Date Rule I @Last Business Day of Month ... | Sett, Date Rule I @7th Business Day of Month ... |

adjust, Days 0 [ Bus. Days Eilling Asset Threshald IIZI
Biling Threshald II:I Input Date Type ITradeDate j
T | Delete | Save || Savenshew ” __J-l Add Attribukes |

E| Defaulks Trade Biling Yalues

Eiook Bundle kwdagent wferTvpe

IIM Based Fee Book, I I I j

» Click Add Attributes to add the EntryType attribute.
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I attributes Window

Marne Yalue
Dref aultBook, IM Based Fee Book
DefaultTransferType
EntryType IM_BASED_FEE
BillingOnly

Set EntryType = User-defined fee, "IM_BASED_FEE” in this example.

8.3.3 Fee Generation

Configure the CLEARING_BILLING scheduled task.

~ Task Description

Task Type: | CLEARING_BILLING

External Reference: IIZI.SIII CALYPUS - LCH

Comnmenks: I Generakes Account Event ko Trigger Generation of IM Based Fees

Descripkion: I Generakes Account Event ko Trigger Generation of IM Based Fees

~ Execution Pararneters

Attempks: |1 Retry After: IIII minukes Expected Execution Time

INM Settings: I-Xm5512m -xne 1 029m -xx MaxPermSize=256m

Log Setkings: I

~ Task Mutification COptions
[~ Send Emails [~ Publish Business Events  To User: j

Common Attributes
H Task attributes
ZCP LZH
PRODUCT TYPE IRD
» Select the CCP for which you want to generate the fees.
»  Select the product type as needed.
[NOTE: For the CME IM fee, the scheduled task should be run only at the end of the month]

If the business holidays are set, and the valuation date is a holiday, the scheduled task fails. You can monitor the
exception in the Task Station:

e Add EX_CLEARING_BILLING to the domain “eventType”.
e Add CLEARING_BILLING to the domain “exceptionType”.

The scheduled task looks up the clearing account and generates PSEventAccountBilling events based on the billing
grid.
The Billing engine subscribes to PSEventAccountBilling events and generates billing trades based on the billing rule.
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Version 14.0+

Make sure that the Billing engine is set in the parameter “engines.startup” of “<calypso
home>/deploy/EngineStartupConfig.properties”:

engines.startup=TransferEngine,MessageEngine, InventoryEngine, AccountingEngine, Liquidat
ionEngine, PositionEngine, TaskEngine,LifeCycleEngine,BillingEngine

You can start the Billing engine as part of the Engine server using "<calypso
home>/startEngineserver.bat" on Windows platforms, or "<calypso home>/startEngineserver.sh" on

*nix platforms.

Version 14.1+

The Billing engine is configured in the Engine Manager of Web Admin: event subscription and engine parameters.
You may need to add this engine if it is not available for configuration: Create a new engine called BillingEngine,
with class name com.calypso.engine.billing.BillingEngine.

The Billing engine can be started from the Engine Manager in Web Admin.

Please refer to Calypso Web Admin documentation for complete details.

The book is set on the billing trades according to the following logic:
e The book specified on the billing rule is selected by default.
e If not set, the “"Funding Book” legal entity attribute on the PO is selected.

e If not set, the standard clearing book lookup method is used.

See Defining Books for details.

Sample billing trade:

ZBiIIing(B.DS USD) -PO is Calypso Clearing US FCM {298699) - Yersion : 0 Mod User i) [1300075P2/CLEARING_25]... =]

Trade Back Office  Biling  Analytics  Pricing Env  Market Data Utilitiﬁ BiIIin;(énDS LSBSI -::‘O i Calypso Clearing s FCM (298699) - Versior

Trade | Detailsl Feesl Billing Feesl

From ICUSTOMER_.C\ J CounterParty BDDkIIM BasedF.. v | Status I'I.I'ERIFIED IID jl298699

To ICP.L\’PSO_US | Processingorg Trade Date |I2I4,|'EII,|'2I313 I?:Z?:4D Al Settle Date IDSIID,I’ZDIS
Stark Dake ID4,I'DI,I'2EI13 End Date ID4,I'3EI,I'2EI13

Recsive Transfer Type IIM Eillng Fee | Account Id | 114213 ICUST_F'.@FCM_CME_IRD

Fee Billing Id | 132704
Principal I .03 ey IUSD YI Ternplate INONE j

Adjustment I 0.00
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ZBiIIing(B.DS USD) -PO is Calypso Clearing US FCM {298699) - Yersion : 0 Mod User ) [1300075P2/CLEARING_25]... [[=]

150

Trade Back Office  Biling  Anakytics  Pricing Enve Market Daka  Utlities  Help  Template
Tradel Detailsl Fees Biling Fees
Legal Entity I I
Billing Exent | Billing Grid
Date Yalue Date | amount Type | Amount | Currency | Converted Amount | Manual &mount | Owerride Amount | Billing Event
04/30/2013 [04)08/2013 |AMOUNT .03 030 .03 r = Account

8.4 Security Collateral Fees

Billing events are generated by the scheduled task CLEARING_BILLING based on margin call positions. The Billing
engine subscribes to the billing events to generate the fees (billing trades) based on billing grids and fee billing
rules.

The Billing Grid calculator “"BondInvestmentFeeCalculator” computes fees of user-defined type, on a periodic basis,
using the scheduled task CLEARING_BILLING and the Billing engine.

The scheduled task CLEARING_BILLING will only process accounts for which the Billing checkbox is checked.
Add the fee type that you want to generate to the domain "BillingFeeType”. For example, "CORP_BONDS".
You also need to add BondInvestmentFeeCalculator to the domain “billingCalculator”.

Setup details are described in the following sections.

8.4.1  Billing Grid

From the Calypso Navigator, navigate to Configuration > Fees, Haircuts, & Margin Calls > Fee Grid, and
select the Billing Grid panel to define billing grids.

ZFEE Grid Window - Yersion - 9
Trade Fee Grid  Billing Grid | Erowse |
pccourt. [T~ |

Coy |an

293097

B
[

Grid 1d |

Processing Crg I.ﬁ.LL

Legal Entity ICLISEII Role ICDunterParty

Event Tyvpe I.ﬁ.ccuunt Fee Value Date ICustDmDate

il

5D Filker ISER'-.-'ICES CME IRD

Yalid From I Yalid ko I
Descripkion ICDrp Bond
Calculakar IEh:undInvestmentFeeCalculatDr j Add | Remoyve
[~ Use Multiple Calculators
Billing Calculataors
Id Tvpe StaticDataFilker | AmountType | Currency | Descripkion | RefDateTime | TimeZone
293695 BondInvestmentFeeCaloulator AMOUMT (i) MOME
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Enter the criteria as needed.

Select the calculator BondInvestmentFeeCalculator and click Add.

Bund Investment Fee Calculator _[O0)

1d |29359=3

cop ICME

Product Subbype ICORF‘

Holidays |rwc Diay Count I.ﬂ.CT,I'SEuIII j
Fee Rate (bps) |1IZI Currency ILISD j
Hair Cut IF‘re-HairCut ~| BillingTyvpe ICORP_BONDS |

Apply |

» Enter the details of the calculator.
»  Set the billing type to the user-defined fee, CORP_BONDS in this example.
» Then click Apply.

Save the billing grid when you are done.

Billing Account Segregation by Clearing Service

You can setup the account attribute ProductType on the billing account to segregate the billing fee by clearing
service.

z.ﬂ.ccuunt Attributes Window MAPPING CUSO1 CME-SWAP (141221)

Marne Walue —

I5_IEF4 krue

rl-:'ruductfype IRD |
AccountType Client
learing Book ZIs01
SERVICES ZME-IRD
_POriginCode CLIEMT
InitialMargindccount AAAL

8.4.2 Fee Billing rule

The billing rule allows defining the billing frequency, and a billing threshold if needed.

Define the billing rule using Main Entry > Configuration > Fees, Haircuts & Margin Calls > Fee Billing Rule
(menu action refdata.FeeBillingRuleWindow).
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Edit I EBrowse |

= Id | 280703 5D Filker |

Leqgal Enkity ICLISEII | Effective To I

Effective From IIIII,I'IIII,I'EEIIEI Billimg Cey ILISD

=
Processing Crg ICP.L""F‘LIS j Fole ICDunterParty j
=

Billing Asset Type IIMMEDIP.TE j Huolidays I |

Billing Date Rule I @End of Month _l Setk, Dake Rule I @7th Business Day of Month _l
Adjust, Days 0 [ Bus. Days Billing Asset Threshold IEI
Billing Threshald ||:| Input Date Tyvpe ITradeDate j
Mew | Delete | Save | Savehshlew | | L Add Attributes |

|E| Defaults Trade Billing Yalues

Bk, Bundle Kwdagent wferTvpe
fouso | | |corp BonDs  + |

» Click Add Attributes to add the EntryType attribute.

znttrihutes Window

Darnair ...

Marme Yalue
Billing Fee Tvpe CORP_BOMNDS
BillingCmlsy krie
DefaulkBook, 11501
DefaultTransfer Type CORP_BOMDS
Enkry Type CORP_BOMDS
DefaulkBundleID

Set EntryType = User-defined fee, "CORP_BONDS"” in this example.

8.4.3 Fee Generation

Configure the CLEARING_BILLING scheduled task.
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~ Task Description

Task Type: | CLEARING_EBILLING

External Reference: IIZI.SIII CALYPUS - CME IRD

Conments: I Generakes Account Event ko Trigger Clearing Related Billing Fees

Descripkion: I Generakes Account Event ko Trigger Clearing Related Billing Fees

 Execution Pararmeters

Attempts: |1 Retry After: IIZI minukes Expected Execution Time

VM Settings: I-Xm5512m -xmm 1029m -2 MaxPermSize=256m

Log Setkings: I

~ Task Matification Options

[~ Send Emails [~ Publish Business Events  To User: j
Common Attributes
El Task Attributes

CCP CME

PRODUCT TYPE IRD

»  Select the CCP for which you want to generate the fees.

»  Select the product type as needed.

If the business holidays are set, and the valuation date is a holiday, the scheduled task fails. You can monitor the
exception in the Task Station:

e Add EX_CLEARING_BILLING to the domain “eventType”.
e Add CLEARING_BILLING to the domain “exceptionType”.

The scheduled task PSEventAccountBilling events based on the billing grid.

The Billing engine subscribes to PSEventAccountBilling events and generates billing trades based on the billing rule.

Version 14.0+

Make sure that the Billing engine is set in the parameter “engines.startup” of "<calypso
home>/deploy/EngineStartupConfig.properties”:

engines.startup=TransferEngine, MessageEngine, InventoryEngine, AccountingEngine, Liquidat
ionEngine, PositionEngine, TaskEngine,LifeCycleEngine,BillingEngine

You can start the Billing engine as part of the Engine server using "<calypso
home>/startEngineserver.bat" on Windows platforms, or "<calypso home>/startEngineserver.sh" on
*nix platforms.

Version 14.1+

The Billing engine is configured in the Engine Manager of Web Admin: event subscription and engine parameters.
You may need to add this engine if it is not available for configuration: Create a new engine called BillingEngine,
with class nhame com.calypso.engine.billing.BillingEngine.

The Billing engine can be started from the Engine Manager in Web Admin.

Please refer to Calypso Web Admin documentation for complete details.
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Section 9. Message Configurations

From the Calypso Navigator, navigate to Configuration > Messages & Matching > Message Set-up for
defining messages.

9.1 CONSENT Messages

The CONSENT message is sent to the CCP once a trade has been approved / rejected in Calypso. Upon receipt of
the CONSENT message, the CCP will clear / cancel the trade.

9.1.1 Message Setup

Edit I Erowse |

Product Type I.C\LL Language IEninsh {United Stakes)

L |

| peliells vl pedpelped 1o

Event Type ICREDIT_CONSENTED_TR.C\DE address Type ICME |

Message Type ICONSENT Gakeway IMQ

Processing Crg ICP.L‘."PUS Farmat Type IXML

PO Cantact Type IDeFauIt Template ICMEBridgeConsentGranted

Receiver IALL 5D Filker IisCMEFeedTrade

0 {5 B

Receiver Role ICDunterParty [~ Matching

Rec Contact Type IDeFauIt [~ Do nok Send Message

Grouping I j [~ Inactive
Config Id |141?8.T" Delete | Save Save As New
Id Product Ewenkt Message ... « ProcessingZrg | PO Contack Tvpe | Receiver | Receiver Role
1417586 /|ALL CREDIT_CCOMSEMTED_TRADE [CCOMSEMNT CALYPUS Diefault aLL CounkerParky

_REDIT NTED_TRADE d CALYPUS Default f CounkerP

Z2a0219/ALL CREDIT_CONSENTED _TRADE |(COMSENT CALYPUS Defaulk ALL CounterParty
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Edit I Browse |

Product Twpe IP.LL

4

RN D 5 5

Event Type ICONSENT REJECTED_TRADE

Messzage Type ICONSENT

Processing Crg IC.D.LYPUS

PO Contact Type IDeFauIt

Receiver I.C\LL

Receiver Raole ICounterParty

Rec Conkact Type IDeFauIt

L

Grauping I

Config Id |141?8EI

Delete |

Clearing Member Setup Guide

=l
o
[
j

Terplate ICMEBridgeConsentReFused - |

o

Language IEninsh (United Skates)

Address Type ICME

Gakeway IMQ

Farmat Type IXML

5D Filker IisCMEFeedTrade
[~ Matching
[~ Do nok Send Message

[~ Inactive

Save Sawve As New

Message Tyvpe »

ProcessingCrg | PO Cankack Twpe | Receiver | Receiver Role

Default nikerParky
141783 COMSEMT Default CounterParty
280220)ALL COMSENT REJECTED_TRADE |ZOMSEMT CALYPIUS Default ALL CounterParky
9.1.2 Message Sender Config
' ™y
A Message Sender Config [EM
Sender Config | Copy Cor‘lﬁg|
Message Status .TO_BE_SENT - Product Type .ALL v.
Advice Type lCONSENT - Address Type lLCH - ]
Static Data Filter E Gateway lMQ - l
Il Save Master and Copies AdviceDocuments will be saved in DB
||
| Send Sender By Method Sender By Gateway
LCHGatewayMQDocumentSender dass will be called
[
Save ] ’ Remove l ’ MNew
1d Status Product Advice Type Address Type Gateway SD Filter Send Save By Gateway By Method
0_BE _SH Q I v v
297212TO_BE_SENT  |ALL EXCHAMGE_FEED_COMSENT_ACK  |LCH MQ
| l
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9.2 CLEARING_STATEMENT Messages

The CLEARING_STATEMENT message is the client statement - It is generated by the Message engine once the

scheduled task CLEARING_STATEMENT sends the STATEM

Edit | Bromse |

Product Type IMarginCaII

Event Tvpe IST.C\TEMENT Add

4

|t pedididiedidd

Message Type ICLEF\RING_STF\TEMENT

Processing Crg IF\LL

PO Contack Type IDeFault

Receiver I

Receiver Role ICIient

Rec Contact Type IDeFauIt

Format Type IHTML

ENT events.

Language IEninsh

ress Type IM.C\IL

E
_

Gateway IFILE

=l

Template IIMFMCCIearingStatement.html |

5D Filker | . |

[~ Matching

[~ Danot Send Message

Erouping I j [ Inactive
Config Id |13E|29E| Delete | Save Save fis Mew
Id Product Ewvent Message Type ProcessingOrg | PO Contack Type Receiver

Default

rMarginCall

STATEMENT |CLEARIMG_STATEMENT |ALL

[NOTE: Receiver Role = Client]

We are using the role “Client” in this setup. It can also be

See On-Boarding an Individual Client for details.

You can select any HTML template - It will be overridden by the CLEARING_STATEMENT message formatter to use

an XSL template.

If you also want to generate a PDF statement, add the foll

Edit | Browse I

Product Tvpe IMarginCaII

Event Type ISTF'.TEMEI"-JT

Message Tvpe ICLEP.RING_STF'.TEMEI"-.IT

Processing Org IF'.LL

PO Contact Tywpe IDeFauIt

Receiver I

Receiver Raole ICIient

Fec Cantack Type IDeFauIt

L
i pelped]s i iediedie

Grouping I

» Format Type = PDF

» Template = "CMFMCClearingStatementPDF.html”
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Language IEninsh

Address Tyvpe ICME

Gateway IFILE

Format Type IF‘DF

Template IﬂCCIearingStatementPDF.html

5D Filker |

[~ Makching

[T Do not Send Message

[ Inactive

Technology, Inc. All Rights Reserved




157 Clearing Member Setup Guide

9.2.1 Default Template

The location and name of the XSL template is set in domain “Clearing.Statement.stylesheetPath”, and defaults to
“resources/com/calypso/templates/ClearingStatement.xsl”, identified as:

Mame: |Clearing. Statement.skylesheetPath

Walue: comfcalypsoftemplates)ClearingStatenment, sl

The location and name can be changed as needed.
The XSL template can be customized as needed.
For example, you can easily replace the “logo” image, and any disclaimer in the “footer”.

<img src="https://www.calypso.com/images/logo.gif" alt="Logo"/>
<p class="FOOTER">

Statement generated by Calypso Technology, 2013.
</p>

The actual content of the client statement is defined in the file
“resources/config/ClearingStatementFactory.xml”.

Its location and name is set in domain “Clearing.Statement.resourcelLocations”, and can be changed as needed.

Mame: |Clearing.Stakement. resourcel ocations

Yalug: |classpath:configiClearingstatementFactory, xmil

[NOTE: If the “Excess/Deficit Including Pending Collateral” row name is customized in
“ClearingStatementFactory.xml”, all occurrences of such name must also be replaced in “ClearingStatement.xsl”]

9.2.2 Defining a Template by Legal Entity

It is possible to override the default location of the template, and set it by legal entity, using the configuration file
“resources/com/calypso/tk/clearing/factory/ResourceClearingFactory.Statement.xml”.

A sample configuration file is provided in
“resources/com/calypso/tk/clearing/factory/ResourceClearingFactory.Statement.xml.sampl
e”. You need to rename it to
“resources/com/calypso/tk/clearing/factory/ResourceClearingFactory.Statement.xml” in
order to use it.

If this file does not exist, the default template will be used instead.

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:util="http://www.springframework.org/schema/util"
xsi:schemalocation="
http://www.springframework.org/schema/util
http://www.springframework.org/schema/util/spring-util-3.0.xsd
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans-3.0.xsd"
default-init-method="init" default-destroy-method="destroy">

<!-- statementConfigurationPaths has to be a list of valid Spring resource
paths. See http://docs.spring.io/spring/docs/3.0.x/spring-framework-
reference/html/resources.htmlfresources-app-ctx for more info -->

<!-- statementTemplatePath has to be either an absolute file path, or a

classpath, with no classpath: or file: prefix -->

<!-- SAMPLES


http://docs.spring.io/spring/docs/3.0.x/spring-framework-reference/html/resources.html#resources-app-ctx
http://docs.spring.io/spring/docs/3.0.x/spring-framework-reference/html/resources.html#resources-app-ctx
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<bean id="calypsoUKresourcelLocations"

class="com.calypso.tk.bo.clearing.statement.ClearingStatementResourcesLocator" >
<meta key="LegalEntity" value="CALYPSO UK"/>
<property name="statementTemplatePath"
value="com/calypso/templates/custom statement.xsl" />
<property name="statementConfigurationPaths">
<list>
<value>classpath:config/CustomUKClearingStatementFactory.xml</value>
<value>config/OtherCustomUKClearingStatementFactory.xml</value>
</list>
</property>
</bean>

<bean id="customerAresourceLocations"
class="com.calypso.tk.bo.clearing.statement.ClearingStatementResourcesLocator" />
<meta key="LegalEntity" value="CUSTOMER A" />
<property name="statementTemplatePath"
value="/path/to/calypso/resources/com/calypso/templates/custom statement.xsl" />
<property name="statementConfigurationPaths">
<list>
<value>file:///path/to/calypso/resources/config/CustomerAClearingStatementFactory.xml<
/value>
</list>
</property>
</bean>

END SAMPLES -->

</beans>

9.3 CVR_WORKSHEET Messages

This message type is used to generate the Collateral Valuation report.

It is not necessary to setup a message configuration, but it is necessary to define a message workflow for this type
of message.

The CVR_WORKSHEET message workflow can be imported using “<calypso
home>/client/resources/CVR_WORKSHEET.wf".

If you are clearing with LCH, you need to use the file “<calypso
home>/client/resources/CVR _WORKSHEET LCH.wf” instead. It adds the transition highlighted below for
managing incoming collateralAllocation messages.

Orig Status Action Resulting Subtype Product Processing
Status Type Org
ACCEPTED ACCEPT ACCEPTED
ACCEPTED ACK ACCEPTED
ACKED ACCEPT REJECTED
ACKED REJECT REJECTED
EDITABLE CANCEL CANCELED CVR_WORKSHEET ALL ALL
EDITABLE EXPORT EXPORTED CVR_WORKSHEET ALL ALL
EDITABLE UPDATE EDITABLE CVR_WORKSHEET ALL ALL
EXPORTED AUTHORIZE TO_BE_SENT CVR_WORKSHEET ALL ALL
Rule: PrepareCVRForSend
Filter:

isSLCHCVRValidToSend
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Orig Status Action Resulting Subtype Product Processing
Status Type Org

NONE NEW EDITABLE CVR_WORKSHEET ALL ALL
REJECTED ACK REJECTED CVR_WORKSHEET ALL ALL
REJECTED REJECT REJECTED CVR_WORKSHEET ALL ALL
SENT ACCEPT ACCEPTED CVR_WORKSHEET ALL ALL
SENT ACK ACKED CVR_WORKSHEET ALL ALL
SENT REJECT REJECTED CVR_WORKSHEET ALL ALL
TO_BE_SENT SEND SENT CVR_WORKSHEET ALL ALL

Static data filter “isLCHCVRValidToSend”
| £ Static Data Filter Window [1400205P2/LAPTOP_REL14/calypso_user] =NRcl |

Name: isLCHCVRValidToSend | Aftributes... || Simuate...

Comment: [ Pending Modifs
Groups: | ANY B
Akkribuke Criteria Filker Waluels)
MaG_ATTRIBUTE, CWRwWorksheetddviceDocumentID |« FLOAT_RAMGE | CFangel|1.0, Infiniky
Message Receiver - IM [ &dd J|LH

It is also necessary to define a message sender configuration in order to send the report to LCH through MQ Series.

:Eg

- -—
_A Message Sender Config

Sender Config

Copy Config

[] save

Send

Static Daka Filker

Message Status | TO_BE_SEMT

Advice Tvpe | CVR_WORKSHEET

Sender By Method

LCHGatewayMODocumentSender class will be called

Product Tvpe ..ﬁ.LL

Address Tvpe |LCH

Gakteway MO

Save

[ Remove l [ T
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Once a CVR report is exported, from the CVR report or using the scheduled task
CLEARING_EXPORT_CVR_WORSHEET, it is sent to LCH using the MQ connector LCHCVR.

MQ Series is configured using the following files:

® “<calypso home>/client/resources/LCHCVRbridge_config.properties.sample” (mandatory to send
the outgoing CVR messages to LCH)

® “<calypso home>/client/resources/LCHCVRbridgeservice.properties.sample” (optional, used to
receive response messages)

LCHCVRbridge_config.properties

Rename “"LCHCVRbridge config.properties.sample” to "LCHCVRbridge config.properties”, and
modify as needed.

JMS properties file
REFER TO EXCHANGE FEED DOCUMENTATION FOR MORE INFO
JMSQueuelEAdaptor properties
Note: if queue.ackType is not set to auto then
failed messages are not acknowledged to JMS and

will be reconsumed when the engine restarts

Queue-specific properties are prefixed by the queue name

= K S S S S K S S S S S

input.queue.name=JQUEUE.LCH.CALYPSO
JQUEUE .LCH.CALYPSO.queue.ackType=auto
JQUEUE .LCH.CALYPSO.queue.persist=false
JQUEUE.LCH.CALYPSO.queue.transacted=false

output.queue.name=JQUEUE.CALYPSO.LCH
JQUEUE .CALYPSO.LCH.queue.ackType=auto
JQUEUE .CALYPSO.LCH.queue.persist=false
JQUEUE .CALYPSO.LCH.queue.transacted=false

jms.queue.hostname=localhost

jms.queue.port=1414
jms.queue.connectionUserName=
jms.queue.connectionPassword=
jms.queue.transportType=MQJMS TP CLIENT MQ TCPIP
jms.queue.queueManager=QM.LCH.CALYPSO
jms.queue.channel=SYSTEM.ADMIN.SVRCONN

LCHCVRbridgeservice.properties

Rename "LCHCVRbridgeservice.properties.sample” to "LCHCVRbridgeservice.properties”, and
modify as needed.

bridge.counterparty.attribute.identifier=LCH CPTY

i
Bridge original, work in progress and #
final transformation directory of the #
incoming message.

If this option is not set,

<CALYPSO_ HOME>/<Connection>

will be used by default

FHEH A A AR AR A A
#file.bridge.log.directory=C:\\LCH

H= =

SiF Sio EiE Sin sl

#
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REQUESTCONSENT SWAP BRIDGE XSLT=LCH REQUESTCONSENT SWAP.xslt
CLEARINGCONFIRMED SWAP BRIDGE XSLT=LCH CLEARINGCONFIRMED SWAP.xslt

SWAP TRANSFORMER CLASS=com.calypso.tk.bo.bridge.transformer.LCHSWAPMappingTransformer
KEYWORDS REQUESTCONSENT SWAP XSLT=KEYWORDS LCH REQUESTCONSENT SWAP.xslt

KEYWORDS CLEARINGCONFIRMED SWAP XSLT=KEYWORDS LCH CLEARINGCONFIRMED SWAP.xslt

REQUESTCONSENT FRA BRIDGE XSLT=LCH REQUESTCONSENT FRA.xslt
CLEARINGCONFIRMED FRA BRIDGE XSLT=LCH CLEARINGCONFIRMED FRA.xslt

FRA TRANSFORMER CLASS=com.calypso.tk.bo.bridge.transformer.LCHFRAMappingTransformer
KEYWORDS REQUESTCONSENT FRA XSLT=KEYWORDS LCH REQUESTCONSENT FRA.xslt

KEYWORDS CLEARINGCONFIRMED FRA XSLT=KEYWORDS LCH CLEARINGCONFIRMED FRA.xslt

RULE HANDLER=com.calypso.tk.bo.bridge.handler.LCHCVRRuleHandler

# BRIDGE BO Messages default sender and receiver.
BridgeMessageDefaultSender=LCH
BridgeMessageDefaultReceiver=CALYPSO

ThreadPoolSize=5

# Look for file changes every xx-seconds.
interval=10
G o o i i
# Message validator list

# A list of xslt files located in

# /resources/calypso/mapping/

# for incoming message validation by
# message structure #

G o o o i
ValidatorFiles=exchange feed clearing confirmed check fpml5.3.xslt,exchange feed clear
ing status check fpml5.3.xslt,exchange feed request consent check fpml5.3.xslt,exchang
e feed consent acknowledgement check fpml5.3.xslt,exchange feed clearing refused check
_fpml5.3.xslt,exchange feed service notification check fpml5.3.xslt,exchange feed posi
tion report check fpml5.3.xslt,exchange feed lch data document check fpml5.3.xslt,exch
ange feed message rejected check fpml5.3.xslt

+H= = H

The clearing member is identified in the output file using the FCM BIC (external name of the house clearing
account).

9.4 BRIDGE_ACK Messages

BRIDGE_ACK messages are sent to acknowledge that collateralAllocation BRIDGEMSG messages have been
received.

9.4.1 Message Setup
You need to add “LCHCVRResponseAck.html” to the domain “XML.Templates” if it is not available for selection.

Mame: =ML, Templates

Yalue: LCHCWYRResponsedck
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Edit | Browse

Language |Endglish (United Skakes)

Produck Type | ALL - -
Event Tvpe |Ex_BRIDGE_ACK - Address Tvpe |LCHCYR - E]
Message Tvpe |BRIDGE_ACK - Gakeway MG -
Processing Org | ALL - Formakt Type | &ML -
PO Contact Type | Defaul: - Template LCHCYRResponsedck, E]
Receiver E] S0 Filker (isLCHCYRMessane E]
Receiver Role | CounkerParty - [] Matching
Rec Contact Type |Default - [7] Do not Send Message
Grouping - E] [ Inactive
Canfig Id (67222 [ Delete ] [ Save ]| Save As Mew
Id Product  Ewent Message Type  ProcessingQrg PO Contact Twpe  Receiver  Receiver Role
672zz|ALL [E%_BRIDGE_ACK [BRIDGE_ACK  [ALL [Def ault ALL CounterParty
9.4.2 Message Sender Config
- ———— |

_J__ Message Sender Config ‘ ' '

Sender Config | Copy c.:.nFig|

Save

Send

Message Skatus | TO_BE_SEMT

Advice Twpe |BRIDGE_ACK

Skatic Data Filker |isLCHCYRMessage

(]

Product Type ..ﬁ.LL

Address Type  LCHCYR

Gateway MO

Master and Copies AdviceDocuments will be saved in DB

] o

Sender By Gateway

LCHC YR GatewayMODocument Sender class will be called

Save

[ Remoye ] [

Mew
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9.4.3 Message Workflow

Clearing Member Setup Guide

The BRIDGE_ACK message workflow can be created using the file “<calypso

home>/client/resources/workflow/bridge ack.wf”.

Orig Status Action Resulting Subtype Product Processing
Status Type Org
NONE NEW PENDING BRIDGE_ACK ALL ALL
PENDING AUTHORIZE TO _BE_SENT BRIDGE_ACK ALL ALL
SENT SEND SENT BRIDGE_ACK ALL ALL
TO _BE_SENT SEND SENT BRIDGE_ACK ALL ALL
9.5 CVR_LE_DATA Messages
This message type is used to generate the report LSOC CVR Static Data.
9.5.1 Message Setup
Edit | Browse |
Product Type |Mar|;|lnCaII ;] Language |En|;|llsh ;]
Event Type [VERIFIED_TRADE | Address Type [1TD_STATEMENT FILE  =| .. |
Message Type |UsENsTY ¢ Gateway IFILE El
Processing Org IP.LL j Formak Tvpe IXI"-’IL j
PO Conkack Type IDeFauIt j Template ICIearingITDStatemer't.nﬂ
Receiver IF'.LL I S0 Filker IisITDMarginCaIITradeType
Receiver Role IExtCDunterParty l] [~ Matching
Rec Contack Type |DeFauIt :] [T Do not Send Message
Grauping | :] I [T Inactive
Config Id |EE|52DD Delete Save Save As New
9.5.2 Message Workflow
Orig Status Action Resulting Subtype Product Processing
Status Type Org
NONE NEW PENDING CVR_LE DATA ALL ALL
PENDING TO_SEND TO _BE_SENT CVR_LE_DATA ALL ALL
TO_BE_SENT SEND SENT CVR_LE DATA ALL ALL
TO _BE_SENT CANCEL CANCELED CVR_LE_DATA ALL ALL
SENT CANCEL CANCELED CVR_LE DATA ALL ALL
SENT RESEND SENT CVR_LE_DATA ALL ALL
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9.6 CFTC_REPORTING Messages

This message type is used to generate the reports Liquidating Deficit and Aged Margin Calls.

It is not necessary to setup a message configuration, but it is necessary to define a message workflow for this type
of message.

Orig Status Action Resulting Subtype Product Processing
Status Type Org

NONE NEW CREATED CFTC_REPORTING ALL ALL

CREATED CANCEL CANCELED CFTC_REPORTING ALL ALL
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Section 10. Scheduled Tasks Setup

The following scheduled tasks need to be configured for each CCP.

They download the CCP files using the following property file:
® “<calypso home>/client/resources/config/clearingconnection.properties”

See Clearing Member Setup for details.

Once the files are retrieved from the CCP, they are stored in the folder specified in the property file “<calypso
home>/client/resources/config/clearing.properties” if it exists.

Otherwise, they are stored by default under “<user home>\Calypso\clearing” on the server where the
Scheduler engine is running, and for the user running the Scheduler engine.

From the Calypso Navigator, navigate to Configuration > Scheduled Tasks (menu action
scheduling.ScheduledTaskListWindow) to configure the scheduled tasks. Choose this menu item to bring up

the Scheduled Task Definitions & Scheduling window.

10.1 Flow Types and Fees
The scheduled tasks create Clearing Transfer trades to reflect the clearing activity. Clearing Transfer trades are of
type CASH_SETTLEMENT.

CASH_SETTLEMENT Clearing Transfer trades represent the cashflow amounts that impact the cash accounts. They
are used for payment purposes and these amounts have a direct impact on the Cash Account balances posted to
the client statements.

They are associated with the following fees:

e CS_PAI - Price Alignment Interest. Interest paid on Mark-to-Market amounts. Taken from the CCP file.
e CS_COUPON - Interest associated with the swap trades (CME). Taken from the CCP file.

e CS_INTERESTS - Interest associated with the swap trades (LCH). Taken from the CCP file.

e CS_FRA_PAYMENT - Settlement associated with the FRA trades. Taken from the CCP file.

e CS_CASH_DELIVERY - Cash associated with the FX NDF trades. Taken from the CCP file.

e CS_VARIATION - Variation margin taken from the CCP file (EOD or intraday for LCH GBP FRAs)

e CS_FEES - CME only - Fees associated with the trades. Taken from the CCP file.

e CS_CONSIDERATN - LCH only - Fees associated with the swap trades. Taken from the CCP file.

e CS_NPV_ADIJUSTED - Adjusted NPV. Taken from the CCP file.

e CS_NPV_REV - Reversal of CS_NPV_ADJUSTED, the day after.

We recommend that CASH_SETTLEMENT trades be settled automatically on their value date since the CCP
takes/pays the money from/to the clearing member’s nostro account, and this must be reflected on the client’s
cash accounts. To do so, you just need to add the rule CheckToBeSettled in the transfer workflow on the transition
VERIFIED - AUTO_SETTLE - SETTLED.

One Transfer for Each Fee

In order to generate proper information for the client statement, the system must generate one transfer for each
fee of the trade.

Note that in this case, the fee definitions MUST have the Transfer option checked, except for fee
CS_VARIATION.

Example for CS_PAI:
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ZFEE Definition (User: calypso_user)

Tvpe : ICS_F'.C'.I

Role ICnunterParty j

Fee Offset : IIII_ Cal

Products : I.ﬁ.LL

Default Calculatar INONE j

Include : [+ Pricing [ Accounting v Allocation
[ Tramsfer [T Settlement Amount

All of these fees are created by the system upon installation.

10.2 Settlement Lag

(1) For all flow types, the Settle Date is set based on the Settle Date of the Flow tag if one is provided. If a Settle
Date is not provided, this date is calculated by adding the number of business days defined in the Currency
Settlement Lag of the flow's settlement currency according to that currency's holiday calendar.

(2) If the CCP legal entity attribute “UseAlternateSettleDateMethod” is false or null the system follows the logic
defined in (1). If set to true, the following logic applies:

T+2 currencies

e SETTLE DATE=Trade Date + 2 days (excluding weekends)

e If SETTLE DATE falls under currency Holiday, then it is set to the next business day for that currency.
T+1 currencies

e SETTLE DATE=Trade Date + 1 day (excluding weekends)

e If SETTLE DATE falls under currency Holiday, then it is set to the next business day for that currency.
“UseAlternateSettleDateMethod” should be set to true for LCH and false for CME.
Settlement Date = Trade Date + Settlement Lag
The Settlement Lag of all Clearing Transfers is driven by the currency of the transfer in the following manner:

e If a settlement lag is specified in the currency attribute “<CCP name>ClearingTransferSettleLag”, it is
used in priority.

e Otherwise, we use the settlement lag specified in the currency attribute “ClearingTransferSettleLag” if any.
e  Otherwise, the settlement lag is 1 business day.
[NOTE: If you only set ClearingTransferSettleLag, it will apply to all CCPs]

Sample setup (remember that attribute names are case-sensitive):

_A Currency Default Attributes Window EUR

Marme Yalue —
ClearingEligible True
LZHClearing TransfersettleLag 3
ClearingTransfersettlzLag z

In this example, the settlement date for CME clearing transfer trades would be Trade Date + 2, and the settlement
date for LCH Clearing Transfer trades would be Trade Date + 3.
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This sample setup is not realistic — It is only used to illustrate the configuration capability.

10.3 Available Date

The Inventory positions MUST be based on the Available Date.

As a result, you need to define how the Available Date is set for the various trades involved in the clearing activity.

By default, the Available Date is set to the Trade Date. This behavior can be customized using the domain
“XferAvailableDate” to determine the Available Date based on the Settlement Date +/- a number of days for a
given static data filter. You need to setup the following:

e Value = “-1.AVDATEFORSIMPLEXFER"” where "AVDATEFORSIMPLEXFER" is a static data filter that filters
simple transfers in AUD and JPY - The available date will be set to the settlement date -1 day.

e Value = “-1.EOD CT” where “"EOD CT" is a static data filter that filters non GBP FRAs clearing transfers in
currencies different from AUD and JPY - The available date will be set to the settlement date -1 day.

e Value = “-2.TPLUS2CCY"” where “TPLUS2CCY" is a static data filter that filters clearing transfer trades in
AUD and JPY - The available date will be set to the settlement date -2 days.

B feravaiabieDate|

- 4¥ -2, TPLUS2CCY
4% -1EOD CT
‘.. 4% -1 AVDATEFORSIMPLEXFER

Static Data Filters

ZStatic Data Filter Window [130007SP2,/CLEARING_25/] (User: calypso_us... [lj=]

Name:IAHDATEFORSIMF‘LEXFER Attributes. .. Simulate, ..
Cn:nmment:l Pending Modifs
Gru:uups:l.ﬁ.r'-h’ |
Aktribike Criteria Filter Waluels)
Product Twpe IN Add SimpleTransfer
Trade Currency IN Add LD, IR

ZStatic Data Filter Window [1300075P2,/CLEARING_25,] (User: calypso_us... [Ij=]

Name:IEOD T Attributes. . . Simulate. .. |
Cu:umment:l Pending Modifs |
Grl:uups:l.ﬁ.N'f |
Attribute riteria Filker Yaluels)
KEYWORD, RelatedProduct Type MOT_IM Add  |SBF_FRA
Product Type IN add | ClearingTransfer
Trade Currency MOT_IM add  |auUD, IPY
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Zﬁtatic Data Filter Window [1300075P2/CLEARING_25,] (User: calypso_us... =]

Name:ITF'LLISECC'f Attributes. .. Simulate. ..
Cnmment:l Pending Modifs
Gru:uups:l.ﬁ.r'-.h’ |
Akkribuke Criteria Filker Waluels)
IM Skatic Data Filker IM Add Clearing TRansfer Trade
Trade Currency IM Add AU, IPY
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10.4 CDML Files Processing

Clearing Member Setup Guide

The CDML files processing is a two-step process.

You first need to store the files into the system using the scheduled task CLEARING_TRANSLATE_TO_CDML. Then
you can process the files using the scheduled task CLEARING_PROCESS_FROM_CDML.

The scheduled tasks CLEARING_TRANSLATE_TO_CDML and CLEARING_PROCESS_FROM_CDML use the timezone
defined in the scheduled task.

10.4.1 Supported Files

CCP

Trade Valuation

Initial Margin

CME

LCH

LCHPORTFOLIO

LCH FX

HKEX

ICE

EUREX

COMDER

IRSTR

91xce(client)
91xe(house)
REP00002c (client)
REP00002 (house)
REP000105c (client)
REP105 (house)
REP00084c (client)

16¢(client)
16b(house)

FREPO009 (CLIENT)
FRPO009 (HOUSE)

WEB Settle Details IRS_C (Client)

WEB Settle Details IRS (House)

WEB Money Settle_C (client)

WEB Money Settle (House)

MARK TO MARKET MARGIN DETAIL report
(NPV).

MARK TO MARKET MARGIN INTEREST
DETAIL report (PAI).

TRADE PAYMENT DETAIL report (Upfront
fees, Coupons, Credit Events).
RPTCB202

RPTCC203

RPTCD200

RPTCI280

FXNDF_Trades_Cleared
FXNDF_Maturing_Today

IRSMR3

REP00086¢c (client)
REP00086 (house)
REP00050g (client)

FREP0O026¢c (client)
FREPOO014 (house)

Web IM Call Amt (Client and House)

Client gross Margin

RPTCC204

EOD_IM_Report
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LCHPORTFOLIO CDML producer is added to process Trade Valuation using position based files. The reason for
adding this is to allow FCM to keep up with client statement generation and EOD processing SLAs, We also have
LCH CDML producer which considers trade level information such as 91xce, 2c and 105c however LCH generates
these files very late which delays EOD processing. LCHPORTFOLIO considers 16c and 16b files for VM flows
calculation and these are available at position level. To make sure LCH v/s LCHPORTFOLIO producers are used we
have introduced new CLEARING_TRANSLATE_TO_CDML ST attribute call Ignore Producers which accept comma
separated values. User can either Ignore LCH or LCHPORTFOLIO based on requirement. Also we have introduced
new attributes in CLEARING_PROCESS_FROM_CDML ST called CCP, Clearing Service and Process Mode. This helps
user to process CDML for particular combination of PO (ST Common Attribute), CCP, Clearing Service for
generation of CT, PL marks and Initial Margin exposure.

User can pick and choose needed combination for generation of IM and VM by PO, CCP, Clearing Service. This
provides flexibility and helps FCM to manage their internal EOD processing related SLAs.

10.4.2 CLEARING_TRANSLATE_TO_CDML

The scheduled task scans the subfolders (that represent the CCPs) and tries to find pre-defined sets of CCPs EOD
reports needed to generate the CDML reports.

The scheduled task can be run multiple times. If it finds new information (e.g. EOD reports for another CCP), it will
add this CCP data to the existing CDML report and will create a new version of the report.

Task Type ICLE.ﬁ.F{ING_TR.C'.NSLP.TE_TO_CDML

External Reference IIMPORT

Cornrments I

Descripkion I

Attempts |1

Retry After, In Minutes IIII

I¥M Sektings I-XmsSlEm -amx1024m -£x:MaxPermSize=256m

fllowe Task To [ Skip Execute [ Sernd Emails [ Publish Business

Comnmon Attributes
[l Task Attributes

Base Folder ${user home}/Calvpso)clearing 0L
DML Processing Import Only
Intraday false

The timezone in the Common Attributes is mandatory.

» Base Folder - Enter the location of the files.

For the mode “Generation plus Import”, the raw CCP files need to be organized in subfolders by CCP short
name.

For the mode “Import” only, the folder contains the CDML files to be imported into the system.
» CDML Processing - Select the type of CDML processing “Import Only” or “Generation plus Import”.
» Select Intraday = false
The scheduled task produces two types of XML reports:
e tradeValuationReport

e initialMarginRreport

10.4.3 CLEARING_PROCESS FROM_CDML

The scheduled task CLEARING_PROCESS_FROM_CDML consumes the imported tradeValuationReport and
initialMarginRreport CDML reports.
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It creates CASH_SETTLEMENT Clearing Transfer trades, Collateral Exposure trades, and PL Marks.
= Task Attributes

Clearing Service
CDML Report Type
Process Mode
The timezone in the Common Attributes is mandatory.
Attributes
»  CCP: Select one or more CCPs.
»  Clearing Service: Select one or more clearing services.
» CDML Report Type: Select All, initialMarginReport, or tradeValuationReport.
»  Process Mode:

- If you have selected the report type “tradeValuationReport”, you can select All, Clearing
Transfers, or Cleared Trade Marks, to create Clearing Transfer trades only, PL Marks only, or both
(All.

- If you have selected the report type “initialMarginReport”, you can select Collateral Exposures to
create Collateral Exposure trades.

10.4.4 CLEARING_INTRADAY_MARGIN_REV

This scheduled task creates “return” trades for the intraday margin call trades of type ITD_COLLATERAL created by
the scheduled task CLEARING_INTRADAY_MARGIN when you use CDML to create the EOD Initial Margin trades.

It creates “return” trades of type ITD_COLLATERAL, of opposite direction of the original trades, and with the trade
keyword ITDMarginCallReturn=true. There is one return trade for each counterparty and currency.

=l Task Attributes

Ledger Type cion

CCP LCH

Product IRD

Mode Both
Attributes

» Ledger Type - Select COV, NON-COV, or ALL.
» CCP - Select LCH.

»  Product - Select the product IRD.

» Mode - Client, House, or Both.

This only applies to LCH - Select Client to import client files only, House to import house files only, or Both
to import both.

10.5 COLLATERAL_MANAGEMENT

It computes the exposure on the initial margin and variation margin, and generates cash margin calls. It requires
that you save a Collateral Manager report template to retrieve selection criteria.

From the Calypso Navigator, navigate to Processing > Collateral Management > Collateral Manager (menu
action reporting.margincall.MarginCallDesktop) to define a Collateral Manager report template.

For IM contracts, the scheduled task loads the corresponding Collateral Exposure trades.

For VM contracts, the scheduled task loads the cash accounts associated with the margin call contracts. The
exposure is the inventory THEORETICAL Margin_Call position that has been updated by the CASH_SETTLEMENT
Clearing Transfer trades.
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Task Type ICOLLP.TERP.L_MANP.GEMENT

External Reference IIII. 17 Collateral Magmt Calypsa U5 (Run T+1:||

Comments IZ.Z.EI Testing Setup Refresh

Descripkion IZ.Z.EI Testing Setup Refresh

Attempts |1

Retry After, In Minukes IEI

¥ Settings |

fllow Task To [ Skip Execute [ Send Emails [~ Publish Business

Common Attributes
El Task Attributes
Template CALYPLS
Collakeral Context
Price method
Qpkimization
Workflow Action

Attributes
» Select a Collateral Manager template to define the selection criteria.
You can create a Collateral Manager template in the Collateral Manager using File > Save Template.
»  Select a collateral context as needed.

» The other attributes may remain empty.

Please refer to Calypso Collateral Management documentation for complete details on this scheduled task.
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10.6 CLEARING_SOD_ MARGINCALL

This scheduled task can be executed at the start of day to manage the SOD pass-through function. It allows
comparing the client Margin Call Positions with the CCP cash balances provided by report REP00030, and
generating Margin Call Trades facing the CCP in the respective IM Margin Call Contract.

The domain “Clearing.SOD.IgnoreAccount” can be used to filter out the accounts to be ignored by this process.
The margin call attribute CCP_SEGREGATION_ACCOUNT must be set to the “Account” field of report REPO0030.

Task Drescription

Task Type: | CLEARING_SOD_MARGINCALL

Exkernal Reference: ICIearing 500 Margin CaII|

Commenks: I

Descripkion: ICIearing SO0 Margin Call

Execution Pararneters

Attempks: |1 Retry After: IIII minukes

VM Settings: I-XmsSlZm -xne 1 029m -xx MaxPermSize=256m

Log Seftkings: I

Tazk Motification Options
[~ Send Emails [~ Publish Business Events  To User: I

Comnmon Attributes
[l Task Attributes

CCP LZH

Produck IRD

Skip download Mewver

Position Tvpe ACTUAL

Collateral Context default
Attributes

» CCP - Select LCH.
»  Product - Select IRD.
»  Skip download - Select Always if already downloaded, or Never.

You can skip the download of the CCP files if the files have already been downloaded, or if you download
them using another process.

»  Origin — Select HOUSE, CLIENT or BOTH as needed.
»  Position Type - Select ACTUAL or THEORETICAL.

» Collateral Context - Select a collateral context as needed.

The margin call trades are created with Keyword.CCPSettlementType="SOD". The counterparty role is set to the
OrdererRole if set on the margin call contracts, or CounterParty otherwise.

The domain “Clearing.SOD.IgnoreXferStatusOnRerun” can be used to store transfer status codes to prevent “*SOD”
trades modifications. The scheduled task will not modify existing "SOD"” trades if their transfers are in these
statuses codes.
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10.7 CLEARING_INTRADAY_MARGIN

This scheduled task can be executed at any time during the day to generate intraday margin calls for LCH. You
may set it up to run every half hour for example.

You need to configure the scheduled task for LCH, and for IRD products.

=l Task Attrihutés

Ledger Type cov

CCP LCH

Product IRD

Mode Both
Attributes

» Ledger Type - Select COV, NON-COV, or ALL.
» CCP - Select LCH.

»  Product - Select IRD.

» Select the mode: Client, House, or Both.

This only applies to LCH - Select Client to import client files only, House to import house files only, or Both
to import both.

This scheduled task downloads the “Report 33a” from LCH and generates margin call trades of type
ITD_COLLATERAL for each PPS Call entry that is after the time specified in the domain
“Clearing.LCH.ExcludeBankingCallTime” with the 24 hour format “hh:mm”. For example 09:30 is 09:30 am. Any
entries before that time will be excluded.

The margin call trades are associated with the IM contracts (client for "C” PPS Call entries, or house for “H” PPS
Call entries) of the clearing member facing the CCP, and can be viewed in the Collateral Manager as “previous
margin”, so that they will not be called again during the EOD process.

The following keywords are populated on the ITD_COLLATERAL trades:

e  CCPAccountReference = CCP_REFERENCE from additional info of IM MCC which can be "C" or "H" or
position account id for ISA

e IS_CLIENT=False (since it is CCP facing trade)

e RelatedProductType=IRD (PRODUCT_TYPE from additional info of IM MCC)

e CCPSettlementType=ITD

e CCPLedgerType = COV for cash cover IM, or NON-COV for non-cash cover (interest and fees)
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10.8 CLEARING_INTRADAY_SETTLEMENT

GBP FRAs are supported with or without intraday processing (same day settlement).

To import GBP FRAs intraday, you need to use the scheduled task CLEARING_INTRADAY_SETTLEMENT as described
below (only applies to LCH).

Otherwise, if you want to import GBP FRAs with settlement at T+1 (like other FRA trades), use the scheduled task
CLEARING_PROCESS_FROM_CDML.

10.8.1 Intraday Setup Requirements

Domain “"ProcessGBPFRAIntraday”

You need to add the value True to the domain “ProcessGBPFRAIntraday” to import GBP FRAs intraday. It is not set
by default (no intraday processing).

ZDumain ¥alues Window (User: calypso_user)

Find

Domain “"XferAvailableDate”

The Available Date is populated differently for GBP FRA trades and the other trades in order to allow trades that
settle on different days to be included in the Client Statement.

You need to setup the following for GBP FRA trades:

e Value = “0.GBP FRA Intraday CT” where “"GBP FRA Intraday CT"” is a static data filter that filters GBP FRAs
- The available date will be set to the settlement date.
- XerdvaiabieDate

Y 0. GBP FRA Intraday CT

- 42 -2 TPLUS2CCY
- 4% -1.EOD CT
‘.. 4% -1, AVDATEFORSIMPLEXFER

Static Data Filter

ZStatic Data Filter Window [130007SPZ,/CLEARING_25/] {(User: calypso_us... [lj=]

Name:lGBF‘ FRA Intraday CT Aftributes. .. Simnulate. ..
Cu:umment:l Pending Modifs
Gru:uups:l.ﬁ.r'-h’ |
Akkribuke Criteria Filker Waluels)
KEvWORD, RelatedProduct Type I add  |GEP_FRA
Product Twpe I add  |(ClearingTransfer

10.8.2 Scheduled Task CLEARING_INTRADAY_SETTLEMENT

To import GBP FRAs intraday, you need to configure a scheduled task CLEARING_INTRADAY_SETTLEMENT.

This scheduled task creates CASH_SETTLEMENT clearing transfer trades with CS_FRA_PAYMENT and
CS_VARIATON_MARGIN fees.
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Task Type ICLEARING_INTRADM_SETTLEMEr'-.IT =]

External Reference IGBF‘FF{A

Description ICIearing Intraday Settlement For GBP FRA

Attempts |1

Retry After, In Minutes IEI

Memory Setktings  Min Memary 312 m Mazx Merory |1I324 m

fllow Task Ta [ Send Emails [ Publish Business Events To userl j
Common Attributes
El Task Attributes
P LiZH
Product IRD
Mode Bioth
Skip download If already downloaded
Attributes

»  Select the CCP: LCH (only LCH is currently supported)
»  Select the product: IRD.
»  Select the mode: Client, House, or Both.

This only applies to LCH - Select Client to import client files only, House to import house files only, or Both
to import both.

»  Select to skip file download: Always, If already downloaded, or Never.

You can skip the download of the CCP files if the files have already been downloaded, or if you download
them using another process.

This scheduled task processes the files 104 and 104c:

e CS_FRA_PAYMENT fee = “"FRASettlementAmount” column
e CS_VARIATION fee = “PreviousTradelLevelNPV” column

The trade keyword RelatedProductType is set to GBP_FRA.

For intraday GBP FRAs, all the fees attached to the CASH_SETTLEMENT clearing transfer trades have Fee Date =
Fee Start Date = Fee End Date = Fee Known Date = Trade Settle Date.
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10.9 CLEARING_HOLIDAY_PROCESSING

The scheduled task CLEARING_HOLIDAY_PROCESSING allows generating Clearing Transfer trades, Collateral
Exposure trades and PL Marks, on an ad-hoc basis, when the CCP does not provide EOD files because of a CCP
holiday.

It should be run on CCP holidays when the CCP does not provide the EOD files.

Task Type ICLE.C'.RII"-.IG_HOLIDM’_F'ROCESSING

External Reference IH-::Iiu:Ia';.f Processing

Cornrments I

Descripkion I

Attempts |1

Retry After, In Minutes IEI

I¥M Settings I-bﬁ'msSlZm -amx1024m -Kx:MaxPermSize=256m

Al Task To [ Skip Execute [ Sernd Emails [~ Publish Business

Common Attributes
[l Task Attributes

P ZME

Produck IRD

Mode Client

Processing Far PL MARES
Attributes

»  Select the CCP.

»  Select the product.

» Select the mode: Client, House, or Both.

» Select the type of processing: CLEARING TRANSFER, COLLATERAL EXPOSURE, or PL MARKS.

For CLEARING TRANSFER, the scheduled task creates Clearing Transfers trades for the given valuation date. It
copies the NPV from the previous business day, and generates reversals accordingly.

For COLLATERAL EXPOSURE, the scheduled task creates Collateral Exposure trades for the given valuation date. It
copies the following measure from the previous business day:

e  MAINTENANCE_REQUIREMENT
e MARGIN_CALL
e INITIAL_MARGIN
e LIQUIDITY_MARGIN
e ADDITIONAL_MARGIN
e BASIS_RISK_MARGIN
e CREDIT_MULTIPLIER_MARGIN
For PL MARKS, the scheduled task copies PL MARKS for the given valuation date from the previous business day.
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10.10CLEARING_IMPORT_MARKET_DATA

You can import the following quotes using the scheduled task CLEARING_IMPORT_MARKET_DATA.

10.10.1 LCH PAI Quotes

PAI quotes are imported from report LCH REPO00016c.

For PAI Quotes, the Interface Value in the Calypso Mapping Window should simply be in the format "CCYPAI”, for
instance USDPAI, CADPAI, etc. We will associate a single PAI rate per currency.

Mame:  [LCH/CQuokes

Inketface Yalue:  [CADPAIL

Calypso Yalue: MM, CAD,CORRA,OD.LCH

CLEARING_IMPORT_MARKET_DATA import:

Common Attributes

= Task attributes
CCP LZH
Market Daka Types Quotes

Market Data Types = Quotes

10.10.1 LCH LDR Rates

The LDR rates are imported from report LCH REPO0017.

For LDR Rates, the Interface Value should be in the format CCY~INDEX~QOISOD~LDR, for instance
DKK~DENTNIN~OISOD~LDR.

Mame:  |[LCHjQuokes

Interface Yalue:  [CAD~CORRA~OISOD-LDR,

Calypso Walue:  [MM.CADCORRA, QD LCHLDR,

CLEARING_IMPORT_MARKET_DATA import:

Common Attributes

= Task Attributes
P LZH
Market Daka Types Quokes

Market Data Types = Quotes

10.10.1 LCH CDR Rates

The CDR rates are imported from report LCH REP0O0017a.

For CDR Rates, the Interface Value should be in the format CCY~INDEX~OISOD~CDR, for instance
GBP~SONIA~OISOD~CDR.

Obviously, the Calypso Quote names will depend on the Rate Index definition in each environment.
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Mame:  |LCHQuokes

Interface Yalue:  |USD~Fed Funds~2I500--C0R,

Calypso Walue: MM, USD,FEDFUMNDS. 0D, LCHCDR

CLEARING_IMPORT_MARKET_DATA import:

Common Attributes

= Task Attributes
P LZH
Market Daka Types Quokes

Market Data Types = Quotes

10.10.2 LCH Bond Prices

The bond prices are imported from report LCH REP0O0034 based on the bonds’ ISIN code. No data mapping is
required.

[NOTE: The prices are imported into the quote set of the pricing environment defined in the scheduled task]
CLEARING_IMPORT_MARKET_DATA import:

Common Attributes
=l Task Attributes
P LZH
Market Data Types Collateral Guotes

Market Data Types = Collateral Quotes

10.10.3 CME FX NDF Rate Resets

The FX NDF rate resets are imported from report CME FXNDF.

The mapping between the FX Reset and the quote is done for CME/Quotes in the Calypso Mapping window as:
e Interface Value = FX.<ccyl>.<ccy2>.<CME FX reset>.<source>
e Calypso Value = FX.<ccyl>.<ccy2>.<Calypso FX Reset>.<source>

Example:

Mame:  |CME/Quotes

Interface Yalue: [P, US0D,CHY USDCNY, SAEC

Calypso Yalug: [P, S0, CHYCRYOL, SAEC

[NOTE: The quotes are imported into the quote set of the pricing environment defined in the scheduled task]

CLEARING_IMPORT_MARKET_DATA import:

Common Attributes

El Task Attributes
P ZME
Market Data Types Fi Rate Resets

Market Data Types = FX Rate Resets
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Please consider QUOTE_ALLOW_IN_FUTURE=false and QUOTE_MAX_DAY_FUTURE environment property so that
the system will not populate values in the future. Also, make sure that you add the appropriate default source in FX
Rate Definition window (SAEC for example).

10.10.4 LCH/ Comder FX Spot Rates by Currency Pair

FX Spot quotes are imported from reports FXMD0001 (LCH) and SpotQuote (Comder).
Calypso Mapping window:

Mame:  |LCH/Quotes

Interface Yalue:  |ALUD/ELR

Calypso Yalug:  |Fx.ELR. ALD

CLEARING_IMPORT_MARKET_DATA import:

Common Attributes

= Task Attributes
P LZH
Market Daka Types Quotes

Market Data Types = Quotes

10.10.5 LCH / Comder NDF Fixing Rates

NDF fixing rates are imported from reports FXMD0010 (LCH) and SpotQuote (Comder).

You need to define the FX Resets using Configuration > Foreign Exchange > FX Rate Definitions.

CLEARING_IMPORT_MARKET_DATA import:

Common Attributes
E Task Attributes
P LZH
Market Data Types Cuotes NDF

Market Data Types = Quotes NDF
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10.11CLEARING_STATEMENT

This scheduled task generates Statement events that are sent to the Message engine to generate the actual client
statements based on the message configuration for the message type “"CLEARING_STATEMENT". It can be run for
all the CCPs that the clients use for clearing. It generates one statement per client.

Task Description

Task Type: | CLEARING_STATEMENT

External Reference: IEI.EIEIEII DAILY Cl501

Comments: IEI.EIEIEII DaIly CUS01

Descripkion: IEI.EIEIEII DaIly CUS01

Execution Pararneters

Attempts: |1 Retry After; IIII minukes Expected Execution

IVM Settings: I-XX:MaxPermSize=192M -Dijava.util, Arrays, uselegacyMergesort=true

Log Settings: I

Tazk Motification Options

[T SendEmails [ Publish Business Events  To User: j
C_Ps CME,LZH, ICE CLEAR, CREDIT
Skakic Data Filker
Clienk 501
Layouk Style Defaulk
Mode Draily
Mew Trades for IRS 0001 - CALYPUS Mew Trades IRD
Mew Trades For FXhDF 0001 - CALYPUS Mew Trades MDF
Mew Trades For CDi
Cpen Trades far IRS 001 - CALYPUS Open Trades IRD
Cpen Trades for FEMDF 0001 - CALYPUS Open Trades NDF
Cpen Trades Far CO¥
Terminated Trades for [R5 001 - CALYPUS Terminated Trades IRD
Terminated Trades For FXMDF 0001 - CALYPUS Terminated Trades MDF
Terminated Trades For COi
Matured Trades for IRS
Matured Trades For FXMDF
Matured Trades For CDX
Account Ackivity Template SWAP-ACTIVITY
Collateral Position Template S AP-MCPOSITICN
Collateral Allocation Template S AP-MCALLOCATION
Collakeral Context def aulk
Attributes

» CCPs - Select the CCPs for which you want to consolidate the client statement.

»  Static Data Filter — You can select a static data filter that contains legal entity attributes to select the
corresponding clients. This only applies if ALL is selected for the Client attribute.

In order to allow the static data filter to contain legal entity attributes, you need to add the value
ClearingLEAttribute to the domain “CustomStaticDataFilter”.

» Client - Select the client for which you want to generate the client statement, or ALL for all clients (or all
clients satisfying the static data filter if set).

» Layout Style: Select “"Default”, “*Condensed” or “CondensedAccount”.
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»

»

»

»
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»
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»

»

»

»

»

»

»

»

»

In the Condensed Client Statement, all pending settlements are aggregated in 1 row, and the following
sections are included in the Clearing Cash Flows Summary:

- Separate Settlements
- Initial Margin Summary
- Summary of Payments

The CondensedAccount statement is only available for client facing clearing accounts with have account
attribute CCPAccountStructure = ISA, and for Mode = ISA Daily. It uses the template
CondensedAccountClearingStatement available in both HTML and PDF format.

Mode - Select the mode: Daily to get the daily activity, Monthly to get the month to date activity, or
Parent Daily to get parent level daily activity.

See Parent Clearing Statement for “Parent Daily” setup requirements.

ETD Position Spec - Not currently used.

New Trades for IRS - Select the Trade Browser template for new IRD trades.

New Trades for FXNDF - Select the Trade Browser template for new FX NDF trades.

New Trades for CDX - Select the Trade Browser template for new CDX trades.

Open Trades for IRS - Select the Trade Browser template for open IRD trades.

Open Trades for FXNDF - Select the Trade Browser template for open FX NDF trades.

Open Trades for CDX - Select the Trade Browser template for open CDX trades.

Terminated Trades for IRS - Select the Trade Browser template for terminated IRD trades.
Terminated Trades for FXNDF - Select the Trade Browser template for terminated FX NDF trades.
Terminated Trades for CDX - Select the Trade Browser template for terminated CDX trades.
Matured Trades for IRS - Select the Trade Browser template for matured IRD trades.
Matured Trades for FXNDF - Select the Trade Browser template for matured FX NDF trades.
Matured Trades for CDX - Select the Trade Browser template for matured CDX trades.
Account Activity Template - Select the Account Activity report template.

Collateral Position Template - Select the Collateral Position report template.

Collateral Allocation Template - Select the Collateral Allocation report template.

Collateral Context — Select “default”.

The report templates are described below.

Performance Enhancements

To improve the performance, you can set the following JVM parameters:
"-XX:UseConcMarkSweepGC -Xms1g -Xmx4g -XX:MaxPermSize=384m"

You can also set the number of threads to use when generating client statements in the domain
“Clearing.Statement.parallel.numThreads”.

New Trades for IRS Template

Trade Browser template.

From the Calypso Navigator, navigate to Deal Management > Trade Browser.

[NOTE: Make sure that the “Trade Currency” column is selected as part of the Column Configuration]
Example = “001 - Calypso US New Trades IRD"”
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Critetia

Template Description I

Trads Startl | jl | E“dl |+ jl =
Endl |+ jl j
Process Startl I' jl j Endl |+ jl j

Settle Start I I =

L

Maturty  Start [ =l = e [+ =] = open
Tradetd | =l _l
Trade Attrbute  [15_CLIENT =) contains e
Buy/sel | | max ows |
Bundls ;”Id jl _l
P rele: AL l—_l

Processing Org ICF\LYPSO_US | [~ Include Child Legal Entities

e  Trade Attribute = IS_CLIENT Contains true
e  Processing org = <the clearing member>
e Trade Filter = New Trades

e  Product Type = Swap, FRA

e  Status = CLEARED, VERIFIED

[~ Undo Date

Trade Filter INew Trades j

5D Filker |

Filter Set |

CUrrency I

Product Family I

Product Tvpe ISwap, FRA

Product Id I

Books I

Skatus ICLEF\RED,‘\I‘ERIFIED

EIEIE] ElEIEIEIE]

Ackion I

The criteria of the “"New Trades” trade filter are the following - It loads trades cleared today.

Post Processing r Position Spec |/ Counterparty |/ Fund |/ Diary Criteria |

Ranges |/ Date J Time |/Pruduct Criteria |/Trade Criteria |/ Underhing Security r Custom Criteria

Criterion Name |ClearedDate v| 7

min|0er1s2012 |- w 0D | Max|06r152012 ||+ » 0D |

New Trades for FX NDF Template

Same as New Trades for IRS with Product Type = FXNDF.

New Trades for CDX Template
Same as New Trades for IRS with Product Type

Open Trades for IRS Template

Trade Browser template.

CreditDefaultSwap, CDSIndex.

From the Calypso Navigator, navigate to Deal Management > Trade Browser.

[NOTE: Make sure that the “Trade Currency” column is selected as part of the Column Configuration]

Example = 001 - Calypso US Open Trades IRD"”
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Criteria
Template Description | [ Unda Date
Trade Startl | jl | Endl |+ jl | Trade Filker IOpenTrades |
Settle  Start| [ = Rd = = SDFiter | _I
Process  Start| [ =l = e [+ =l = Fiter Set. | _I
Matuty st [ Rl = e [+ =l =]r osen curency | ]
Trade Id IID j| _l Product Family | _I
Trade Attribute IIS_CLIENT ~|  contains Itrue Product Type ISwap,FR.ﬁ. _I
Buyjsel | = | Max Rows | Product 1d |
o e | o .y o
P rale: ALL Status D, ¥ALIDATED, WAIT_RETRY _l
Processngorg [cAveso s .o | I Inciuds Chid Leg Entiiss ction | [ |

e Trade Attribute = IS_CLIENT Contains true
e  Processing org = <the clearing member>
e Trade Filter = Open Trades

e  Product Type = Swap, FRA

e  Status = CLEARED, VERIFIED

The criteria of the “Open Trades” trade filter are the following - It loads trades cleared before today.

Post Processing |/ Position Spec |/ Counterparty |/ Fund |/ Diary Criteria |
Ranges |/ Date | Time |/F'ruduct Criteria |/Trade Criteria |/ Underhing Security |/ Custom Criteria

_'T Hew Rule | g Remove All Rules EI: Collapse | Expand Panels

MaturityDate is after today X &
MaturityDate - is after b today -
[ Include null
TerminationDate is after today o x
TerminationDate b is after * | | today b

i Has keyword @ Has not keyword

[ Include null
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Post Processing r Position Spec |/ Counterparty r Fund r Diary Criteria |

Ranges |/ Date / Time |/ Product Criteria r Trade Criteria r Underking Security |T Custom Criteria

Criterion Name |ClearedDate v| 7

Min | - =] ~] Max|0/14i2012 |- w [ 1D

Open Trades for FX NDF Template
Same as Open Trades for IRS with Product Type = FXNDF.

Open Trades for CDX Template
Same as Open Trades for IRS with Product Type = CreditDefaultSwap, CDSIndex.

Terminated Trades for IRD Template
Trade Browser template.

From the Calypso Navigator, navigate to Deal Management > Trade Browser.

[NOTE: Make sure that the “Trade Currency” column is selected as part of the Column Configuration]

Example = 001 - Calypso US Terminated Trades IRD”

Criteria

Template Description I [~ Undo Date

Trade Stark I

Endl |+ jl j Trade Filker ITERM Trades j

Settle  Start |

Endl |+ jl =l 5D Filter |

Process Skark I

Endl |+ j| =l Filter Set |

EN{ENIER(EN

Maturity Stark I

Endl |+ jl jr Open Currency I

|;_I‘_I;I‘_I;

Trade Id IID j|

Product Farnily I

Trade Attribute IIS_CLIENT j Contains Itrue Product Type ISwap,FRF\
Buy/Sel I j Max Rows# I Product Id I
Bundle ||Id jl | Boaks

|
CF role: AL Status |
|

Processing Org ICF\LYPSO_US | I Include Child Legal Entities Action

e Trade Attribute = IS_CLIENT Contains true
e  Processing org = <the clearing member>
e  Trade Filter = TERM Trades

e  Product Type = Swap, FRA

e  Status = Not set

0 5 3 11 1

The criteria of the “TERM Trades” trade filter are the following - It loads trades terminated today.
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Post Processing |/ Position Spec |/ Counterparty |/ Fund |/ Diary Criteria |

186

Ranges r Date / Time |/ Product Criteria |/ Trade Criteria |/ Underhing Security |/ Custom Criteria

l_‘i' Hew Rule @ Remove All Rules El: Collapse ! Expand Panels

MaturityDate is on or after today include null A n
MaturityDate b is on or after | | today -
[¥] Include null
TerminationDate within the last 1 daw(s) include null X%
TerminationDate ¥ | | within the last n 1 n

1"&

day(s)

[¥] Include null

@ Has keyword  Has not keyword

Post Processing r Position Spec r Counterparty r Fund r Diary Criteria |

Ranges r Date / Time |/ Product Criteria |/ Trade Criteria |/ Underhing Security |/ Custom Criteria |

Wi BUY [v] SELL

Internal Reference [v] IN

Bundle

|l ~]] ]

Bundle Attrilnte

Book [v] IM
Trader [¥] IN
Status [v] IN

Sales [v] IN

MATURED TERMIMATED

Book Attribute

Keyword Value

Keyword | Has

d

TerminationDate, TerminationTradeDate

Terminated Trades for FX NDF Template
Same as Terminated Trades for IRS with Product Type = FXNDF.

Terminated Trades for CDX Template
Same as Terminated Trades for IRS with Product Type = CreditDefaultSwap, CDSIndex.
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Matured Trades for IRD Template

Trade Browser template.

From the Calypso Navigator, navigate to Deal Management > Trade Browser.

[NOTE: Make sure that the “Trade Currency” column is selected as part of the Column Configuration]
Example = “001 - Calypso US Matured Trades IRD”

Criteria
Template Description | | ] Undo Date
Trade  Start| |- =] | Enq |+~ -] Trade Fiter | ALL |
Settle  Start| |- »[| <] End [+~ =] SD Filter | [ -]
Process Start| || VH 'l End| ||+ VH Vl Filter Set | || |
Maturity  startjo0s2013 | v | w|  Endpsosiooiz| v w|Topen Currency | | =]
Tradeld [D ]| | =] Product Family | L]
Trade Attribute | IS_CLIENT v | contains  fiue | Product Type | Swap FRA [ -]
Buy'sell | ~| maxro. | | ProductId | |
Bundie ||j|ld v|| ||j Books | || |
CP role: ALL [cUS01 | -] Status |-XERCISED, TERMINATED)|| .. |
Processing Org |CALYPUS | . | O mciude chila Legal Entities Action | | =]

e  Maturity Date = <today>

e  Trade Attribute = IS_CLIENT Contains true

e  Processing org = <the clearing member>

e Trade Filter = ALL

e  Product Type = Swap, FRA

e  Status = PENDING, PRICING, VERIFIED, ALLOCATED, ROLLOVERED, MATURED, EXERCISED, TERMINATED

Matured Trades for FX NDF Template
Same as Matured Trades for IRS with Product Type = FXNDF.

Matured Trades for CDX Template
Same as Matured Trades for IRS with Product Type

CreditDefaultSwap, CDSIndex.

Account Activity Template

Account Activity report template.

From the Calypso Navigator, navigate to Reports > Nostro/Custodian Positions > Account Activity.
[NOTE: Make sure that the “Currency” column is selected]

Example = “SWAP-ACTIVITY”
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Criteria
Template Description I
Start ID4,|'18||'2013 | | IDD ~| End |D4||'18,|'2013 |+ ~| IDD | Init Date INONE =
Position Date I.ﬁ.vailable j ProcessingOrg Cash/fSec ICash j
Position Class ICIient j Cpty Id = Currency IZAD,CHF,EUR,GBP,JPV =
Position Tvpe I.ﬁ.ctual j Account Id I _l IName jl
Position Dekail IStart,l'End j [+ Detail by Socount [~ Show Only Positions [~ Metting
Pasition Yalue IQuantity j [ Exclude Unchanged Positions [ Display

e Start and End = 0D

e  Position Date = Available

e  Position Class = Client

e  Position Type = Actual

e  Detail by Account = Checked

e  Currency = <list of currencies>

Make sure to select the currencies that you want to monitor.

This is a sample setup. You may choose the settings of the fields based on your business requirements.

You can define the flows that you want to filter out from the Account Activity section of the Client Statement in the

domain “NPVFlows” and “"NPVReversalFlows”.

The domain “"NPVFlows” contains NPV non-reversal flows, by default:
e CS_NPV_ADIJUSTED
e NPV_ADJUSTED

e[ NPYFlovs
- A CS_NPY_ADIUSTED
42 NPY_ADIUSTED

The domain “NPVReversalFlows” contains NPV reversal flows, by default:
e NPV_REV
e CS_NPV_REV

Elj MNPYReversalFlows

: & CS5_MPY_REW
Lo MPY_REY

Collateral Position Template

Margin Call Position Entry report.

From the Calypso Navigator, navigate to Processing > Collateral Management > Collateral Manager - Report

available under Window > Report > Position).
Example = "SWAP-MCPOSITION"” (today’s actual Margin_Call positions)
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MarginCallPositionEntry Report (418,13 2:26:16 PM) / SWAP-MCPOSITION (User: calypso_user)

Report  Dakta  Wiew  Export Market Dabs Utlities  Help

EXEIE)
Criteria
MMatginCallEntry Pasition
Process Date ! Startl I- jl j Endl |+ jl j Pricing Status :
Yalue Date : StartIU4,|'18,|'2013 | jIDD j Endluofhajzma |+ jIDD j Fosition Type : ACTUAL

Processing Crg I | Contrack : I | Currency
CP role; ALL I | Contract Types I | Underlying Type :

e Value Date Start and End = 0D
e  Position Type = ACTUAL

1]

Collateral Allocation Template
Margin Call Allocation Entry report.

From the Calypso Navigator, navigate to Processing > Collateral Management > Collateral Manager - Report
available under Window > Report > Allocation).

Example = "SWAP-MCALLOCATION” (today’s margin call trades)

zMarginEallAllDEatiDnEntry Report {4/18/13 2:23:50 PM} / SWAP-MCALLOCATION {User: calypso_user)

Report Data Miew Export  [(Market Data Utilities  Help
B 3| o

| Criteria

MarginiZallEntry

Process Date : Startllil4,|'18,l'2l]13 | jIDD j EndIIZI4,|'18,|'2I313 |+ j|nn j
Walue Date : Startl I jl j En-:ll |+ jl j

®  Process Date Start and End = 0D

Please refer to the Calypso Clearing Member User Guide for sample client statements and complete details.

10.12Parent Clearing Statement

This mode pertains to multi branch account structure wherein buy side has various funds which are clearing trades
under parent entity. Buy side generally have each fund acting as cost center hence some flows of VM need to be
accounted for at fund level however IM needs to be calculated at parent entity level taking offsetting risk
advantage across all funds.

You can decide which flows need to be settled at parent level using the parent SDI functionality with environment
property LOOK_PARENT_SDI = true and margin call contract attribute CLOUD_NET. The SDIs can be configured so
that the system uses the parent SDIs to settle the flows defined in CLOUD_NET, and specific netting can be
configured for those flows. The child SDIs are used otherwise.

The clearing statement allows reporting these flows using the scheduled task attribute Mode = Parent Daily. This
only applies with the Default layout style.

10.12.1 Domain Values

Add the following domain values.
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Domain “mccAdditionalField.CLOUD_NET” - Possible list of flows that can be netted. For example: ALL, COUPON,
PAI, VM. This is user-defined.

I pomain Values Window _ O] x|
Search: Icloud_net Find ||_ Value :
- mecAdditionalField. CLIENT_TRANSFERS ] Name: Imccﬁdd'rtionalField.CLOUD_NEr

- mecAdditionalField. CLOUD_CLEARING
imecAdditionalField.CLOUD_NET Value: I
2 ALL
i* COUPON Comment; |
L PAI [

£ VM << Add | Save Abo... |
+ | mecAdditionalField. DISPUTE_COMMENT _MANDATC
'I‘ __1 mrradditinnalFiald NTSRIITE COMMERMNT MAMDATC ™ . e P e I

Domain “tradeKeyword”:

Value = CLOUD_NET

Domain “XferAttributes”

Values=CLOUD_NET

Make sure that CLOUD_NET is added to the domains “Clearing.MCC.propagateFields” and
“PropagateTradeKeyword” so that it can be propagated to margin call trades and transfer attributes to be used in
static data filters and netting configurations as needed.

10.12.2 Workflow

Make sure that the rule UpdateClearingMarginCallKeywords is set on the MarginCall workflow transition NONE -
NEW - XXX.

Make sure that the rule PropagateTradeKeyword is set on the Transfer workflow transition NONE - NEW — XXX.

10.12.3 Legal Entities

Define Parent/ Child relationships between Parent fund and child entities as shown below.

Example: FUND_A child of parent LEADFUND

I Legal Entity- Version - 1 [1400225P2/V140TC/calypso_user]

Utiities Help
Short Name [FUND_A Status |Enabled =
Full Name [FUND_A Role... |Client
| Parent [LEADFUND || CounterParty
Statement Recipient
Country [NONE =]
Inactive As Fr... | User Icalypsofuser
Entered Date [03/02/2017 |5:15:56 AM —I
Disabled Role(s)
External Ref I
& Financial
Holida sl
¥ —I " Non Financial
I= | Triparty Substitutions

10.12.4 Margin Call Contracts

Set the attribute CLOUD_NET as needed for contracts that should be settled and netted at parent level.
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In the example below, child FUND_A is settling VM and PAI through its parent entity LEADFUND. Coupons are
directly settled by FUND_A. PAI has as separated netting bucket and VM is netted in a general bucket.

| A Margin Call Window - Version - 2

Edt

o]

FUNDA_VM_USD ] |OPEN__[6/25/12 3:09:00.000 PM ED
| 30901/FUNDA_PAL USD _/ [OPEN__[6/25/12 3:09:00.000 PM ED
[ 30902|FUNDA_COUPON_USD [Client . ¢ |OPEN  |6/25/12 3:09:00.000 PM ED'

.

Make sure that the attributes INCLUDED_VM_FLOWS and CLOUD_NET are compatible:

e CLOUD_NET can be ALL or empty, if INCLUDED_VM_FLOWS is empty.

e CLOUD_NET can be ALL or a subset of INCLUDED_VM_FLOWS, or empty, if INCLUDED_VM_FLOWS is not
empty.

10.12.5 Settlement Instructions

Parent Level

SWIFT SDIs should be set up at Parent level to instruct the payments of all children entities (including the parent
itself when acting as a child entity) that are in scope, i.e. for transactions that are settled/ netted at the parent
level.

Example:
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[ Settlement Delivery Instructions [1400225P2/V140TC/]

[cient 7]

feormo | |

[ oy — L
T ot Coudver |
o ] T
[swergow ——— F

TSR N
| -

fow —— lafwe[

[ static Data Filter Window [140022S5P2/V140TC/]

KEYWORD.CLOUD_NET - IS_HOT_NULL . r | |

g |

—
-

Child Level

The only SWIFT SDIs required at Child level are the SDIs of the settlements that will be directly instructed by the
Child fund, i.e. not applicable for Parent netting and settlement.

It is necessary to specify in a filter the applicable flows for the SDI. Note that this SDI needs also to be set up for
the parent entity when it acting as a child entity and no netting is required

Example: FUND_A settles the coupons at Child level.
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[ Settlement Delfivery Instructions [140022SP2/V140TC/]

7.7.7.5 ct
fow — Lafwe[ T
et &
I
L |I

I— I Authorization

Static Data Filter Window [1400225P2/V140TC/]

Potcoudeting
_ mmibwe | citeds | |  Ftervauety) [ |
KEwoRD.COWDNET  mwee |

—

_ Awbues.. | smuste. |
=

10.12.6 Netting Method

Clearing Member Setup Guide

This netting method will be used to create the netting buckets as defined on the underlying MCC. For instance, if a
Fund has a separate PAI contract where CLOUD_NET is set to PAI and 2 further separate VM and Coupon contracts
where CLOUD_NET is set to ALL, then the system will create 2 netting buckets: 1 for the netting by flow type for

PAI only and the other for the contracts that are tagged as ALL.

Create new netting type, for instance CloudNet.
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Additional Netting Type

Netting Config Window

ALL

MarginCall

Cloud_Netting_Method ||

Specify in the filter which flow types should be included in this netting method:
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Name:[Cloud_Netting_Method Atributes... | Simulate.. |
Commnt:l Pending Modifs |
Groups:IANY _l
Attribute Criteria Filter Value(s)
KEYWORD.CLOUD_NET IS_MNOT_MULL

10.12.7 Parent Statement

The CLEARING_STATEMENT scheduled task is used to trigger the parent statement using Mode = Parent Daily and
the following attributes:

e CCPs - List of CCPs in scope for the statement

e Client - Should bet set to the Parent Entity(ies) only

e layout - Default. Condensed is currently not supported for Parent statement
e Trade reports - Currently not supported, should be left empty

e  Other reports - Same as default daily statement

Bl Task Attributes

CCPs LCH

Static Data Filter

Client LEADFUND
Layout Style Default

Mode Parent Daily
New Trades for IRS

Mew Trades for FXNDF

Mew Trades for CDX

Open Trades for IRS

Open Trades for FXNDF

Open Trades for CDX

Terminated Trades for IRS

Terminated Trades for FXNDF

Terminated Trades for CDX

Matured Trades for IRS

Matured Trades for FXNDF

Matured Trades for CDX

Account Activity Template PO1_STMT_ACTIVITY

Collateral Position Template PO1_STMT_MC_POSITION
Collateral Allocation Template PO1_STMT_MC_ALLOCATION
Collateral Context EOD_COLLATERAL_CONTEXT

The Parent Daily Statement is an aggregation of all the flows of the Child entities that are tagged with the MCC
attribute CLOUD_NET. The statement is based on the default daily statement and follows the same logic.

The Parent statement can be distinguished from the child statement by looking at BO Message Attribute
“Statement Type”: Set to PARENT DAILY for the parent statement and DAILY for the child statement.

A cawypso

Parent Daily Statement on 2017-04-05 for LeadFund

LeadFund

Financial Summary

Clearing Cash Flows Summary

Beginning Cash Balance | -459,652 00 | -459,652.00

Commissions/Fees 0.00 000
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10.13Scheduled Tasks Execution

The scheduled tasks are executed by the Calypso Scheduler once you have defined triggers as described in the
Calypso Scheduled Tasks User Guide.

Important Note — Timezones Considerations

In order to successfully process scheduled tasks which combine the import and processing of EOD files, you need
to run the relevant scheduled tasks for a given day before the EOD of the books where the trades are
saved, based on the book’s timezone.

For example, the book’s timezone is New York EOD 5pm. To process today’s files, you need to run the scheduled
tasks before 5pm New York time, regardless of where you run the scheduled tasks from, so that the trades are
timestamped as of today, and the settlement date is computed from today.

Order of Execution
They should be executed in the following order:
e CLEARING_SOD_MARGINCALL (start of day)
e CLEARING_INTRADAY_MARGIN (every half hour during the day)
e CLEARING_TRANSLATE_TO_CDML
e CLEARING_PROCESS_FROM_CDML
e CLEARING_INTRADAY_SETTLEMENT (for intraday GBP FRAs only)
e  COLLATERAL_MANAGEMENT
e CLEARING_STATEMENT
e ERS_ANALYSIS
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Section 11. Intraday Margin Calls to Clients

This section describes the setup for making intraday margin calls to clients, and sending XML margin call
notifications.

Intraday margin calls to clients follow the diagram below.

Intraday MC Notification
Message through E-Mail

= ?=‘<(~-,~q'_-':f:’3 ]

Bk e B Pl

Send Funding Cost Info in
-, A Daily and Monthly
o - Client Statement

11.1 PL Mark Mapping

In this process we translate yyyymmdd_REP00086¢ - Intraday Margin Split_ “n” into CDML format for intraday
reporting. 86c Intraday contains CoveredLiability = (CoveredIM + CoveredLM + Covered AM + CoveredBR +

CoveredCM + CoveredNPVChange)
This report gives information on intraday initial margin requirements at a portfolio level for client activity.
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e Frequency: Intraday, LCH generates the report every 15 mins

e Report Structure: This report contains the following information
- MbrMnemonic = "ShortName”
- Account ="C" representing client activity
- ReportingCCY = Currency in which CoveredLiability is reported

e Sub Components of CoveredLiability: We are importing the following components for intraday client
reporting purposes along with CoveredLiability in CollateralExposure trades:

- CoveredIM = Initial Margin for all registered trades.

- CoveredLM = Liquidity Margin: Liquidity Risk Multiplier multiplied by the Initial Margin amount.
This is taken from the Previous Days Close of Business.

- CoveredAM = Additional Margin for all registered trades.
- CoveredBR = BR for all registered trades.

- CoveredCM = CM within the total liability amount which has registered a call. This is only
populated should a backload call or a TriReduce call be made.

- CoveredNPVChange = NPV change for all registered trades -i.e. CoveredNPV -
NPVPreviousDay.

- ItdCallAmount = Non-cumulative Intraday call amount.

11.2 Configuration Requirements

11.2.1 Domain Values

In the domain “Clearing.Statement.ITD.useBaseValue” add the value True or False.

e If true, amounts are converted to the base currency of the collateral context.

e If false, amounts are converted to the contract currency of the LCH IM contracts.

11.2.2 Date Rule Setup

The following date rules are needed for the margin call contract for ad-hoc or intraday valuation.

Daily date rule for Valuation Date Frequency

_igix
Name  [Daiy Type [DALLY ~|
Day I':I— Add Dayslﬂ_ WeekDay INGNE j
Month |41 [ Rark [1/01E ~|

selectAl | Unselect Al |

Date Roll |NO_CHANGE |

v Jan |v Feb [v Mar
i I " Bus [+ Cal Bus Days
At |7 May [ Jun Add Relative Months 0 I ki

Felative Type: -
7l 7 Aug [ Sep ¥pe Holidays INYC |

Relative - i
[+ Oct |« Mov [ Dec I J [T Chedk Holiday

Relative I I |

VD=0D date rule for Valuation Time Offset
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RI=E
Mame Im:u{: Type IRELA‘I'I'IJE j
Day ||:| Add Dayslﬂ WeekDay INDNE j
"""""“j"lj’!‘N = Rank INGNE ~|
Select Al | Unselect &l |
Date Roll IND_CHANGE |
[T dan [T IFeb [T [Mar
i {* Bu ~ cal Bus D
oo [ May | dun Add Relative Months IU 5 ™ BusDays
Relative Type: "
ol leug [sep | Holidays |rwc -]
Absolute -
[T ot [Tinow [T[Dec I - J [T Check Holiday
Relative IDany Im}' |

11.2.3 IM Margin Call Contract Setup

You need to set up Ad-Hoc details for the IM margin call contracts: Check “Ad-Hoc Calls” in the Ad-Hoc Details

panel.

This enables the Valuation details.

-:,.d Margin Call Window - Version - wglég

Margin Call Config  Util  Help

Edit | Browse

Mame : AEGON_IM_LCH_IRS o
Description :

Concentration I Qptimization | Child Configurations I Ratings

Additional Info I Eligible Bo ii ecurities I Eligible Currendes
Parties | Details I Dates & Times | Ad-Hoc Details | Initial Margin | Independent Amount
= | =) el
=l Calls

Ad-Hoc Calls
= | =) el
= Valuation

Valuation Date Frequency Diaily

Valuation Time Offset VD =0D

Valuation Date Time 2:23 pm

Valuation Time Zone AmericaMew_Yark

»  Set the Valuation Date Frequency as Daily and the Valuation Time Offset as the relative date rule based on

the Daily date rule previously defined.
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You also need to set an end-of-day pricing environment and an intraday pricing environment in the Details panel.

| Parties | Details | Dates & Times | Ad-Hoc Details I Initial Margin I Independent Amuuntl

-
] =t e

Perimeter

Workflow

= Details
Status OPEM
Contract Type Client
Contract Group
Contract Direction EILATERAL
Secured Party ProcessingOrg
Rehypotheticable Collateral
End Of Day Pricing Environment FROMDE
Intraday Pricing Environment FROMDE

Indude End Date Exposure

11.2.4 Collateral Contexts

You need to define a collateral context for end-of-day processing, and one for intraday processing.

EOD Collateral Context
It should have Pricing Env Type = EOD, and Valuation = Standard.

It is used for EOD processing in the scheduled task COLLATERAL_MANAGEMENT, and in the Collateral Manager.

_A Collateral Context Configuration . - 8 Elﬂl-g—hj

Collateral Context  Util Help

Mame ; ECD_Collateral_Context 1 ] Default
Description : EQD collateral context 2.3.6-14. 1.0,
Product Definition I Position Definition | Currency Definition
Entry Attrbutes | Allocation Attributes | Workflow | Pricing Context Attributes

=Y P
B 2+|E||Ei%:
= Definition
Pricing Env Type ECD
Rating Scenario
Valuation Standard

ITD Collateral Context
It should have Pricing Env Type=ITD, and Valuation= Adhoc.

It is used for intraday processing in the scheduled task COLLATERAL_MANAGEMENT, and in the Collateral Manager.
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J__ Collateral Context Configuration . » [ — | (5] |_-'E:?-

Collateral Context  Util  Help

Mame ; ITD_Collateral_Context 1 ] Default
Description : ITD collateral context 2.3.6-14. 1.0,
Product Definition | Position Definition | Currency Definition
Entry Atirbutes | Allocation Attributes | Workflow | Pricing Context Attributes

Ay P

1§23 | = | Ll H
= Definition

Pricing Env Type ITD

Rating Scenario

Valuation AdHoc

You can also define a separate collateral workflow for the intraday collateral context using the Workflow panel.

Workflow Setup

You can create a separate Collateral workflow for each context, or add a NEW transition from EXECUTED to
PRICING.

It is also important to have a SUBSTITUTE intermediate transition to apply the workflow rule

SetMarginCallTradeTypeAttribute.
NONE
N
FRICE

PRICING b -

PRICE

PRICED_PAY

PRICED_RECEIVE

PRI
SUBSTYITUTE

AMHND

AGREE_EXPOSURE
PRICED_NO_CALL -

AGREE_EWPOSURE

RETURN
EXPOSURE_AGREED I -  RETURMNED |

ALL TE

RESOLVE_DISFUTE

ALLOCATED I‘//_/DEE\- DISPUTED |
_‘.—I =

VALIDATE

EXECUTE s

o s >
s |+ oeom

EXECUTE
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The workflow rule SetMarginCallTradeTypeAttribute needs to be added on the VALIDATE and SUBSTITUTE
transitions. This rule sets the keyword CCPSettlementType to ITD or EOD based on the Pricing Env Type of the
collateral context.

B workFlow Action -0 x|
Id|14?'62 Acﬁunl'l.-'.ﬁ.LID.b.TE |
Orig Status IALLOCATED | Result Smmsl'l.-'.ﬁ.LID.ﬁ.TED |
Event Class ICnIIateraI SubtypeIALL
PruductIALL Processing DrgIALL
[~ Different User [~ Create Task [¥ Use STP [~ Use KickOfffCut Off
[~ Log Completed ¥ Preferred Action [~ Update Only [T Generate Intermediary Ex
[~ Meeds man. Auth. I_IZI Priority
Rules ISEﬁ'ﬂarginCaIITradeTypeAttribute | Help ... |
B workFlow Action -0 x|
Id |33202 AcﬁunISLIBS'ITI'LI'I'E |
Orig Status IB{ECLI'I'ED | Result SEmSISLIEFITI'LI'I'ED |
Event Class ICuIIateral SubtypeIALL
PruductIALL Processing DrgIALL
[~ Different User [~ Create Task [~ UsesTP [~ Use KickQfffCut Off
[~ Log Completed [” Preferred Action [~ Update Only [T Generate Intermediary Ey
[~ Meeds man. Auth. I_IZI Priority

RulesISeﬁ'ﬂarginCaIITradeTypeAttribute | Help ... |

11.2.5 Processing Org Attributes

You need to specify the following attributes on the processing organization:

e EODCollateralContext — Enter the EOD collateral context. Used to apply on Margin Report filters to
generate appropriate information on ITD notification XML.

e ITDCollateralContext — Enter the ITD collateral context. Used to apply on Margin Report filters to generate
appropriate information on ITD notification XML.

e ImportZeroMarginAmountITD - Used when importing the COVEREDLIABILITY column. Default is true.

- If false, COVEREDLIABILITY and the other PL marks are imported ONLY if ITDCALLAMOUNT
column <> 0

- If true, PL Marks are imported regardless of the value in the ITDCALLAMOUNT column.

e ApplyBufferITD - Used to apply a buffer against intraday margin calls. Default is false.
- If false, no buffer is applied.
- If true, a buffer (multiplier) is applied.
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11.2.6 Intraday Notification Message

The system creates an XML file on creation of the Margin Call Trades for intraday. It is stored into the local folder.
This message is used for client notification and downstream reporting.

Message Setup

Product Type = MarginCall

Message Type = CLEARING_ITD_STATEMENT
Receiver Role = Statement Recipient

Event Type = STATEMENT

Format Type= XML

Edit | Bruwsel
Product Tvpe IMarginCaII Language IEngIlsh J
Event Type I'IJ'ERIFIED_TRP.DE address Type IITD STATEMENT FILE J |
Message Type ICLE.C'.RING_ITD_STF'.TEMENT Gatewary IFILE J
Processing Crg IF'.LL Farmat Tvpe IKML j

PO Conkact Type IDeFauIt Template ICIearingITDStatement.xml

Receiver I.ﬁ.LL S0 Filker IisITDMarginCaIITradeType

Receiver Role IExtCDunterF‘arty [~ Matching

Rec Contact Type IDeFauIt [T Do not Send Message

[T Inactive

R R R

I

Srouping I

Config Id IZBEZDD Delete Save Save As MNew

SD Filter Setup
The static data filter checks the trade keyword MarginCallTradeType.

EEtatic Data Filter Window [142002/CLEARING_37 /calypso_user]

Name:IisITDMarginCaIITradeType Attributes, .,
Cu:umment:l
Grn:nups:l.ﬁ.r'-]\“ |

Akkribuke Criteria Filker Yalue(s)
KEYWORD, CCPSettlement Type

Message Sender Configuration
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;Message Sender Config _ O] x|

Sender Config I Copy Config |

Message Status ITO_BE_SENT j Product Type IMarginCaII j

Advice Type ICLEARING_ITD_STP.TEMENT j Address Type IITD_STF'.TEMENT_FILE j

Static Data Filker | | Gateway IFILE j

v Save Master and Copies AdviceDocuments will be saved in DB

[+ Send [ Sender By Method v Sender By Gateway

GatewayFILEDocumentSender class will be called

11.3 Scheduled Tasks

Configure the scheduled task CLEARING_TRANSLATE_TO_CDML with Intraday = true.

Task Type ICLEF'.RING_TRP.NSLP.TE_TO_CDML

Excternal Reference ICDML Inkraday Impork

Carmments I

Descripkion I

Attempts |1

Retry After, In Minukes IIZI

M Settings I-Xm5512m -k 1024m -2 MaxPermSize=256m

fllow Task Ta [ Skip Execute [ Send Emails | Publish Business Events

Comnmon Attributes
[l Task Attributes

Base Folder [harmeclearingy 14/ Calypsofcearing/MasterFaolder
DML Processing Impart COnly
Inkraday krie

On execution of this scheduled task, the system imports PL marks on existing Collateral Exposure trades.

After executing this scheduled task, you need to execute the scheduled task COLLATERAL_MANAGEMENT with the
intraday collateral context, to generate the margin calls and the intraday message notifications.
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Task Type | COLLATERAL_MANAGEMENT
External Reference |

Comments |
Description |
Attempts |1
Retry After, In Minutes |0

IV¥M Settings |—)<m5512m -X¥mx1024m -¥X:MaxPermSize =256m

Allow TaskTe  [] Send Emails || Publish Business Events  To

Common Attributes
= Task Attributes

Template Clearing OTC

Collateral Context ITD_Collateral_Context
Price method

Optimization

Workflow Action MNEW
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COVA | Value of Collateral Held Total value of posted collateral (post-haircut) for the transaction.

MARG | Margin Amount Difference between the total collateral value and the total collateral
required.

TACR | Total Accrued Interest Amount Total amount of money accrued interest computed in the case of
interest bearing financial instruments.

TCFA | Total Cash Failed Amount Total value of undelivered intended transaction cash amount.

TCOR | Total Collateral Required Collateral is required to cover interest that accrues on the exposure.
Margin amount would thus be the difference between collateral
required and collateral value (that is COVA).

TEXA | Total Exposure Amount Total exposure amount between the giver and the taker expressed
in the transaction currency.

TPIN Total Pending Collateral In Value of incoming collateral, to be settled for the transaction.

TPOU | Total Pending Collateral Out Value of outgoing collateral, to be settled for the transaction.

TPRI Total of Principals Total of principals for the transaction.

TRAA | Transaction Amount Transaction amount.

TRTE | Termination Transaction Amount | Termination transaction amount.
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Section 13. Default Management Process

In case of counterparty default, the CCP provides a portfolio to each clearing member (DMP Auction reports) as
well as scenario shifts and curves.

The expectation is to calculate VM and IM, and reconcile it with the CCP numbers. This is to check the readiness of
the clearing members to take part in the auction of the defaulted portfolio.

13.1 Curves Mapping

REP109 curves need to be mapped in customclearingreports like in the examples below:

<bean name="VMYieldCurve-ZeroRatesDay ZAR" parent="parentCurveLCHReport">
<property name="displayName" value="VM Yield Curve - Zero Rates" />
<property name="path"

value="/Public (mbr) /SwapClear#{lchSwapClearFolderSuffix}/Risk/Yield

Curves/${date} REP00109 VM Curve - Discount Factors ZAR 1.txt" />
<property name="XSLResourcePath"

value="#{1lchStylesheetBasepath}/LCH REP00100a.xslt" />

</bean>

<bean name="VMYieldCurve-ZeroRatesDay USD" parent="parentCurveLCHReport">
<property name="displayName" value="VM Yield Curve - Zero Rates" />
<property name="path"

value="/Public (mbr) /SwapClear#{lchSwapClearFolderSuffix}/Risk/Yield

Curves/${date} REP00109 VM Curve - Discount Factors USD 1.txt" />
<property name="XSLResourcePath"

value="#{1lchStylesheetBasepath}/LCH REP00100a.xslt" />

</bean>
gl
= _] Corvelame -] :
& 100a_AUD_AONIA_EOO
4 100a_AUD_BBSW_3M_EOD Nome: L OHCurvetiame
& 1002_AUD_BBSW_6M_E0D nterface Yolue: 1008 CAD_COOR_M4_ECO
& 100a_AUD_BBSW _E£00
s Catypeo Vale: }m_cao_com.w'too_m
i* 100a_CAD_CDOR_EOO
¥ 100a_CAD_CORRA_EOD Reverse Defadt: [~
& 100a_CHF_LIBOR_12M_EOD
i 100a_CHF_UIBOR_3M_EOD
¥ 100a_CHF_LIBOR_6M_EOD <<Add
& 100a_CHF_UIBOR_EQD
& 100a_CHF_TOIS_EOD >> Remove
& 100a_CZK_PRIBOR_3M_EOD
i 100a_CZK_PRIBOR_6M_EOD —_l“""" et
3 100a_CZK_PRIBOR_EOD =
£ 100a_DKK_CIBOR_3M_EOD ey
i 100a_DKK_CIBOR_6M_EOD
& 100a_DKK_CIBOR_£00
i 100a_EUR_EONWA_FOD
* 100a EUR EURIBOR 12m €00 =
e | o= |

13.2 Indices Mapping
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Z( alypso Mappng Window = M

2 JPY-LIBOR-1W-BBA
2 JPY-LIBOR-1Y-B8A
2 JPY-LIBOR-2M-BBA
2 JPY-LIBOR-~2W-BBA
£ JPY-LIBOR-3M-BBA
¥ JPY-LIBOR~4M-BBA
¥ JPY-LIBOR~5M-BBA
£ JPY-LIBOR-6M-~BBA
¥ JPY-LIBOR~7TM-BBA
2 JPY-LIBOR-8M~BBA
2 JPY-LIBOR-~9M-BBA

¥ JPY-TONAR-OISOD-LDR

2 JPY-~TONA~1D~OIS-COMPOUND

£ NOKPAI

¥ NOK-NIBOR~1M-NIBR
¥ NOK-~NIBOR~1W~NIBR
¥ NOK-~NIBOR~1W~NIBR
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Name:  [LOH/Quotes
Interface Vale: | PY~LIB0R~11M~E8A
Calypso Vaue: VM. PY.LIBOR. 11M.88A
Reverse Defaut: [~

<< Add

o

o |

_cme |

13.3 Process

You can use the scheduled task DEFAULT_TRADE_LOADER to import FPML messages to create trades of the
defaulted portfolio into the system from the DMP Auction reports.

You can use the scheduled task CLEARING_IMPORT_MARKET_DATA to import curves and reset rates so that
valuation can be done for all the imported trades.

You can then perform independent valuation and IM calculation.



